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An Introduction to Control
Surfaces

Preface

You can use hardware control surfaces to control and automate transport, mixing,
recording, and other tasks in Logic Pro.

All Logic mixer controls, such as level and pan, can be adjusted onscreen—using your
mouse and computer keyboard. This is not, however, an ideal method for precise real-time
control. You can enhance your creative flow and achieve greater flexibility and precision
by connecting a hardware control surface to your computer.

Control surfaces are ideal for creating a dynamic live (on-stage) performance when used
with a portable computer, MIDI keyboard, and audio and MIDI interfaces. In the studio,
you can record control surface automation (even when Logic is not in record mode).
Track automation appears in Logic’s Arrange window and in the Piano Roll Editor.

When you move a fader on the control surface, the corresponding fader in Logic’s Mixer
moves with it. EQ or other parameters can be altered by turning rotary knobs on the
control surface, with assigned parameters updating instantly in Logic.

As communication between Logic and your control surface is bidirectional, adjustments
to parameters onscreen are immediately reflected by the corresponding control on the
control surface.

This preface covers the following:

» What Are Control Surfaces? (p. 7)

+ About the Logic Pro Documentation (p. 8)
+ Additional Resources (p. 8)

What Are Control Surfaces?

Control surfaces are hardware devices that feature a variety of controls, which can include
faders, rotary knobs, buttons, and displays. Control surfaces typically allow you to select
parameters for editing, or to select particular tracks/channel strips or banks (of channel
strips). Many also offer a Jog Wheel, which allows you to move the playhead precisely,
transport buttons, such as Play, Rewind, and so on, and other controls.




Some simple control surfaces only provide (non-motorized) faders and knobs. More
sophisticated units include motorized faders, rotary encoders, LED rings, and
programmable displays. The additional feedback these control surfaces provide makes
them easier to use—without having to refer to your computer screen to know what mode
the device is in, or what current parameter values are.

Note: When you use a supported control surface with Logic Pro, some controls are
premapped to common functions. You can map unassigned controls to other Logic Pro
commands and functions (see ).

About the Logic Pro Documentation
Logic Studio comes with various documents that will help you get started as well as
provide detailed information about the included applications.

+ Logic Pro User Manual: The onscreen user manual is a comprehensive document that
describes the Logic Pro interface, commands, and menus and gives step-by-step
instructions for creating Logic Pro projects and for accomplishing specific tasks. It is
written for users of all levels of experience. The user manual is available in Logic Pro
Help (in Logic Pro, choose Help > Logic Pro).

« Exploring Logic Pro: This booklet presents the basics of Logic Pro in an easy, approachable
way. Each chapter presents major features and guides you in trying things out. A PDF
version of the printed manual is available in Logic Pro Help. You can also open the PDF
directly in Logic Pro by choosing Help > Exploring Logic Pro.

« Logic Pro Control Surfaces Support: This onscreen manual describes the configuration
and use of control surfaces with Logic Pro.

+ Logic Pro TDM Guide: This onscreen manual describes the essential aspects of using
TDM in Logic Pro.

+ Logic Studio Instruments: This onscreen manual provides comprehensive instructions
for using the powerful collection of instruments included with Logic Pro and MainStage.

« Logic Studio Effects: This onscreen manual provides comprehensive instructions for
using the powerful collection of effects included with Logic Pro, MainStage, and
WaveBurner.

+ Logic Studio Working with Apogee Hardware: This onscreen manual describes the use
of Apogee hardware with Logic Pro.

Additional Resources
Along with the documentation that comes with Logic Pro, there are a variety of other
resources you can use to find out more.

Preface  An Introduction to Control Surfaces



Release Notes and New Features Documents
Each application offers detailed documentation that covers new or changed features and
functions. This documentation can be accessed in the following location:

+ Click the Release Notes and New Features links in the application Help menu.

Logic Pro Website
For general information and updates, as well as the latest news on Logic Pro, go to:

Apple Service and Support Websites

For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You'll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.

For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Logic Pro, go to:

For discussion forums for all Apple products from around the world, where you can search
for an answer, post your question, or answer other users’ questions, go to:

Preface  An Introduction to Control Surfaces
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Basic Control Surface Setup 1

Regardless of the control surface being used, you first need to connect, add, and configure
your device for use with Logic Pro. This chapter describes the setup procedures and
preferences that are common to all control surfaces. Setup information for specific devices
is covered elsewhere in the documentation.

Note: Read this chapter first, and then read through the chapter that pertains to your
specific device.

This chapter covers the following:

+ Getting Started (p. 11)

+ Connecting Control Surfaces (p. 12)

+ Adding Control Surfaces to Logic Pro (p. 15)

+ Creating Control Surface Groups (p. 16)

= Configuring Your Control Surface Setup (p. 18)
« Setting Control Surfaces Preferences (p. 26)

+ Modal Dialog Display (p. 31)

» Control Surface Usage Tips (p. 32)

+ Control Surfaces Supported by Logic Pro (p. 32)
+ About Control Surface Plug-ins (p. 35)

 About Software and Firmware (p. 35)

Getting Started

To use one or more control surfaces with Logic Pro, you will need:
+ An installed, authorized copy of Logic Pro

+ For USB- or FireWire-equipped devices (such as a Yamaha 01X), an available USB or
FireWire port. Ideally, this should be a direct USB/FireWire connection with the computer,
rather than via a USB/FireWire hub. Refer to the documentation provided by the
manufacturer of your control surface.

n
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+ For devices that are only equipped with MIDI ports (such as a Mackie Control), a MIDI
interface with free MIDI input and output ports for each device. For example, if you're
using a MIDI interface with 8 MIDI input ports and 8 MIDI output ports—with one
Mackie Control and one Mackie Control XT unit—you will need to use two of the
interface’s MIDI In ports, and two of its MIDI Out ports.

+ Aninstalled driver (if required by your control surface) that is supported by the operating
system you are using on your computer

Important: Your MIDI interface must feature driver software that supports SysEx
communication. Consult the documentation that shipped with your MIDI interface (or
MIDI interface drivers).

The number of devices that can be used simultaneously depends on the number of free
ports of the appropriate type (USB, FireWire, or other) available on your system. In a
standard setup, you can use a single control surface, or one accompanied by one or more
expansion devices. You can also create control surface groups, as described in

Using multiple control surfaces allows you to control more tracks and channels, effects,
and other parameters simultaneously. For example, the Mackie Control XT devices are
basically identical to the channel strip section (fader, V-Pot, and LCD) of the main
Mackie Control unit. The Mackie C4 features a number of V-Pots, but no faders. You can
add as many XT, C4, or other control surface devices as you wish to your system, provided
that enough free MIDI In and Out (or USB or other suitable) ports are available.

Connecting Control Surfaces

Logic Pro supports a variety of control surfaces that connect to your computer using
FireWire, USB, and other connection protocols. Be sure to check the type of connection
that your device features, and that it is supported by your computer. Before connecting
the device, read the installation instructions included with it, and install the latest version
of any appropriate firmware or driver software, if needed. For more information, refer to
the documentation that came with the device.
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Connecting FireWire and USB Control Surfaces

If your control surface has a FireWire or USB port, you can connect it directly to your
computer, using a cable with the appropriate connectors. FireWire and USB devices
transmit and receive data through a single cable, if the device supports bidirectional
communication. The following diagram illustrates a typical setup using a FireWire or USB
cable:

0000000

y

I a1

Computer Control surface

It is recommended that you connect FireWire and USB devices directly to your computer,
rather than through a hub. Daisy-chaining devices can result in errors and other problems,
due to the amount of data transmitted in real time.

Connecting Control Surfaces via Networking Ports

A handful of devices are connected via the network (LAN) ports of your Mac computer,
using a single, standard (CAT5) networking cable. Most devices connected in this way
also incorporate audio I/0 and digital audio converters, plus built-in MIDI ports, making
the addition of these peripherals a simple, single cable (and driver) installation.

As with FireWire and USB, it is recommended that such devices are directly connected
to the computer, rather than through a network hub or switch.

Chapter 1 Basic Control Surface Setup
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Connecting MIDI Control Surfaces

If your control surface has MIDI input and output ports, you can connect it to a MIDI
interface, and connect the MIDI interface to your computer. MIDI interfaces are typically
connected to your computer via the USB or FireWire connection protocols. MIDI uses
separate ports for input and output, and you must connect both the MIDI input and
output to use the device with Logic Pro. The following diagram illustrates a typical setup
using MIDI input and output:

/:

—

®oe®o 000000
MIDI
interface  Out port In port
<—|oooo‘,‘,| < -

A\ J In port Out port

Computer Control surface

It is recommended that you do not daisy-chain other MIDI devices via MIDI through to
the MIDI In or Out ports used by control surfaces. Daisy-chaining can result in errors and
other problems, due to the amount of data transmitted in real time.

Optional Footswitches and Pedals

Some control surfaces allow you to connect footswitches or pedals as additional controllers.
If your control surface features suitable connectors, you can connect optional footswitches
to remotely control playback and other functions. This frees your hands for other controls,
and can also be helpful when using guitars or other instruments that require two-handed

playing.

Powering Up

Once everything is connected, press the power switch on your control surface. Once
powered, the displays (such as an LCD, if your device has one) or LEDs are lit. Some LCDs
display a welcome message, which includes the firmware version number. On most control
surfaces with motorized faders, each fader will slide to its top position, then back to its
bottom or center position. This self-diagnostic power-on procedure indicates that your
units are functioning correctly.

Generally, you can turn on your computer (and MIDI interface, if applicable) either before
or after you turn on the control surface, and open Logic Pro either before or after the
control surface is powered up. Some devices, however, may require the computer to be
turned on before or after the device has initialized. Check the device documentation, and
manufacturer website.
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Adding Control Surfaces to Logic Pro

Some control surfaces (such as the Mackie Control) are detected automatically when you
open Logic Pro. You can add other devices that are not detected automatically using the
Setup window. Installation is easy (and is covered in the setup section of the chapter for
your particular device). Some devices may require different or additional steps, but
generally, all you need to do is select the device that you want to use with Logic Pro, and
then add it either by scanning or manually.

To add a control surface by scanning
Choose Logic Pro > Preferences > Control Surfaces > Setup to open the Control Surfaces
Setup window.

In the Setup window, choose New > Install, and then select the device from the list. You
can select more than one model by Command-clicking multiple entries in the list. If you
select more than one model, Logic Pro performs the operation for each model, in turn.

Note: If you don't want to select the models to be scanned, you can simply choose New
> Scan All in the Setup window: Logic Pro searches for all supported control surface units
on all MIDI ports. This process may take a while.

Click the Scan button. You can also press Enter, or double-click the device name to initiate
the scan.

Logic Pro scans your system for connected devices, and automatically installs (and connects
to) those it finds.

When you finish, close the window.
Some control surfaces don't support automatic scanning. Such devices must be added

manually to your setup. When you add a device manually, you also need to assign the
appropriate MIDI In and Out port parameters.

Note: It is preferable to install devices by scanning, whenever possible. Logic Pro is able
to gather more information about devices through scanning, than via manual installation.

To add a control surface manually
Choose Logic Pro > Preferences > Control Surfaces > Setup to open the Control Surfaces
Setup window.

In the Setup window, choose New > Install, and select the device you want from the list.
Click the Add button.
Close the Install window when you finish.

If another control surface of the selected type already exists in your setup, a warning
dialog asks you to confirm the addition of the new device.

You need to manually alter the MIDI In and Out port values (in the Device Parameter area
of the Setup window) to match those of the connected unit.

Chapter 1 Basic Control Surface Setup 15
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Note: You can reinitialize the support of all connected control surfaces by choosing
Logic Pro > Preferences > Control Surfaces > Rebuild Defaults.

Creating Control Surface Groups

If you have multiple control surface units in your system, you can define how they relate
to each other, and create control surface groups. A control surface group consists of
multiple devices that you combine to create a single, unified virtual control surface.

You can create up to 20 control surface groups. Each group can consist of any number
of physical devices. The only limiting factor is the number of available MIDI In and Out
ports (or USB/FireWire “MIDI” ports, if you are using a USB or FireWire control surface).

You can independently determine the default behavior of each device in a group. For
more information, see the Device Parameters section.

To create a control surface group
Choose Logic Pro > Preferences > Control Surfaces > Setup to open the Control Surfaces
Setup window.

In the Setup window, drag the icons of the control surfaces you want to group, so that
they form a single horizontal row.

Mackie Control C4

The order of the icons from left to right defines the order in which tracks and parameters
are arranged and displayed on the devices.

To use two control surfaces independently
Choose Logic Pro > Preferences > Control Surfaces > Setup to open the Control Surfaces
Setup window.

In the Setup window, arrange the icons for the control surfaces in separate rows—that
is, one above the other.
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Pictured below is a multiple group example with two Mackie Controls, three
Mackie Control XTs, and one HUI:

The top row, consisting of the Mackie Control #1, Mackie Control XT #1, and

Mackie Control XT #2, forms a single control surface group with 24 channels. Mackie Control
#1 controls channels 1 to 8, XT #1 controls channels 9 to 16, and XT #2 handles channels
17 to 24.

In the second row, the Mackie Control #2 and Mackie Control XT #3 form a second control
surface group, controlling instruments (on channels 1 to 8) and auxes (on channels 9 to
16).

In the third row, the HUI forms a single unit control surface group.

Each group has individual settings, such as Flip mode, Display mode, Plug-in Parameter
Bank Offset, and others. This allows you to access, edit, and automate different sections
of the Logic Pro Mixer.

In the example above, the three units in the top row could be used to control audio and
MIDI channel strips. In the second row, Mackie Control #2 could be used to control
instrument channel strips 1 to 8, and XT #3 could be used to control aux channel strips
1 to 8. The HUI could be used to edit group definitions. The physical placement of units,
and the way you use them, is completely flexible.

Note: In most situations, the placement of your control surface units in relation to each
other should be the same onscreen as in the real world. Simply position the icons in your
control surface group accordingly.

Chapter 1 Basic Control Surface Setup
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Once you have created a control surface group, you can configure it in the Setup window.
For more information, see Control Surface Group Parameters.

Configuring Your Control Surface Setup

The left side of the Setup window contains two or three parameter areas: Device
parameters, Special parameters (if your connected device supports them), and Control
Surface Group parameters. You can configure your control surface setup to meet your
needs by editing the parameters in these boxes.

Important: Any changes to settings (in the Setup window or from the device) are saved
in a preferences file, named “com.apple.logic.pro.cs,” located in ~/Library/Preferences.
This file is saved independently of the Logic Pro Preferences file.
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Device Parameters
The Device Parameters area contains the following items:

[ Edit | New + | View +]|

¥ Logic Control

Qut Port: All
Input: Ay
Module: Logic Control
Model: Logic Control
Varsion: [unknown)
Color: I:l
Transport Button Click: E
Touchless movable faders: |:|
| Fader Touch Sensitivity: 3
:Ba.ckl'nghr Saver Timeout (min}: 15
Serial No.:

L 12

+ Out Port: Choose the MIDI output port from the pop-up menu.
* Input: Choose the MIDI input port from the pop-up menu.

+ Module: Shows the name of the control surface.

+ Model: Shows the model name of the control surface.

« Version: Shows the firmware version for some control surfaces.

+ Color: Click to choose the color that indicates which tracks are being controlled by this
control surface. In the Arrange window, the tracks controlled by this device are colored
along the left edge of the track list (if the track control bars are displayed).

Each control surface must be connected to an independent MIDI In and Out port (or
corresponding USB/FireWire port, designated as a MIDI port by the device driver). When
the device is added, the automatic setup or scan procedure sets the appropriate MIDI
input and output port settings for the device. If the MIDI port settings are incorrect, you
can manually choose them from the Input and Out Port pop-up menus.

Special Parameters

Some control surfaces (such as the Mackie Control) allow you to define “special” parameters
such as fader touch sensitivity. When a device that offers special parameters is connected,
the Special Parameters area appears on the left side of the Setup window. For more
information about supported special parameters, refer to the documentation for the
specific device.

|u
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Control Surface Group Parameters

If you have created one or more control surface groups, you can configure group
parameters in the Control Surface Group Parameters area. These parameters apply to the
group associated with the selected device, and allow you to set up each group to meet
your needs. This is especially helpful when you have multiple control surface groups.
Many (if not all) control surface group parameters can also be changed directly from the
control surface, as well as from the Setup window.

If you have created multiple control surface groups, the Control Surface Group Parameters
area shows the settings for the group that is currently selected in the Setup window.
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Control Surface Group Display Parameters
The parameters at the top of the Control Surface Group Parameters area give you control
over aspects of the device displays.

¥ Control Surface Group 1
Flip Mode: Off &
Display Mode: Value
Clock Display: Beats
Channal Strip View Mode: Arrange
Fader Bank for Tracks View: 0
Fader Bank for All View: 0
Channel Strip Parametar: Yolume

.

LS 13

Surround Parameter: Angle
EQ Band: 1

EQ) Parameter: Freguancy = I

EQ Parameter Page: 0

Flip Mode: Choose the functions for the faders and rotary encoders of the channel strips
on the device. For control surfaces that contain a fader and a rotary encoder for each
channel strip, Flip mode allows you to assign both controls to the same parameter, or
swap their assignments. The choices are:

« Off: Standard mode, with the fader acting as a volume control.

« Duplicate: Assigns both the fader and encoder to the currently selected encoder
parameter.

+ Swap: Switches the fader and encoder assignments, making the fader a pan control
and the encoder a channel volume control, for example.

+ Mute: Disables the fader. This is useful when recording in the same room as the
control surface, and you want to avoid the mechanical noise of the faders. Any existing
automation still functions normally.

Display Mode: Click to limit the device display to only the name or only the value of
the current parameter. This is helpful if there is insufficient space for the display of both
the parameter name and value.

Clock Display: If your control surface features a position display, this parameter allows
you to determine how the playhead position is represented. Click to switch between
Beats (musical values) or SMPTE (absolute time values).

Note: The exact elements displayed, and thus their positions, depend on the selected
SMPTE or bar/beat display option defined in the Logic Pro Preferences.
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« Channel Strip View Mode: Choose one of the following view modes:

« Arrange: The channel strips on the device correspond to Logic Pro channel strips as
they appear in the Mixer window. The layout of channel strips matches the way tracks
are laid out in the Arrange window. Channel strip 1 in the Mixer window is equivalent
to channel 1 on the control surface, channel strip 2 in the Mixer is equivalent to
channel 2, and so on. Instruments and channels used by multiple tracks are merged
into one channel. This is the default mode of most devices, including the
Mackie Control.

« All: The channel strips on the device correspond to Logic Pro channel strips of certain
types, such as MIDI or aux channels, independent of their use in tracks. Control
surfaces that support this view mode generally allow you to define which channel
types you want to display. The contents of Logic Pro’s Mixer window automatically
follow the state of the control surface, provided that the View > Link Control Surfaces
option is turned on.

« Tracks: This view mode is similar to Arrange view mode, but individual channel strips
are shown when multiple arrange tracks address the same channel. Typically, this
will be an instrument channel, with several tracks routed to it.

+ Single: This mode shows a single channel (and its routing to auxes and so on). You
can determine which parameters the channel strip controllers (on the control surface)
will edit.

Note: Keep in mind that the View mode is a property of the control surface group, not
a global setting. One group can display busses, while the other shows tracks, for
example.

* Fader Bank for Tracks View: Drag vertically, or enter an integer value to offset which
tracks are controlled by the channel strips of the device in Tracks view. For example, if
your device has eight channel strips, these might normally be assigned to audio channel
strips 1-8 in Logic Pro. If you set this parameter to 2, the device channel strips would
control Logic Pro Mixer channel strips 3-10 (1 + 2 = 3).

« Fader Bank for All View: Drag vertically, or enter an integer value to offset which Logic Pro
channel strips are controlled by the device in All view. This parameter is only available
when multiple channel strip types are displayed in the Mixer. When single channel strip
types are displayed, there are separate fader bank parameters. (These aren't displayed
in the parameter list.)

* Channel Strip Parameter: Choose which function is controlled by the channel strip
encoders on the device. The choices are:

« Volume: Encoders adjust channel volume.
+ Pan: Encoders adjust channel panorama position.
+ Format: Encoders adjust/select channel format.

+ Input: Encoders adjust/select channel input source.
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+ Output: Encoders adjust/select channel output (main outs/auxes/surround).
« Automation: Encoders adjust/select channel automation mode.

* Group: Encoders adjust group membership of the track. Editing the parameter allows
you to set either “no group” or a single group. Enabling membership of multiple
groups is not possible. (This can only be done directly in the Logic Pro Mixer.)

+ Displayed Par.: Encoders adjust the automation parameter selected in the Arrange
window. This is especially useful if you set the control surface to Arrange View mode,
and your Arrange window shows multiple subtracks with various parameters.

Surround Parameter: Choose the surround parameter that the rotary encoders will
control. The choices are:

+ Angle: Encoders adjust surround angle.

« Diversity: Encoders adjust surround diversity (direction).

« LFE: Encoders adjust LFE level.

« Spread: Encoders adjust the Spread parameter of Stereo to Surround channel strips.
+ X: Encoders adjust surround X position.

+ Y: Encoders adjust surround Y position.

« Center: Encoders adjust the Center channel level.

Note: The X and Y parameters are a different representation of the Angle and Diversity
parameters, and thus are independent of them. The X and Y parameters support the
use of surround joysticks.

EQ Band: Sets the current EQ band, so that you can edit a particular Channel EQ or
Linear Phase EQ parameter for all tracks in the EQ Multi Channel View.

EQ Parameter: Choose which parameter of the selected EQ band is controlled by the
encoders in EQ Multi Channel View. The choices are:

+ Frequency: Encoders adjust the frequency of the selected band.

+ Gain: Encoders adjust the gain of the selected band. For the Low Cut (band 1) and
High Cut (band 8) bands of the Channel and Linear Phase EQ, this parameter controls
the slope.

« Q: Encoders adjust the Q factor of the selected band.
+ On/Off: Encoders bypass the selected EQ band.
« EQ Parameter Page: Sets the EQ parameter displayed in EQ Channel Strip view.

The Channel and Linear Phase EQs feature eight bands per audio channel, with each
band offering four parameters. All of these parameters can be accessed with your
control surface.
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If your control surface does not display all EQ parameters at once, you view them by
stepping through the parameter pages in sequence. For example, if your control surface
has eight channel strips, you can directly control parameters 1 to 8 with knobs or sliders
1 to 8 when you switch to EQ Channel Strip Edit view. You then need to switch by a
page to access parameters 9 to 16.

Control Surface Group Send and Plug-in Parameters
The parameters in the middle of the Control Surface Group Parameters area let you control
different operational aspects when working with Send and Plug-in parameters.

Send Slot: 1

Send Parameter; Destination %
Send Parameter Page:
| Split: no. of upper parameter:
Instrument Parameter Page:
| Inst Param Page (Split Lower):
Insert Slot:
Insert Skot (Split Lower):
Plug-in Parameter Page:
|Plug-in Param Page (Split Low:
Channel Strip Track: 262145
:i.'Zha.ﬂnel Strip Track (Split Low: 262145

Track Lock: [

0O 0O = = O o0 o o

+ Send Slot: Sets the currently selected Send slot. The default is 1, which sets the first
(top) Send on each channel as the Send slot. A value of 2 sets the second send as the
Send slot, a value of 3, the third Send slot, and so on.

+ Send Parameter: Choose the Send parameter controlled by the encoders when in the
Send Multi Channel view. The choices are:

« Destination: Encoder is used to determine the bus channel number for the Send slot.
« Level: Encoder is used to adjust the Send level.

* Position: Encoders set Pre, Post, or Post Pan fader modes.

+ Mute: Encoders mute/unmute the selected Send slot.

+ Send Parameter Page: Sets the current page for the Send parameters. Up to 32
parameters are available in Send Channel Strip view for a given channel (eight Send
slots multiplied by the four parameters listed above).

« Split: no. of upper parameters: Sets the number of encoders that belong to Split Upper,
for control surfaces that support Split mode. The remaining encoders belong to Split
Lower. A value of 0 means that Split mode is off—all encoders are assigned to the Split
Upper area.

Control surfaces that support Split mode allow the display of two separate parameter
sections within one plug-in (or even different plug-ins). They are called Split Upper and
Split Lower.
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« Instrument Parameter Page: Determines which parameter is assigned to the leftmost
encoder when editing a software instrument. The next instrument parameter is assigned
to encoder 2, and so on. This applies to Split Upper when Split mode is turned on.

* Inst Parameter Page (Split Lower): Sets the parameter that is assigned to the leftmost
encoder of Split Lower when editing a software instrument (when Split mode is turned
on). The next instrument parameter is assigned to encoder 2, and so on.

+ Insert Slot: Sets the current Insert slot number, both for selecting a plug-in (in Plug-in
Channel Strip view) and for editing its parameters. The default is 1, which sets the first
(top) plug-in slot on each channel as the Insert slot. A value of 2 sets the second plug-in
slot as the Insert slot, and so on. With Split mode turned on, this applies to Split Upper.

« Insert Slot (Split Lower): Sets the current Insert slot number for Split Lower when selecting
or editing a plug-in when Split mode is turned on.

* Plug-in Parameter Page: Defines which parameter is assigned to the leftmost encoder
when editing a plug-in. The next plug-in parameter is assigned to encoder 2, and so
on. This applies to Split Upper when Split mode is turned on.

Note: The plug-in and instrument page parameters are kept separate, as this allows you
to quickly switch between editing an instrument and an effect plug-in on a channel,
without having to adjust the parameter page every time.

* Plug-in Param Page (Split Lower): Defines which parameter is assigned to the leftmost
encoder of Split Lower when editing a plug-in (with Split mode turned on). The next
plug-in parameter is assigned to encoder 2, and so on.

+ Track: Defines which track is displayed for Channel Strip views. When Split mode is
turned on, this applies to Split Upper.

« Track (Split Lower): Sets which track is displayed (in the Split Lower section of the control
surface) for Channel Strip views, when Split mode is turned on.

« Track Lock: Determines how the control surface responds when a track is selected in
Logic Pro—in essence, this remotely affects the Track and Track (Split Lower) parameters.
When set to “on,” the control surface group continues to display the same track,
independent of the currently selected track in Logic Pro. When set to Off, the control
surface group automatically switches to the selected track, whenever a track is selected
in Logic Pro.
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Control Surface Group Other Parameters

The parameters at the bottom of the Control Surface Group Parameters area let you set
the Track Name Format, Parameter Page Shift Mode, Relative Change Mode, Mix Group,
and Group Parameter Page parameters.

Track Name Format- Name
Parameter Page Shift Mode: By Page
Relative Change Mode: Coarse -
Mix Group: 1
Group Parameter Page: 0

+ Track Name Format: Determines whether the track name display shows only the track
name, or the track name and number.

* Parameter Page Shift Mode: Determines whether the parameter is shifted by one page
or by one parameter.

* Relative Change Mode: Choose the mode for controller assignments that support a
Relative Value Change mode (rotary encoders, for example). The choices are:

+ Coarse: The parameter is adjusted in coarse steps.

* Full: Turning the encoder to the right sets the maximum value. Turning it to the left
sets the minimum value. The encoder also stops at its default value. For example,
when the Pan knob is left of center, turning the encoder to the right initially sets the
Pan parameter to center (its default value). A further turn to the right sets the Pan
to full right (its maximum value).

+ Fine: The parameter is incremented or decremented in fine steps—by one tick or
other unit. In this mode, the highest possible resolution is used. For example, when
editing the Sample Delay plug-in's Delay parameter, every encoder tick increases or
decreases the value by 1 sample, regardless of the resolution value.

+ Mix Group: Determines which group is edited when in Group Edit mode.

+ Group Parameter Page: Defines which parameter of the edited group is assigned to the
leftmost encoder.

Setting Control Surfaces Preferences
Various settings that affect the onscreen appearance and performance of control surfaces
can be made in the Logic Pro Control Surfaces preferences.

To open the Control Surfaces preferences
Choose Logic Pro > Preferences > Control Surfaces > Preferences (or use the Open Control
Surfaces Preferences key command).
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To temporarily disable your control surfaces
Choose Logic Pro > Preferences > Control Surfaces > Bypass all Control Surfaces.

This command is useful for silencing motorized control surface faders when recording in
the same room. It is also handy when troubleshooting MIDI data errors, or for reducing
MIDI bandwidth requirements.

General Preferences

General control surface preferences include resolution of relative controls, maximum MIDI
bandwidth, and other functions.

L e E o = g | ®
Ceneral Audio MIDI Display Score Video Automation Control Surfaces | Sharing
I:‘ Bypass All while in background
. . 1 | | | | 1 | | | | —
Resolution of Relative Controls: @ * 128 &
3 1 1 1 1 [ 1 1 I 1
Maximum MIDI Bandwidth: kel 50 _A_%

Multiple Controls per Parameter:

Show value units For: E Instrument,/plug-in parameters

D Touching fader selects track

E Control surface follows track selection

I:‘ Jog resolution depends on horizontal zoom
E Pickup Mode

E Flash Mute and Solo buttons

3

For longer labels and value displays

E Only when all parameters fit on one page

E Volume and other parametars

[L‘nnr.rnller Asslgnments...) (Setup... )

* “Bypass Allwhile in background” checkbox: Allows you to share your control surface with
other applications, when Logic Pro is not the active program.

* Resolution of Relative Controls slider: Sets the resolution of controls that change values
in a relative manner. The default resolution is 128 steps. Choose a higher resolution
value to divide the value range into finer increments.

+ Maximum MIDI Band Width slider: Drag to set the maximum amount of MIDI bandwidth
that your control surface can use. This is set to a default of 50%, which should be suitable
for most situations. You can adjust the value if you find that your MIDI or automation
playback is being affected.
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“Touching fader selects track” checkbox: When this option is selected, touching a fader
on the control surface selects the track corresponding to the fader. For this to work,
the device must feature touch-sensitive faders.

“Control surface follows track selection” checkbox: When this checkbox is selected,
selecting a track in the Arrange window automatically selects the corresponding track
or channel on the control surface.

“Jog resolution depends on horizontal zoom” checkbox: When selected, the precision of
scrubbing (using the Jog/Shuttle Wheel of your control surface) is determined by the
horizontal zoom level of Logic Pro. Your control surface must feature a Jog/Shuttle
Wheel (or similar control) for this to have any effect. To retain a consistent resolution,
regardless of Logic Pro window zoom levels, deselect this checkbox.

Pickup Mode checkbox: When selected, the control surface operates in Pickup mode (if
this mode is available). Some control surfaces, typically those without motorized faders
or knobs, do not show parameter changes— caused by playing back existing automation
data—on their interface. Such control surfaces usually offer a Pickup mode. In Pickup
mode, the controller must reach (“pick up”) the current value before the value starts
to change. This prevents sudden jumps of parameter values caused by playing back
automation. Your device may feature a display (usually a pair of arrow LEDs) that
indicates the direction or distance you need to move the controller, in order to match
the settings shown in Logic Pro (also known as NULL). Once you have matched the
onscreen values, deactivate Pickup mode and start automating.

When Pickup mode is turned off, adjusting a fader modifies the parameter immediately
(which can result in parameter value jumps).

Flash Mute and Solo buttons checkbox: When selected, the Mute and Solo buttons on
the control surface will blink (flash) on and off when mute or solo modes are engaged.

Multiple Controls per Parameter pop-up menu: Choose the maximum number of encoders
used for each parameter, when editing plug-ins or audio instruments. The choices are:

+ 1: Parameters are always displayed using one encoder per parameter, with the least
space available for parameter name and value in the LCD.

+ 2: On each unit, encoders 1 and 2 are used for the first parameter, encoders 3 and
4 for the second, and so on.

+ 4: On each unit, encoders 1 to 4 are used for the first parameter, encoders 5 to 8 for
the second, and so on.

+ 8: On each unit, encoders 1 to 8 are used for the first parameter, encoders 9 to 16
for the second, and so on.

When multiple encoders are used per parameter, the encoders are divided into groups
(1/2,3/4,5/6,7/8, for example). The first encoder of each group controls the parameter
shown in the display. The remaining encoders are inactive.

Chapter 1 Basic Control Surface Setup



Using more than one encoder per parameter shows fewer parameters at any given
time, but you gain space on the LCD to cater to longer parameter names and values.
The more control surfaces you have within a control surface group, the more you benefit
from this feature.

* “Only when all parameters fit in one page” checkbox: When selected, the defined number
of encoders are only used when there are sufficient encoders available to show all
parameters, without changing pages. For example, if you have a Mackie Control and
two Mackie Control XTs (giving you at total of 24 encoders), a plug-in with 13 parameters
will be shown with one encoder per parameter. Eleven encoders will remain unused.
A plug-in with 11 parameters will be shown with two encoders per parameter. Two
encoders will remain unused (as will the inactive encoders of the subdivisions mentioned
above).

When deselected, multiple encoders are used for each parameter, which may require
scrolling. This would not be the case if only one encoder were used for each parameter.

+ “Show value units for” checkboxes: The two checkboxes in this section allow you to
adjust whether parameter values are appended by the measurement unit, where
applicable—"Hz" or “%," for example. You can set this option separately for instrument
and plug-in parameters, and for volume and other channel strip parameters. When
selected, applicable values are appended with the appropriate unit. Turn off this option
if viewing units makes the display too cluttered.

« Controller Assignments button: Click to open the Controller Assignments window.

« Setup button: Click to open the Control Surfaces Setup window.
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Help Tags Preferences

For control surfaces that feature freely programmable displays with more than six
characters per line (or segment) of the display, you can change the way help tags are
shown. Control surface help tags are similar to Logic Pro help tags, showing additional
information during use.

@ac Preferences.

0Ee 3 o E‘E‘l@

Ceneral Audic MIDI Display Score Video Automation Control Surfaces | Sharing

le Help Tags

While editing show long names For E Parameter name
E Parameter value

Display Duration: ] ! nu“ I I - : I : L (= 20 «}s

E Show info for multiple parameters
E Show info when selecting tracks

E Show info when editing volume

Show value units For: E Instrument/ plug-in parameters

E Volume and other parameters

leontrn]ler Asslgnmenls.._) ( Setup... )

« “While editing show long names for” checkboxes: The two checkboxes in this section
allow you to set how the names and values of parameters are displayed on the LCD of
the control surface.

« “Parameter name” checkbox: When selected, the upper LCD line displays the full
parameter name, rather than an abbreviated form of it, when you edit a parameter.

« “Parameter value” checkbox: When selected, the lower LCD line displays the full
parameter value when you edit a parameter. If the “Show value units for parameter”
checkboxes (see below) are selected, it will be appended by the measurement unit,
where applicable (for example, “dB,” “Hz,” or “%").

Note: The following options only have an effect if at least one of the two parameters

described above is active.

« Display Duration slider: Drag to adjust the time that parameter names and values remain
on the LCD display, following selection and adjustments.
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* “Show info for multiple parameters” checkbox: When selected, the long name information
appears in the display until the most recently edited parameter’s display times out.
This may cause overlapping text. When unselected, the long name display is only shown
for the most recently edited parameter, which can cause screen flicker.

+ “Show info when selecting tracks” checkbox: When turned on, Selected appears in the
upper row of the LCD, and the selected track’s name is shown in the lower row, when
you select a track.

+ “Show info when editing volume” checkbox: When selected, the word Volume appears
in the upper row of the LCD, and the edited value appears in the lower row, when you
edit a track’s volume.

« “Show value units for” checkboxes: When selected, parameter values are appended by
the appropriate measurement unit (“Hz” or “%,” for example). You can set this option
separately for “Instrument/plug-in parameters” and “Volume and other parameters.” If
you can do without value units, the display is less cluttered.

Note: This parameter only applies while you are editing the relevant values.

Modal Dialog Display

All modal dialogs (except File Open dialogs) appear on the LCD display of control surfaces
that feature text displays. Examples of modal dialogs include authorization warnings, edit
confirmations, or error messages. While a modal dialog is visible, you cannot perform
actions in any other window.

The modal dialog text appears in the upper row of the LCD. If the dialog text does not
fit in the LCD's upper row, it starts scrolling after three seconds. You can scroll the dialog
text manually with the appropriate control. (See assignment tables in the appropriate
chapter.) Once you start scrolling the text manually, automatic scrolling is disabled.

+ If the control surface has an Enter or OK button, pressing it triggers the dialog’s default
button, where applicable.

« If the control surface has a Cancel or Exit button, pressing it triggers the button labeled
Cancel or Abort, where applicable.

+ All buttons in the modal dialog (push buttons, including Enter, Default, and Cancel, as
well as checkboxes and radio buttons, but not pop-up menus) appear in the display’s
lower row.

Pressing a control surface button below the display triggers the appropriate function in
the dialog, if applicable. Once you press an Enter or Cancel button on the control surface
or click it onscreen, the dialog disappears, and all controls and displays return to their
previous state.

When a File Open dialog appears onscreen, the “There is afile select dialog on the screen”
message appears on the LCD or other display (if your control surface has one).
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Control Surface Usage Tips

You may find that using control surfaces changes the way you use Logic Pro. Slight
changes to your working methods can help you to use control surfaces more effectively.
The following hints may streamline your Logic Pro control surface workflow.

Customize Your Templates

+ Set up screensets 1-7 as your most frequently used screensets. You can access these
directly on some control surfaces. On a Mackie Control, for example, you can access
them with function keys F1 to F7, while function key 8 (F8) closes the topmost window.

+ Itis recommended that you assign a full-screen Arrange window, with track automation
view set to On (for all tracks), as one of your screensets.

+ A full-screen Mixer window is also recommended as another screenset.

Make Use of Markers

Markers allow you to quickly navigate from location to location in a project. Most control
surfaces feature a number of shortcuts that allow you to rapidly move between markers,
which is an extremely useful way of moving around in your projects.

Markers are also useful for creating or selecting cycle areas and a number of other tasks,
such as punch and replace recording.

If you tend to follow a particular song structure, or like to work with a particular number
of bars (4, 8, 16 bars, and so on) for verse and chorus sections, then set up a number of
markers at suitable locations in your templates.

Control Surfaces Supported by Logic Pro
Following is an alphabetical listing of control surfaces directly supported by Logic Pro.
The list contains cross-references to the relevant device-specific chapters.

Note: It is possible that your device may be directly supported in Logic Pro via one or
more downloadable support files. This is often a driver or plug-in supplied by the
manufacturer. (See About Control Surface Plug-ins.) Check the documentation and discs
that came with the device, and the manufacturer’s website. Follow any written instructions
supplied with the files, if available.

Supported devices Manufacturer Notes

01V96 Yamaha The Yamaha 01V96 emulates two HUI units, using
two virtual MIDI In and Out connections over its
USB cable. See Yamaha 01V96.
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Supported devices Manufacturer Notes

01X Yamaha The Yamaha 01X emulates a Mackie Control. It
does not feature all controls available to the
Mackie units, however. Refer to the 01X
documentation for details. Logic Pro recognizes
the 01X as an 01X, and displays a custom icon, but
communication is as with a Mackie Control unit.
See Mackie Control.

02R96 Yamaha The Yamaha 02R96 emulates three HUI units, using
three virtual MIDI In and Out connections over its
USB cable. See Yamaha 02R96.

Baby HUI Mackie The Baby HUI is a stripped-down version of the
HUI. See Mackie Baby HUI.

Cc4 Mackie The Mackie C4 is directly supported. See Mackie C4.

CM408T (System 5-MC)  Euphonix See Euphonix MC Pro, System 5-MC, MC Control,
MC Mix, and MC Transport.

CS-32 MiniDesk JLCooper See JLCooper CS-32 MiniDesk.

DM1000 Yamaha The Yamaha DM1000 emulates two HUI units,
using two virtual MIDI In and Out connections
over its USB cable. See Yamaha DM1000.

DM2000 Yamaha The Yamaha DM2000 emulates three HUI units,
using three virtual MIDI In and Out connections
over its USB cable. See Yamaha DM2000.

FaderMaster 4/100 JLCooper See JLCooper FaderMaster 4/100.

FE-8 Tascam Extension unit for FW-1884. See Tascam F\W-1884.

FW-1082 Tascam A stripped-down version of the FW-1884. See
Tascam FW-1884.

FW-1884 Tascam See Tascam FW-1884.

HUI Mackie See Mackie HUI.

iControl M-Audio See M-Audio iControl.

KONTROL49 Korg A larger version of the microKONTROL. See Korg

microKONTROL and KONTROLA49.

Logic Control XT

Mackie/Emagic

This is the extension unit for the Logic Control. It
only offers the channel strip section, making it less
useful without a Logic (or Mackie) Control. See
Mackie Control.

Logic/Mackie Control

Mackie/Emagic

See Mackie Control for more details.
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Supported devices

Mackie Control

Manufacturer
Mackie

Notes

The original Mackie Control hardware is similar to
the Logic Control. The front panel legend is
different, however. You should request a

Logic Control Lexan Overlay from Mackie. As
Logic Pro also recognizes the Mackie Control
protocol, you may use any firmware version. If
your unit has firmware version 1.02 or later, you
can freely use either the Logic Control or

Mackie Control mode. See Mackie Control.

Mackie Control
Extender

Mackie

Mackie-badged version of the Logic Control XT.
As Logic Pro also recognizes the Mackie Control
protocol, you may use any firmware version. If you
have firmware version 1.02 or later, you can freely
use either the Logic Control or Mackie Control
mode. See Mackie Control.

Mackie Control
Universal

Mackie

A Mackie Control with Logic Control silk screening
(legend) and firmware version 2.0 or later
(including HUI emulation). As Logic Pro also
recognizes the Mackie Control protocol, you may
use any firmware version. If you have firmware
version 1.02 or later, you can freely use either the
Logic Control or Mackie Control mode. See
Mackie Control.

MC

Euphonix

See Euphonix MC Pro, System 5-MC, MC Control,
MC Mix, and MC Transport.

MCS3

JLCooper

See JLCooper MCS3.

microKONTROL

Korg

See Korg microKONTROL and KONTROLA49.

Motormix

CM Labs

See CM Labs Motormix.

Radikal Technologies

SAC-2.2

The SAC-2.2/2K’s native mode is directly supported,
but it can also emulate a Mackie Control. You
should use the native mode. See Radikal
Technologies SAC-2K.

Radikal Technologies

SAC-2k

See Radikal Technologies SAC-2K.

SI-24

Roland

See Roland SI-24.

TranzPort Frontier Design Group ~ See Frontier Design TranzPort.

Us-224 Tascam A stripped-down version of the US-428. See
Tascam US-428 and US-224.

US-2400 Tascam Logic Pro supports the US-2400’s native mode. In
contrast to its Mackie Control mode, all controls,
including the joystick, are supported. See
Tascam US-2400.

US-428 Tascam See Tascam US-428 and US-224.
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About Control Surface Plug-ins

Supported control surfaces communicate with Logic Pro via special plug-in files that are
installed along with Logic Pro. The plug-in files are located in the /Contents/MIDI Device
Plug-ins subfolder of the Logic Pro application bundle. To view the bundle contents,
Control-click the Logic Pro application icon, and choose Show Package Contents from
the shortcut menu. Logic Pro also checks for control surface plug-ins installed in the
(optional) /Library/Application Support/MIDI Device Plug-ins and ~/Library/Application
Support/MIDI Device Plug-ins (the “~" denotes your user home directory) folders.

When new control surface plug-ins are released independently of a Logic Pro update (or
supplied directly by the device manufacturer), place them in the folders described above
(or as advised in the documentation supplied with the plug-in).

About Software and Firmware

Most control surfaces depend on Logic Pro for their functionality, and cannot be operated
if Logic Pro is not running. They do not provide any additional functionality that is not
available in Logic Pro itself. One advantage of this approach is that as new functions are
added to Logic Pro, or as you create new assignments, your control surface will be able
to access and control them.

Most control surface units do include a form of software called firmware. Firmware is
similar to the low-level boot software found in your computer, mobile phone, iPod, and
so on.

New behaviors, such as improved control of motorized faders and changes to the display,
can be provided by firmware updates. You should periodically check the manufacturer’s
website for your device, to check for updates that may enhance use or performance.

The firmware is usually stored on an EEPROM (Electronically Erasable Programmable
Read-Only Memory) chip. It can often be updated via a simple MIDI dump procedure, in
the form of a MIDI file. Should new firmware become available, you can simply download
the appropriate MIDI file and play it (from Logic Pro) to your control surfaces, which will
be updated accordingly. The steps required to perform a firmware update will be outlined
in the documentation that accompanies the MIDI file. Read this before attempting any
update.

Note: Some control surfaces may require that you physically replace the chip for firmware
updates. Contact the manufacturer of your device for details.
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Customizing Controller 2
Assignments

You can assign controllers to Logic Pro parameters, and edit controller assignments to
fit your workflow.

This section explains how to assign controllers to Logic parameters, edit controller
assignments, and use zones and modes to switch between groups of assignments.

This chapter covers the following:

+ Assigning Controllers to Logic Pro Parameters (p. 37)

+ Controller Assignments: Working in Easy View (p. 38)
+ Controller Assigments: Working in Expert View (p. 41)
+ Assigning Buttons to Key Commands (p. 59)

+ Controller Assignments Storage (p. 61)

Assigning Controllers to Logic Pro Parameters

You can assign any controller that is capable of generating a MIDI message to a parameter
in Logic Pro. Assigning controllers to Logic parameters lets you use faders, knobs, switches,
and other controllers to remotely control Logic functions. These can be used “as is,” or
in conjunction with modifier keys.

Most supported control surfaces include preset controller assignments that become active
when you add the device to your system. You can change existing assignments for
supported control surfaces, and create new assignments for both supported and
unsupported devices. For example, the default assignments of the F1 to F7 buttons on
the Mackie Control open screensets 1 to 7 in Logic Pro. You can reassign these control
surface buttons to other Logic commands—either alone or in conjunction with the
Command, Shift, Option, and Control modifier buttons (on the control surface)—in any
combination.
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You can assign controllers to parameters in Logic’s Controller Assignments window, using
the Learn process. The Controller Assignments window has two views: a compact Easy
view, where you can assign channel strip and plug-in parameters; and the more extensive
Expert view, where you can create and edit any type of controller assignment, including
global, automation, and control surface group assignments.

Controller Assignments: Working in Easy View
Easy view allows you to see and assign controllers to channel strip and plug-in parameters,
and to change the track that assignments apply to.

To open the Easy view of the Controller Assignments window
Choose Logic Pro > Preferences > Control Surfaces > Controller Assignments (or use
Command-K), and click the Easy View button.

868 Controller Assignments

[ [ easyview | Expertview |

Parameter: -

Channel Strip: | Audio 3 S

Input message:

Lo Mode

The Easy view of the Controller Assignments window contains the following fields and
buttons:

« Expert View button: Click to open the editor in Expert view.
* Back/Forward buttons: Click to move back and forth between assignments.

+ Link button: When active, the assignment that matches the most recently received MIDI
message is automatically selected.

* Parameter field: Displays the name of the selected parameter.

« Channel Strip pop-up menu: Choose whether the assignment applies to the selected
track, or matches the channel strip number entered in the field beside the pop-up
menu (as shown in the Mixer’s All view).

+ “Input message”field: Displays the incoming MIDI message data of the controller being
assigned to a function.
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Assigning and Deleting Controllers in Easy View

Only one set of assignment parameters is visible at a time in Easy view. You use the Learn
process to assign controllers to channel strip and plug-in parameters. The Learn process
basically involves moving a controller on your control surface. This sends a MIDI message
to Logic Pro, thus “teaching” Logic Pro which controller you are assigning to the chosen
parameter.

To assign a controller in Easy view
In the Mixer, or in any plug-in window, select the parameter that you want Logic Pro to
learn as a controller assignment.

Choose Logic Pro > Preferences > Control Surfaces > Learn Assignment for [parameter
name]. (Alternately, you can use the Learn new Controller Assignment key command,
default: Command-L, to open the Controller Assignments window, and activate Learn
mode.)

The Controller Assignments window opens in Easy view, with the Learn Mode button
activated. In most cases, the name of the selected parameter is shown in the Parameter
field.

Move the hardware controller you want to assign to the selected parameter.

Moving the controller sends a MIDI message to Logic Pro, which appears in the “Input
message” field. This memorizes the controller assignment, and you can click the Learn
Mode button to complete the Learn process.

If you do not click the Learn Mode button, Learn mode remains active, allowing you to
make further assignments.

To make another assignment, select the parameter you want to assign in Logic Pro, then
move the controller on the control surface.

When you finish, click the Learn Mode button (or press Command-L) to complete the
Learn process.

To assign a controller using a modifier key
Choose Logic Pro > Preferences > Control Surfaces > Learn Assignment for [parameter
name] (or press Command-L) to open the Controller Assignments window.

Hold down the modifier key you want to use (Command, for example) as you select the
parameter you want to assign, while moving the control.

Click the Learn Mode button to complete the Learn process.

If Logic Pro receives a MIDI message from the device while you are holding down the
modifier key, the Learn Mode button is deactivated when you release the key, and the
Learn process is complete. If you release the modifier key before Logic Pro receives a MIDI
message, the Learn Mode button remains active, so you can still move a controller to
send a MIDI message. In this situation, be sure to click the Learn Mode button when you
are finished to end the Learn process.
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To delete a controller assignment in Easy view
Select the assignment you want to remove in the Controller Assignments window (Easy
view), and click the Delete button.

Assigning a Series of Controllers in Easy View

Logic Pro includes a shortcut that makes it easy to assign a series of controllers to a series
of similar parameters. For example, you can use this shortcut to assign a series of faders
to volume; to assign a series of knobs to other channel strip parameters such as pan, solo,
or mute; or to assign a series of controllers to a set of plug-in parameters.

To assign a series of controllers to a series of parameters
In the Mixer, or in any plug-in window, select the parameter that you want Logic Pro to
learn as a controller assignment.

Choose Logic Pro > Preferences > Control Surfaces > Learn Assignment for [parameter
name]. (Alternately, you can use the Learn new Controller Assignment key command,
default: Command-L, to open the Controller Assignments window, and activate Learn
mode.)

The Controller Assignments window opens in Easy view, with the Learn Mode button
activated. In most cases, the name of the selected parameter is shown in the Parameter
field.

Assign the first controller in the series to the first parameter (assign fader 1 to control
volume for channel strip 1, for example).

Assign the last controller in the series to the last parameter (assign fader 16 to control

volume for channel strip 16, for example). The number of controllers between the first
and last in the series must match the number of parameters between the first and last
parameter. In the example, the distance between 1 and 16 would equal 15.

A “Do you want to fill up in between?” dialog appears.

Click OK to automatically fill the controllers between the first and last with the
corresponding assignments.

Note: You can only use shortcuts for knobs that send a single channel message, where
the first data byte is the controller number and the second data byte is the value.
Alternatively, the controller number can be encoded in the MIDI channel, with a fixed
first data byte. Consult the documentation that came with your device for information
on its data structure.
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Controller Assigments: Working in Expert View

You can use Expert view to make advanced controller assignments. These include Logic Pro
parameters other than channel strip and plug-in parameters. For example, you can assign
controllers to global, automation, and control surface group parameters in Expert view.
You can also extensively edit controller assignments in Expert view, and define zones and
modes, which let you switch between groups of controllers.

The Learn process opens the Controller Assignments window in Easy view, which shows
the basic parameters for the current assignment. To make assignments other than channel

strip or plug-in assignments (or to edit other assignment parameters), you need to switch
to Expert view.

Tip: You can only switch back to Easy view if a track or plug-in parameter is selected.

To open the Expert view of the controller assignments window

Choose Logic Pro > Preferences > Control Surfaces > Controller Assignments (or use
Command-K), and click the Expert View button.

Zone list Control/Parameter list
[cX=Ye) Controller Assignments.
{No Zone) + (No Mode) Ch. 1 Signal -
Control Surface: Logic Cc LED and vertical mete Ch. 2 Signal
Global Views « | LEDand horizontal | | | Ch.3 Signal
Level Meters Signal LED only Ch. 4 Signal
e S I Controller Assignment
Transport / V-Pot Overla. Ch. 7 signal =
o ch. 8 Sianal . cis Parameter area
’c‘-ﬁ:::n Parameter: .
o s
ValueChange: ]
! ! ! - Input Message area
Touch/Release: |
Value 3
MinfMax: [ o] [127]
: - Value area
Feedback:
[ Text Feedback
[ Local Feedback Fader/Knob)
- [JKey Repeat _
[Ceam e |
Mode list

In Expert view, the Controller Assignments window contains the following fields, menus,
and buttons that you use to edit assignment parameters and define zones and modes.

+ Zone list: Displays the available zones for the device. The first entry “(No Zone)" is for
zoneless assignments—assignments that are always active, regardless of the active
zone. Select a zone in the list to see its modes (in the Mode list), and its current

assignments (in the Control/Parameter list). You can also double-click a zone to rename
it. See
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+ Modelist: Displays the modes for the currently selected zone. The first entry “(No Mode)”
is for modeless assignments. Select a mode in the list to see its assignments in the
Control/Parameter list, and make it the selected zone’s active mode. You can also
double-click a mode to rename it. See

+ Control/Parameter list: Select the assignment you want to edit. The left column displays
the name of the control, and the right column displays the name of the parameter
being controlled (in an abbreviated form). The parameters of the selected assignment
appear in the fields to the right of the list. See

Note: You can select multiple assignments in the list, but only the parameters of the
first selected assignment are displayed. When multiple assignments are selected,
operations performed via the Edit menu can be applied to all selected assignments.
All other operations apply only to the first assignment.

+ Controller Assignment Parameter area: All aspects of the selected controller assignment
parameter are shown, and can be changed, in this area. See

* Input Message area: The port and MIDI input message can be altered directly. Some
fields in this section are merely displays, and cannot be changed. See

+ Value area: The range of values, and response, of the controller assignment to incoming
messages is determined in this area. Feedback to the display of control surfaces can
also be determined here. See
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Controller Assignments Window Expert View Settings

This section outlines each parameter shown in the fields on the right side of the Controller
Assignments window when in Expert view. Detailed descriptions of each parameter can
be found in Using the Control Name and Label Fields.

Controller Assignment Parameter Area
The area at the top right shows the following parameters:

+ Control Name field: Displays the name of the controller for supported devices. For
unsupported devices, Learned is displayed. See Using the Control Name and Label
Fields.
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+ Label field: Displays characters that represent the label for the assignment on the control
surface’s display. You can view this much like a scribble strip on a mixer. See

* Flip Group field: Enter an integer to define a flip group for the assignment. See

+ Class pop-up menu: Choose the class of parameter (parameter type) you want to assign.
See

Note: Depending on the chosen class, different fields and pop-up menus for that class
appear below the Class pop-up menu.

* Parameter/Mode pop-up menu and field: Depending on your choice in the Class pop-up
menu, you can choose from dozens of different parameters and modes. The options
available change as different classes are selected.

* Group/Track/Command/Key field pop-up menu: These options also change depending
on your choice in the Class pop-up menu.

* Bank Type pop-up menu: This pop-up menu determines the bank relationship of the
assigned parameter. This can be as per the Group setting, By One, or By Bank.

Input Message Area
The area at the center right shows the following parameters. See
for details.

+ MID! Input pop-up menu: Choose a MIDI input source (MIDI Port or Caps Lock Keyboard).
This can be changed by incoming MIDI messages, shown in the Value Change field.

+ Value Change field: Displays incoming MIDI messages that cause a value change.

+ Touch/Release field: Enter an integer value to force incoming MIDI messages to change
the touch/release status of the selected parameter. This only applies to control surfaces
that offer touch-sensitive controls (where touching or releasing a fader, for example,
enables or disables reception of data from the control surface).

Value Area
The area at the bottom right shows the following parameters. See
for details.

* Min and Max fields: Enter integer values to set the range of incoming MIDI values.
+ Format pop-up menu: Choose the format used to encode negative values.
*+ Multiply field: Enter a value to scale incoming MIDI values.

* Mode pop-up menu: Choose the mode used by incoming values to modify the current
parameter value.

* Feedback pop-up menu and checkboxes: Choose the display format of the parameter
value (on the control surface display, if applicable).
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Assigning and Deleting Controllers in Expert View

You can use the Learn process to assign controllers when the Controller Assignments
window is in Expert view, just as you would in Easy view. You can also assign controllers
to classes of Logic Pro parameters that are not accessible in Easy view.

To learn a controller for a non-channel strip or plug-in parameter
Choose Logic Pro > Preferences > Control Surfaces > Controller Assignments (or use
Command-K), and click the Expert View button.

Choose a zone or mode (unless you want to make a modeless assignment), and click the
plus button in the lower-left corner of the Control/Parameter list.

A new, blank assignment appears in the Control/Parameter list.
Click the Learn Mode button to start the Learn process.

Move the controller (on your control surface) that you want to assign to the selected
parameter.

Moving the controller sends a MIDI message to Logic Pro, thus “teaching” Logic Pro which
controller you are assigning. The Learn Mode button remains active, allowing you to
make further assignments.

The incoming MIDI message appears in the Input message field. Once Logic Pro has
received the message, choose the class of parameter you want to assign from the Class
pop-up menu.

Assign the parameter by making appropriate choices in the pop-up menus and fields
that appear below the Class pop-up menu.

Note: A detailed explanation of classes and other assignment parameters can be found
in

When you finish, click the Learn Mode button (or press Command-L) to complete the
Learn process.

Tip: You can use the shortcut described in

to assign a series of controllers to a series of similar parameters.

Should you accidentally move the wrong controller in Learn mode, you can easily delete
an unwanted assignment.

To delete an assignment in Expert view
Select the assignment that you want to delete in the Control/Parameter list.

Choose Edit > Delete (or press the Delete key).
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Getting to Know Zones and Modes

You can define a group of controllers as a zone in Expert view, and switch all controls in
a zone to different parameters, all in one operation. Using a Mackie Control, for example,
you can define the eight rotary encoders as a zone, and switch them between pan, send
level, and plug-in parameters. You can also define multiple zones for a control surface:
one for the encoders, and a second one that switches the function keys (F1 to F8) to
different functions.

Each set of zone parameters is called a mode. A zone can contain one or more modes,
but only one mode can be the active mode at any given time. A zone can also contain
assignments that are always active, regardless of the active mode. (These are known as
modeless assignments.)

The simultaneous use of modal and modeless assignments allows you to do things such
as:

+ Define a zone that switches between two modes (or functions) by pressing and releasing
a control surface modifier button (such as Shift or Option) while using a particular
function button (on the control surface).

+ Define a zone that allows you to use modeless assignments for things like updating
the display, Transport functions, and Save and Undo operations. The same zone could
contain a modal assignment for all Volume and Pan controls. Switching to another
mode would provide access to EQ parameters. In both modal situations, the display,
Transport, and Save and Undo functions would be available.

A mode can contain any number of assignments. Only the assignments for the active
mode are processed by Logic Pro. Assignments of inactive modes are ignored.

You can switch the active mode for a zone by making special assignments. See

Zones and modes can be defined across multiple control surfaces, to support the use of
control surface groups.
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The following example illustrates one possible arrangement of zones and modes, and
shows how you can define them, hierarchically:

Modeless Assignment A Mode 3 (inactive)
Modeless Assignment B Modal Assignment A
Mode 1 (inactive)
Modal Assignment A

Modal Assignment B
Mode 5 (inactive)
Modal Assignment A
Modal Assignment B
Modal Assignment C
Modal Assignment D

Defining Zones and Modes
You can only define zones and modes in the Expert view of the Controller Assignments
window.

To define a zone
1 Click the Add button in the lower-left corner of the Zone list.
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A new, blank zone appears in the Zone list. It is highlighted, allowing you to immediately
rename it.

Enter a name for the zone.

If you want to add controllers to the zone, see Assigning and Deleting Controllers in
Expert View.

To define a mode
Click the Add button in the lower-left corner of the Mode list.

A new, blank mode appears in the Mode list. It is highlighted, allowing you to immediately
rename it.

Enter a name for the mode.

If you want to add controllers to a mode, see Assigning and Deleting Controllers in Expert
View.

Reassigning a Controller in Expert View

The procedure for reassigning an active controller (an assigned controller in the active
mode) is different from that of an inactive controller (one with an assignment in an inactive
mode).

To reassign an active controller

Use the Learn process described in Assigning and Deleting Controllers in Expert View to
assign an active controller (one with an assignment in the active mode), and choose one
of the options shown in the dialog:

This control is already assigned to another
parameter.

Do you want to reassign the control?

{ Keep both ) M

+ Cancel: Deletes the new assignment, retaining the existing assignment.

* Keep Both: Retains the new and old assignments. Used typically when one knob controls
multiple parameters as a macro.

* Reassign: Deletes all existing active assignments for this parameter. Used to reassign a
function key (F1 to F8, for example) to a new key command.

To reassign an inactive controller

Use the Learn process described in Assigning and Deleting Controllers in Expert View to
assign a controller in an inactive mode. Note that the new assignment becomes part of
the active mode in the same zone that contained the previous, inactive assignment.
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This is typically used as follows: Supported control surfaces generally have empty user
pages available, allowing for new encoder assignments. You would select a particular
user page mode (page 3, for example), and then learn an assignment for the encoder.

Using the Control Name and Label Fields

The following describes the use and options available for the Control Name and Label
fields in the Controller Assignment Parameter area at the top right of the Expert View
window.

Control Name Field

Shows the name of the control. For supported devices, the control surface name is used.
For assignments created with the Learn process on unsupported control surfaces, the
control name defaults to Learned. You can enter a new name in the field. The control
name is for display only, and has no effect on functionality.

Label Field

For supported control surfaces, shows characters that represent the label for the
assignment that appears on the control surface display. Unsupported control surfaces
can only send information, not receive it, and cannot display an assignment label.

If the field contains fixed text, it can contain any number of characters. When used as a
placeholder for dynamically created text, however, the field contains three characters
that represent the label. The first character is always @, followed by two additional
characters.

+ Second Character: This character is used to define a type for the event label; for example,
track, Insert slot, Send slot, and so on.

* Third Character: This character is used to define a value for the chosen event label type,
such as the track number or name.

For example, “Send@s#” translates as “Send1,” “Send2,” and so on.

The following table shows the possible meaning for the second character.

t Track

r Surround

s Send slot

S Number of sends
e EQ band

E Number of EQs
p Insert slot

i Instrument
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The following table shows the possible meaning for the third character.

Third character Meaning

# Number of above (track number, Send slot, EQ band, Insert slot)

n Name of above

Name of parameter addressed by the assignment

P Name of first parameter

o Parameter offset, counted from 1

0 Maximum parameter offset, counted from 1

b Parameter bank (= parameter offset/bank size), counted from 1

B Total number of banks (= parameter offset/bank size), counted from

1

Setting the Flip Group and Exclusive Parameters

The following describes the use and options available for the Flip Group field and Exclusive
checkbox in the Controller Assignment Parameter area at the top right of the Expert View
window.

Flip Group Field

Enter the same integer value for two assignments, to define a counterpart for Flip mode
(for supported control surfaces that offer Flip mode). By setting a fader and an encoder
to the same flip group, for example, they are coupled. To set “none,” enter a value of 0.

For unsupported devices, you need to set up two active assignments, both of which use
the same flip group. One assignment needs to be absolute (using a fader, for example),
the other relative (encoder, for example).

Exclusive Checkbox

When selected, the assignment deactivates all other assignments that have Exclusive
turned off for the same control (on supported control surfaces). This limits the overwriting
of a modeless assignment to particular modes. For example, faders normally control
volume. To create a mode where faders control the send level, select Exclusive.

Setting Class Pop-Up Menu Parameters

Choose the class of assignment (the type of destination parameter controlled) from the
pop-up menu. Different options appear below the Class pop-up menu when you choose
a class. The following section describes the different classes, and the options available
for each.
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Mode Change

Choosing the Mode Change class lets you use an assignment to switch from one mode
to another. An additional Mode pop-up menu appears below the Class pop-up menu,
allowing you to choose between available modes. For example, the assignment buttons
on a Mackie Control can be used to choose different modes for the encoders.

Note: The mode chosen in the Mode pop-up menu is only activated when the Value
section: Mode menu is set to Direct.

If any of the other Value section: Mode menu options is chosen, the following applies:

+ Toggle: The assignment toggles between the zone's first mode and the chosen mode.
The mode change assignment must be located in the same zone.

* Relative: Useful for stepping up and down through modes in a zone (using two buttons)
or for choosing a mode with an encoder. The minimum destination parameter represents
this zone’s first mode, and the maximum represents the zone’s last mode. The mode
change assignment must be located in the same zone.

* Rotate: Useful for stepping through all available modes with a single button. Used with
a Jog Wheel, for example: Off > Scrub > Shuttle > Off. The minimum destination
parameter represents this zone's first mode, and the maximum represents the zone's
last mode. The mode change assignment must be located in the same zone.

Global

Choosing the Global class lets you use an assignment to control global parameters. A
Parameter pop-up menu appears below the Class pop-up menu, offering the parameters
listed in the following table.

Note: All options listed in the table below only work in relative mode, where changes
are relative to the starting value/position, and so on.

Global options Explanation

Playhead This assignment controls the position of the playhead; feedback is
sent in the format chosen in the control surface group’s Clock
Display parameter.

Playhead (Beats) As above, but feedback is sent in beats format.
Playhead (Time Code) As above, but feedback is sent in SMPTE time code format.
Playhead (Beats, Scrubbing) Moving the controller doesn't set the playhead position, but initiates

scrubbing. The format is defined by the control surface group’s
Format parameter. The controller value defines the scrubbing speed.

Move Locators Moves left and right locators.

Left Locator Sets left locator.

Right Locator Sets right locator.

Move Punch Locators Moves punch in and punch out locators.
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Global options

Explanation

Punch In Locator

Sets punch in locator.

Punch Out Locators

Sets punch out locator.

Marker Position

Edits position of current marker.

Marker Length

Edits length of current marker.

Global options

Explanation

Nudge selected Regions/Events

Nudges the selected regions or events by the chosen nudge value.
(See below.)

Any Solo

Feedback only. On if any (track or region) Solo button is active.

Nudge Value

Controls the nudge value used for Nudge selected Regions/Events.
Switches between tick, division, beat, bar, frame, 1/2 frame.

Scrub Status

Sets the scrubbing status for the Playhead parameter (beats,
scrubbing). Possible values are set clock, audio scrubbing, shuttle.

Automation of all tracks

Switches the automation status of all tracks between the following
values: Off, Read, Touch, Latch, Write.

Alert Text, Alert Button, Alert
Icon

Used by plug-ins to define special Alert mode. This is mainly of use
to control surface developers.

Dummy Used to temporarily disable a modeless assignment, by using the
Exclusive checkbox. See Control Name Field.

Cycle Toggles the Cycle function on and off.

Autopunch Toggles the Autopunch function on and off.

Go to Marker

Allows you to move the playhead to a marker number. An additional
number field below the Parameter pop-up menu is used to
determine the destination marker number.

Group Clutch

Sets the automation group clutch; automation groups are disabled
when the clutch is enabled. For buttons, sets the group clutch to 1
when the button is pressed, and sets it to 0 when the button is
released.

Active Sense

Used by some control surfaces (such as the HUI) to process incoming
Active Sensing messages.

Shuttle Speed

Sets the shuttle (forward and backward) speed directly. Use this for
controllers (usually knobs) that send an absolute, rather than relative,
value.

Waveform Zoom

Sets the waveform zoom level in the key focus Arrange area.

Quantize value

Sets the Quantize value in the key focus window (if this parameter
is available).

Division

Sets the Division value in the key focus window (if this parameter
is available).

Horizontal Zoom

Sets horizontal zoom in the key focus window (if this parameter is
available).
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Global options Explanation

Vertical Zoom Sets vertical zoom in the key focus window (if this parameter is
available).

Channel Strip

Choosing the Channel Strip class lets you use an assignment to set a channel strip
parameter. A Channel Strip pop-up menu appears below the Class pop-up menu, offering
the following parameters.

Channel strip type Explanation

Selected track Normally corresponds to the selected Arrange track. Exception: If
the control surface group’s Track Lock parameter is active, the
“selected” track is the one that was chosen when Track Lock was
enabled.

Fader Bank Addresses a channel strip in the control surface group’s current
View mode (Arrange, All, Tracks, Single). This is dependent on the
current Fader Bank value for this mode (see below). Example: The
View mode is All, the All view Fader Bank is five, and the number
next to this parameter is two. Thus, the eighth channel strip in the
All view is addressed (Fader Bank and No. are 0-based, so add 1).

Index Same as the Fader Bank setting, but doesn't depend on the current
Fader Bank value.

Audio An audio channel. The numerical value (No.) determines which
audio channelis addressed (again: 0-based; to address audio channel
2, use a value of 1).

Software Instrument Same as Audio setting, for software instrument channel strips.

Bus Same as Audio setting, for bus channel strips.

Auxiliary Same as Audio setting, for auxiliary channel strips.

Output Same as Audio setting, but for output channel strips.

Master The Master channel strip; if it does not exist in the project, the first

output channel strip is addressed.

If you choose the Fader Bank, Index, Audio, Software Instrument, Bus, Auxiliary, Output,
or Master setting in the Channel Strip pop-up menu, the following two parameters become
available:

« Number field: A 0-based offset, which is added to the channel strip number. The typical
use for this field is for sequential controls: Fader 1 uses offset 0, Fader 2 uses offset 1,
and so on.

Parameter field: Text description of the addressed parameter. Can only be set by
choosing the Logic Pro > Preferences > Learn Assignment for [parameter name] menu
item. Note that for plug-in and instrument parameters, Parameter Page offsets apply,
allowing you to shift the parameter addressing up and down by page.
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Key

Choosing the Key class lets you use assignments to emulate keystrokes on your computer
keyboard. You can enter the key to emulate in the Key field, which appears below the
Class pop-up menu. This is not case-sensitive.

Key Command

Choosing the Key Command class lets you use an assignment to perform a key command.
You can enter the key command in the Command field, which appears below the Class
pop-up menu. Some key commands provide on/off or enabled/disabled feedback.

If you want your key command assignment to be executed repeatedly, select the Key
Repeat checkbox at the bottom of the Controller Assignments window. For further
information, see “Key Repeat Checkbox” in Editing Value Parameters in Expert View.

Click the Show button to open the Key Commands window. The key command shown
in the Command field is automatically selected and shown in the Key Commands window.

Control Surface Group

Choosing the Control Surface Group class allows you to set a property for the control
surface group (that the assignment belongs to). When you choose this class, a Parameter
pop-up menu appears below the Class pop-up menu. This pop-up menu allows you to
choose one of the options described in Control Surface Group Parameters, or one from
those listed in the following table.

Note that assignments for unsupported control surfaces always belong to the first control
surface group.

Parameter option Additional info

Fader Bank for Current View Maps to the fader bank for the currently used View mode. This way,
you need only one assignment per left/right button for all View
modes.

Filter for All View When this parameter is selected, eight additional checkboxes (for

the eight channel strip types) are displayed, when the View mode
is All. Depending on the Value mode, these switches define which
channel strips are displayed (by using Direct mode) or which are
toggled (by using X-OR mode).

Fader Bank for: MIDI Channel These fader bank parameters are used in All View when only one
Strips, Input Channel Strips, channel strip type is displayed. This allows you to switch between
Audio Channel Strips, Instrument  several channel strip types, while retaining the current fader bank
Channel Strips, Aux Channel for each type.

Strips, Bus Channel Strips,

Output Channel Strips

If you choose one of the fader bank or parameter page settings in the Parameter pop-up
menu, the following Bank Type options appear below the pop-up menu.

*+ By One: The fader bank or parameter page is shifted by one channel strip or parameter.
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* By Bank: The fader bank or parameter page is shifted by the number of displayed
channel strips or parameters.

+ CS Group Setting: The fader bank or parameter page is shifted by the value defined for
the Parameter Page Shift Mode control surface group parameter.

Automation Group
Choosing the Automation Group class allows you to use the assignment to set an
automation group parameter.

When this class is chosen, a Group field appears below the Class pop-up menu. You can
determine the edited group by entering a number in the field. Entering a “0” sets this
parameter to the group selected for the Automation Group parameter (in the control
surface group parameters).

A Parameter pop-up menu also appears below the Group field, allowing you to choose
the automation group parameter for the assignment. For further information, see the
Group Settings section of the Logic Pro User Manual.

Editing Input Message Parameters in Expert View
The parameters in this section let you control different aspects of MIDI input.

MIDI Input Pop-Up Menu

When you choose a MIDI input (port) from the pop-up menu, all assignments that use
the same input are changed accordingly. If the assignment belongs to a supported control
surface, the device’s MIDI input also changes in the Setup window.

This makes it easy for you to create default assignments for a new control surface. These
new assignments can be moved to other computers by copying your com.apple.Logic.cs
preferences file. Simply paste this preference file into the Preferences folder of another
computer, open the Controller Assignments window in Expert view, and change the MIDI
Input parameter of one assignment (as applicable to the MIDI setup on the other
computer).

Value Change Field
Shows incoming MIDI messages that cause a value change in the destination parameter,
and lets you edit these MIDI messages.

The Value Change field displays the message as a sequence of hexadecimal bytes. The
plain language meaning appears below the field. The placeholders for the variable part
of the message are:

+ Lo7: Low 7 bits of the value (LSB or Least Significant Bits)
+ Hi7: High 7 bits of the value (MSB or Most Significant Bits)
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For messages containing only a Lo7 placeholder, the value is treated as 7 bit. For messages
containing both a Lo7 and Hi7 placeholder, the value is treated as 14 bit. The order of
Lo7 and Hi7 is honored, and there may be constant bytes in between. This allows you to
define Control Change LSB and MSB portions. For example, BO 08 Hi7 BO 28 Lo7 indicates
a 14-bit message.

Note: When you enter multiple MIDI messages, always enter each message completely,
being sure to repeat the status byte, even if it’s the same. It may help to write out the
message to ensure that the correct byte works, as you can’t know what status the
previously sent message had.

For messages containing neither Lo7 nor Hi7 placeholders, Logic Pro assumes an incoming
value of 1. This is typical for pressed or released buttons. Also see “Multiply Field” in

Touch/Release Field

Enter an integer value to use the incoming MIDI message for status changes of the
destination parameter from touched to released, or vice versa. A non-zero value means
touched; a value of 0 means released. The messages are shown and edited in the same
way as the Value Change field.

Note: The Touch/Release setting only applies to the Channel Strip assignment class, and
to parameters that can be automated.

Editing Value Parameters in Expert View
The parameters in this section let you control different aspects of the values for incoming
MIDI messages.

Min and Max Fields

Enter an integer value to set the minimum and maximum range for incoming values
represented by Lo7 and Hi7. Typically, the minimum defaults to 0, and the maximum
defaults to 127. Some control surfaces (such as the CM Labs Motor Mix) may use the same
message, with different value ranges, for different controls. For more specific information,
refer to the documentation that came with your device.

Format Pop-Up Menu
Choose the encoding format for negative values in the 7-bit portions sent over MIDI. The
choices are:

* Unsigned: No negative values are possible. The full 7- or 14-bit range is treated as a
positive number. The value range is 0 to 127 (7 bit) or 0 to 16383 (14 bit).

+ 2's complement: If the most significant bit is set, the value is negative. To obtain the
absolute value, invert all bits and add 1. The value range is from -128 (7 bit) to 127 or
-8192 to 8191 (14 bit).
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+ I'scomplement: If the most significant bit is set, the value is negative. To set the absolute
value, invert all bits. Note that this allows two possible encoding values for zero. The
value range is —127 to 127 (7 bit) or -8191 to 8191 (14 bit).

+ Sign Magnitude: If the most significant bit is set, the value is negative. To set the absolute
value, clear the most significant bit. Note that this allows two possible encoding values
for zero. This results in a value range of —127 to 127 (7 bit) or -8191 to 8191 (14 bit).

The appropriate format for a device is usually specified in its documentation. If unavailable,
check the control surface manufacturer’s website or contact them for more information.

Multiply Field
Enter a scaling value for incoming values. This is especially useful for button presses that
have a value of 1. For example:

+ To set the automation mode to Write, set Multiply to 4.00, and Mode to Direct.

+ To decrement a parameter by 1 with a button press, set Multiply to -1.00, and Mode
to Relative.

Mode Pop-Up Menu
Choose the mode used by incoming values to modify the current parameter value. The
choices are:

+ Direct: The incoming value is used as the parameter value.

+ Toggle: If the parameter’s current value is 0, it is set to the incoming value. All other
values set the parameter value to 0. This option is useful for buttons that toggle a value:
Mute, Solo, and so on.

+ Scaled: The incoming value is scaled from its value range to the destination parameter’s
value range. This is useful for faders and rotary encoders.

* Relative: The incoming value is added to the parameter’s current value. Used by
encoders, but also for buttons that increment/decrement by a certain amount (set by
the Multiply parameter).

* Rotate: The incoming value is added to the parameter’s current value, cycling between
maximum and minimum values. This is useful for button presses that cycle between
modes: automation mode, for example.

+ X-OR: The value defines a bit mask (a filter, in other words), which is applied to the
parameter’s current value with the “exclusive or” Boolean operation. Useful for
enabling/disabling single channel strip types in All view.

For On/Off parameters, Mode is set to Toggle by default. It is set to Scaled for absolute
controls (faders and knobs, for example), or to Relative for encoders.
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Feedback Pop-Up Menu
Choose the display format for the parameter’s current value (on the control surface
display). The choices are:

+ None: No feedback is sent.

+ Single Dot/Line: LED rings: only one LED; LCDs: a single vertical line.

« Left to Right Bar: A bar from the minimum to the current value.

* Bar from Center: A bar from the center position to the current value.

* Right to Left Bar: A bar from the current value to the maximum.

« Q/Spread: Two equal bars from the center to the current value.

+ Ascending Bar: A bar from the bottom to the current value.

 Descending Bar: A bar from the top to the current value.

+ Text Only: LED rings: no feedback; LCDs: no feedback as a graphics element.

+ Automatic: Dependent on the currently assigned parameter, the most suitable feedback
mode is used: Plug-in and Instrument parameters carry this information, Pan displays
a Single Dot/Line, and all other parameters display a bar that runs from left to right
(Left to Right Bar).

Note: Feedback only works for supported control surfaces, and not all settings are available
for all controls.

Text Feedback Checkbox

When selected, a text representation of the current value is sent to the control surface’s
display. The control surface display capabilities determine the display position and number
of characters that are used.

Local Feedback (Fader/Knob) Checkbox
When selected, no feedback is sent while the parameter is in Touch mode. This prevents
motorized faders from “fighting” against the user.

Key Repeat Checkbox

When selected, the assignment is repeatedly executed. The Key Repeat Rate slider—set
in the Mac OS X Keyboard & Mouse preferences—determines how quickly Logic Pro
repeats the assignment. The duration that the button/controller must be held for, before
the assignment is repeated, is set with the Delay Until Repeat slider in the Keyboard &
Mouse preferences.

Key Repeat is particularly useful for the zoom function. For example, if you assign a Key
Repeat command to the Mackie Control Zoom buttons, holding down the Zoom In button
will continuously zoom in the Logic Pro window until the button is released. This mirrors
the behavior of the Zoom key commands. The alternative is to repeatedly press the
(Mackie Control) Zoom buttons to zoom in or out more than one level.
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Note: The Key Repeat checkbox is only available for key commands, key presses, and
relative value changes. If any other assignment class is selected, the checkbox is dimmed.

The default key command assignments support the Key Repeat function (if useful or
applicable to the control surface or device), making changes unnecessary for use of this
functionality.

If you want to enable the Key Repeat function for your own assignments, you may need
to use the re-learn option for the assigned message. Key Repeat messages must include
the Lo7 byte, which provides information on the up (released) or down (pressed) state
of the assigned button.

Logic Pro guides you through the re-learning process. The current MIDI message is
automatically cleared, Learn mode is activated, and a help tag prompts you to send the
desired MIDI message.

Releasing the assigned button—after learning the MIDI message—automatically creates
the Lo7 byte, and assigns the Lo7 value (for the button release message) to the Min
parameter. The Lo7 value for the button pressed message is automatically assigned to
the Max parameter.

Typically, the value range of 1 to 127 is used for the button pressed message. The zero
(0) value is generally used for the button release message.

Note: Some control surfaces may use different value ranges (CM Labs Motormix, for
example). Assigning appropriate Min and Max values ensures that the Key Repeat function
will work with such devices. This, however, means that you need to take care when
manually changing the Min or Max value for a key command; in cases where the Min and
Max values do not match the button pressed (on) and button released (off) states, the
complete assignment will not work. Consult your control surface manual for further
information about the values it uses.

Assigning Buttons to Key Commands
In addition to assigning controllers to parameters, you can assign control surface
buttons—and button or key release messages—to key commands.

Chapter 2 Customizing Controller Assignments

59



60

1

Hw

N U

—_

(S

(o)}

To assign a control surface button to a key command
Choose Logic Pro > Preferences > Key Commands to open the Key Commands window.

e

In the Command list, click the disclosure triangle next to the category whose commands
you want to reveal, then select the key command you want to assign. You can also search
for the key command in the Search field.

Click the Learn New Assignment button.

Press the (control surface) button that you want to assign to the key command. This sends
a MIDI message to Logic Pro.

The name of the controller appears in the Assignments field.

You can repeat steps 2 to 4 to make additional assignments, if you like.

When you finish, click the Close button to exit the window.

To assign a button or key release message to a key command

Choose Logic Pro > Preferences > Key Commands to open the Key Commands window.

In the Command list, click the disclosure triangle to reveal the commands for a category,
then select the key command you want to assign (or use the Search field).

Press and hold down the (control surface) button or key that you want to assign to the
key command.

Click the Learn New Assignment button.
Release the button or key.
The name of the button or key appears in the Assignments field.

When you finish, click the Close button to exit the window.
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To delete a key command assignment
In the Key Commands window, select the key command (with an assignment that you
want to delete) in the Command list.

Select the assignment for the key command in the Assignments field.

Press the Delete key.

Controller Assignments Storage
The current controller assignments and all Control Surfaces preferences are stored in the
~/Library/Preferences/com.apple.logic.pro.cs file.

You do not need to explicitly save controller assignments or related preferences and
settings. These are automatically stored (in the location mentioned above) when you quit
Logic Pro.
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Mackie Control

You can fully control Logic Pro with a Mackie Control, and can extend its functionality
with several expansion devices, such as the XT and C4 units.

The information in this chapter applies to the Mackie Control Universal, the original
Mackie Control, the Logic Control, and the Mackie (or Logic) Control Extender (XT). The
term Mackie Control is used for all of these devices throughout the chapter.

The controls of the Mackie Control are physically grouped into different areas, called
zones. Each zone is clearly labeled, and distinguished by different shades of gray on the
device. The Mackie Control features and functions described in the following sections are
organized by these zones.

This chapter covers the following:

» Mackie Control:
« Mackie Control:

« Mackie Control:

« Mackie Control:

« Mackie Control:

Setting Up Your Mackie Control in Logic Pro (p. 64)

Mackie Control:

Mackie Control:
Mackie Control:

Mackie Control:

+ Mackie Control

« Mackie Control:

Mackie Control:
Mackie Control:

Mackie Control:

« Mackie Control

Display Zone (p. 64)

Channel Strip Controls (p. 67)
Assignment Zone (p. 70)
Fader Bank Zone (p. 84)
Function Key Zone (p. 87)
Global View Zone (p. 88)
Modifier Buttons (p. 89)
Automation Buttons (p. 89)
Utilities Buttons (p. 91)

: Transport Zone (p. 92)

Cursor Key Zone (p. 99)

Jog/Scrub Wheel Zone (p. 100)
Programmable User Modes (p. 100)
Connecting Foot Switches (p. 101)

: Assignment Overview (p. 101)
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Setting Up Your Mackie Control in Logic Pro

When you open Logic Pro, it automatically detects any powered Mackie Control unit that
is connected to your system. You can use the Mackie Control immediately—with the
default settings—or you can customize its settings, as described in Basic Control Surface
Setup, and Customizing Controller Assignments.

Once set up, you can use the Mackie Control to control Logic Pro in the following ways,
or perhaps take an alternate approach that best meets your working preferences.

+ With your project open in the Arrange window, select the channel strips you want to
control by pressing the Fader Bank buttons on the Mackie Control.

See Mackie Control: Fader Bank Zone for more information.

+ Select the parameters you want to edit, and whether you want to edit multiple channels
(Mixer view) or a single channel (Channel view), using the Assignment buttons.

See Mackie Control: Assignment Zone for more information.

+ Start playback, and move the playhead to the position where you want to work, using
the Mackie Control transport buttons and Jog Wheel.

See Mackie Control: Transport Zone and Mackie Control: Jog/Scrub Wheel Zone for
more information.

+ Edit the project with the channel strip controls.

See Mackie Control: Channel Strip Controls for more information.

Mackie Control: Display Zone

The display zone, located along the top of the Mackie Control, features four displays. Each
shows different information:

+ Main Liquid Crystal Display (LCD)

+ Assignment display

+ Time display

+ Solo LED

Mackie Control: Main Liquid Crystal Display (LCD)

The main LCD is divided into eight sections (or columns), each with two lines of text. Each
section displays information for the channel strip controls directly below it. Depending
on the parameters you are editing and whether Mixer view or Channel view is active, the
information displayed on the main LCD changes. In general, the upper row of each section
displays the (abbreviated) track (or channel) name, and the lower row displays the
(abbreviated) parameter name and its value.
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In some modes, a long parameter name (or other text) appears briefly onscreen while
you are moving the corresponding control. You can set the display and duration of long
parameter names in the Control Surfaces preferences. For information on setting
preferences, see Basic Control Surface Setup.

Note: On the LCD, 8-bit ASCII characters such as curly quotes and umlauts are replaced
with the best-possible 7-bit ASCII equivalent.

Mackie Control: Assignment Display

The Assignment display (also referred to as the mode display), to the right of the main
LCD, shows a two-digit abbreviation for the current assignment status. A period (.) appears
at the bottom-right corner of the display when Channel view is active.

Mackie Control: Time Display

The Time display, to the right of the Assignment display, shows the current playhead
position, either in musical time divisions (BEATS) or in SMPTE time code format (SMPTE).
A small LED to the left of the display indicates the current display format.

+ When the format is set to Beats, the four segments of the Time display show the current
playhead position as bars, beats, beat subdivisions, and ticks.

+ When the format is set to SMPTE, the four segments of the Time display show the
current playhead position as hours, minutes, seconds, and frames.

You can switch between formats by pressing the SMPTE/BEATS button directly below
the display. You can also set the default format with the Clock Display parameter in the
Control Surfaces Setup window. Information on this (and other configuration options) is
found in Configuring Your Control Surface Setup.

Mackie Control: Solo LED

The Solo LED (labeled as Rude Solo on the Mackie Control), located at the right edge of
the display zone, is lit when a channel strip is set to solo, or when Solo mode is turned
on. It is a helpful reminder in situations where you have soloed a channel strip, and then
switched the fader bank, resulting in the Solo LED (of the soloed channel strip) being
hidden on the control surface.

Mackie Control: Display Buttons
These buttons, located just below the left edge of the Time display, affect what you see
in the main LCD and Time display.

NAME/VALUE
Press the NAME/VALUE button to switch between the two parameter display formats
(either the parameter name or value is shown) on the main LCD.
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Pressing the NAME/VALUE button while holding the SHIFT button cycles through three
level meter modes on the main LCD:

« Vertical: In this mode, the last character of each channel (in both LCD rows) is overlaid
by a vertical bar which shows the channel level. The text characters reappear when the

level meter is not visible.

* Horizontal with Peak Hold: In this mode, the lower row of the LCD is replaced by
horizontal channel level bars. Peak Hold appears as a hollow box, which disappears
after a few seconds. Signal overloads (clipping) are indicated by an asterisk, which
remains on the LCD display until cleared (see below).

+ Off: In this mode, no level meter bars are displayed in the main LCD.

In all three modes, the SIGNAL LEDs of the channel strips function as per usual, indicating

the presence of a signal.

Pressing the NAME/VALUE button while holding down the CONTROL button clears any
overload (clipping) indicators in the Logic Pro Mixer, and in the LCD of the Mackie Control
(if the Horizontal with Peak Hold mode is active).

Pressing the NAME/VALUE button while holding down the CMD/ALT or OPTION button
activates Control Surface Group Settings mode. This mode lets you edit the following
control surface group settings, some of which are not accessible with a single button:

Control Action

V-POT 5

Sets the track name display format.

+ Name: Displays the track name only.
+ No: Name: Displays the track number and name.

V-POT 6

Switches Channel view to Lock mode.

+ Off: The standard mode, where selecting a channel strip makes
it the active (currently being edited) channel strip.

+ On: Locks the active channel strip. Selection of another channel
strip has no impact on the channel strip being edited.

When you switch from On to Off, the channel strip is also updated.

V-POT 7

Switches the LCD display format.

+ Name: The upper line of the LCD displays global info, and the
lower line displays parameter names.

« Value: The upper line of the LCD displays parameter names, and
the lower line displays parameter values.

Functionally, this is identical to pressing the NAME/VALUE button.

V-POT 8

Switches the Clock display format.

+ Beats: Clock is displayed in bars, beats, beat subdivisions, and
ticks.
+ SMPTE: Clock is displayed in SMPTE format.

Functionally, this is identical to pressing the SMPTE/BEATS button.
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You can exit Control Surface Group Settings mode by pressing NAME/VALUE, or by
entering one of the Marker or Nudge modes.

SMPTE/BEATS

Press the SMPTE/BEATS button, located just below the SMPTE/BEATS LEDs, to switch
between the two time formats (SMPTE time or beats). For more information, see
Mackie Control: Time Display.

Mackie Control: Channel Strip Controls

Directly below the main LCD display are eight sets of channel strip controls. You can use
these to control Logic Pro channel strip parameters, plug-in parameters, and other
Logic Pro functions. Each channel strip of both the Mackie Control and XT units includes
the following controls, which are described in the following sections:

+ V-Pot rotary encoder with button. See Mackie Control: V-Pot.

+ REC/RDY button and LED. See Mackie Control: REC/RDY Button.
+ Signal LED. See Mackie Control: Signal LED.

+ SOLO button and LED. See Mackie Control: Solo LED.

+ MUTE button and LED. See Mackie Control: MUTE Button.

+ SELECT button and LED. See Mackie Control: SELECT Button.

+ Touch-sensitive motorized fader. See Mackie Control: Touch-Sensitive Motorized Faders.

Mackie Control: V-Pot

The V-Pot is a rotary encoder, with an integrated button (accessed by pressing down on
the top of the encoder). You can use the V-Pot to adjust the channel’s send level and
pan/balance (in Channel view), or to adjust effect or instrument plug-in parameters. The
V-Pot can also be used to scroll through and choose items such as plug-ins, software
instruments, and more from menus, and to determine send destinations. The faster you
turn the V-Pot, the quicker it changes values, scrolls through menus, and so on.

The top of each V-Pot has an integrated push button, which typically sets a default
parameter value (if a parameter has more than two possible values) or switches between
two parameter values (on/off). The button can also be used to activate a function you
have selected with the V-Pot. For example, you can turn the V-Pot to scroll through a list
of effect plug-ins for one of the channel Insert slots. Once the effect you want is displayed
in the main LCD, press the top of the V-Pot to select and insert the effect, and open the
plug-in window. The button is also sometimes used to switch to a special assignment
mode.

When a value or name (such as a plug-in) has been preselected, but not confirmed or
instantiated, the value (or name) flashes on the main LCD until you press the V-Pot button.
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The current value of the parameter you are adjusting with the V-Pot is displayed on the
main LCD (depending on the Name/Value setting), and is also indicated by the ring of
LEDs encircling the V-Pot. The way that parameter values are displayed on the LED ring
varies depending on the type of parameter being displayed.

Holding down the CMD/ALT button sets the V-Pots to high-resolution (fine) mode, for
parameters where this mode applies.

Holding down the OPTION button and turning the V-Pot switches between the minimum,
default, and maximum values for the parameter.

Mackie Control: REC/RDY Button

Pressing the REC/RDY button arms the channel strip for recording. If the channel is
currently armed, pressing the REC/RDY button disarms it. Each REC/RDY button features
a red LED, which is illuminated when the channel is armed for recording.

Holding down the OPTION button while pressing the REC/RDY button of any channel
disarms all channel strips.

Mackie Control: Signal LED
The Signal LED indicates the presence of an outgoing MIDI or audio signal. During
recording, it indicates the presence of an incoming signal.

Mackie Control: SOLO Button

Pressing the SOLO button solos the channel strip, which equates to muting all unsoloed
channels. Each SOLO button features an amber LED which is illuminated when the channel
strip is soloed. The Rude Solo LED (on the right edge of the display zone) is also lit
whenever any channel is soloed.

Holding down the OPTION button while pressing any channel SOLO button disables solo
for all channel strips.

In the Send Destination/Level view (see Mackie Control: SEND Button), the SOLO button
controls the Pre/Post mode selection for both Mixer view and Channel view.

Mackie Control: MUTE Button
Pressing the MUTE button silences the channel. Each MUTE button features a red LED
which is lit when the channel is muted.

Holding down the OPTION button while pressing any channel strip MUTE button unmutes
all muted channel strips.

In the EQ Frequency/Gain and Send Destination/Level views, the MUTE button controls
the EQ bypass or Send Mute function. This affects both Mixer and Channel views.
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Mackie Control: SELECT Button

Pressing the SELECT button chooses (activates) the channel for channel-based editing or
assignment commands. Each SELECT button features a green LED which is lit when the
channel is selected.

Holding down the SHIFT button while pressing a channel’s SELECT button sets the channel
volume to unity level (0 dB).

Note: While holding down the SHIFT button, the SELECT button LED indicates if the
channel volume is set to 0 dB.

Holding down the OPTION button while pressing the SELECT button of any channel
creates a new track—assigned to the same channel strip as the selected track—and
switches to Arrange view.

Holding down the SHIFT and OPTION buttons while pressing a channel’s SELECT button
creates a new track with the next channel strip (the one following the selected track),
and switches to Arrange view.

Mackie Control: Touch-Sensitive Motorized Faders

The motorized fader of each channel strip is generally used to control the channel level,
just like a volume fader on a mixing console. You can, however, also assign the fader to
control other parameters by using “Flip” mode.

Flip mode is activated by pressing the FLIP button, just above the MASTER fader. When
Flip mode is activated, you can control the parameter which is currently assigned to the
channel’s V-Pot with the fader. This allows more precise control of pans, aux returns, MIDI
track parameters, EQs, effects, software instrument, or other channel parameters.

You can switch between channels being controlled with the eight faders, by pressing
one of the CHANNEL or FADER BANK buttons. See Mackie Control: CHANNEL LEFT and
CHANNEL RIGHT Buttons and Mackie Control: BANK LEFT and BANK RIGHT Buttons.
The behavior of the faders changes in different modes, as outlined below:

* In Flip mode: Duplicates or swaps parameters with the V-Pot on the same channel.

+ In Surround Angle/Diversity view: Adjusts surround diversity.

* In EQ Frequency/Gain view: Adjusts the gain of the selected EQ band.

* In Send Destination/Level Mixer view: Adjusts the send level of the selected send.

* In Send Destination/Level Channel view: Adjusts the send level of the send on the selected
channel strip.
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Mackie Control: Master Fader

The Master fader controls the level of the primary master channel strip in the Logic Pro
Mixer. This raises or lowers the level of all output channel strips, without changing their
relative levels.

When no master channel strip exists in the project, the Mackie Control Master fader is
mapped to output channel strip 1-2.

If you use multiple audio systems simultaneously, the Master fader only controls the
master channel strip of the first device (matching the order shown in the Audio Preferences
window).

Mackie Control: Assignment Zone
Directly below the Assignment LED are six ASSIGNMENT buttons.

Press one of the ASSIGNMENT buttons to select the type of parameter that you want to
control or edit with the channel strip V-Pots, faders, and switches. The corresponding LED
is lit to indicate the currently active assignment, and the Assignment display shows a
two-digit abbreviation of the assignment type.

The ASSIGNMENT buttons work in both Single and All views. View modes are discussed
in Control Surface Group Parameters.

Mackie Control: Assignment Modes
Each ASSIGNMENT button has two views: Mixer view and Channel view. These views
provide two ways to edit parameters in your project.

* Mixer view: Displays, and allows you to edit, a single parameter in multiple channels.

* Channelview: Displays, and allows you to edit, multiple parameters for a single channel.
The mode display shows a period (.) in the lower-right corner when Channel view is
active.

Pressing an ASSIGNMENT button once selects it, and switches to the Mixer view, except
when switching between Instrument Edit view and Plug-in Edit view. In this case, the
mode remains in Channel view.

Note: For each of the ASSIGNMENT buttons, the parameters you can edit will change,
depending on the active view mode.

The NAME/VALUE button also affects what is shown on the main LCD when in the Mixer
and Channel views. For more information, see Mackie Control: Function Key Zone.

Chapter 3 Mackie Control



Mackie Control: TRACK Button
Pressing the TRACK button selects Channel view, and assigns the channel strip controls
to edit channel strip parameters.

+ Press the TRACK button once to edit a single parameter in multiple channel strips, and
to activate Mixer view.

+ Press the TRACK button again to edit multiple parameters for a single channel strip,
and switch to Channel view.

Mixer View

Mixer view allows you to edit a single parameter in multiple channel strips: volume, pan,
input format, input assignment, output assignment, or automation mode. When you
switch to Mixer view, the parameter being edited is briefly displayed on the right side of
the main LCD. The mode display shows “tr” (for track), and the upper row of the LCD
shows track names.

Press NAME/VALUE to display parameter values on the lower row of the LCD. These are

shown when you turn a V-Pot, or press its button.

You can manipulate the following controls for editing in Mixer view.

+ Turning the V-Pots changes the associated channel strip parameter.

+ Pressing the button on a V-Pot sets the parameter to its default value.

+ The Cursor Left/Cursor Right buttons switch to the next or previous channel strip
parameter. The selected parameter is displayed briefly in the upper row of the LCD.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

Channel View

Channel view allows you to edit the most important channel strip parameters for a single
channel strip: volume, pan, instrument, Insert slot 1 assignment, Insert slot 2 assignment,
Send 1 level, Send 2 level, and Send 3 level. When you switch to Channel view, the mode
display shows “tr.; and the upper row of the LCD shows the name of the channel strip.

Press NAME/VALUE to show parameter names in the upper row, and parameter values
in the lower row.

The following table lists what each V-Pot edits in Channel view mode:

Control Action

V-Pot 1 Edits volume. The current value is shown in the lower row of the
LCD.

V-Pot 2 Edits pan. The current value appears in the lower row of the LCD.

V-Pot 3 For software instrument tracks, turn to choose the instrument. Press

the V-Pot 3 button to confirm your choice, insert the instrument,
and open the plug-in window.
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Control Action

V-Pot 4 For audio and software instrument tracks, turn to choose the plug-in
used on Insert slot 1. Press the V-Pot 4 button to confirm your
choice, insert the effect, and open the plug-in window.

V-Pot 5 For audio and software instrument tracks, turn to choose the plug-in
used on Insert slot 2. Press the V-Pot 4 button to confirm your
choice, insert the effect, and open the plug-in window.

V-Pot 6 Edits the send level of Send 1.
V-Pot 7 Edits the send level of Send 2.
V-Pot 8 Edits the send level of Send 3.

Holding down SHIFT while pressing one of the MUTE or V-Pot buttons switches between
mute and bypass.

Control Action

V-Pot 1 or Mute 1 Mutes (or unmutes) the channel strip.
V-Pot 2 or Mute 2 Mutes (or unmutes) the channel strip.
V-Pot 3 or Mute 3 For software instrument tracks, mutes (or unmutes) the software

instrument used on the channel strip.

V-Pot 4 or Mute 4 For audio and software instrument tracks, bypasses the effect plug-in
used in Insert slot 1.

V-Pot 5 or Mute 5 For audio and software instrument tracks, bypasses the effect plug-in
used in Insert slot 2.

V-Pot 6 or Mute 6 Mutes (or unmutes) Send 1.

V-Pot 7 or Mute 7 Mutes (or unmutes) Send 2.

V-Pot 8 or Mute 8 Mutes (or unmutes) Send 3.

Track Shortcut Menu

Hold the TRACK button to display the Track shortcut menu on the LCD. When this menu
is active, the mode display shows “t_ “ (for Track shortcuts). Press one of the V-Pot or
Function buttons to make the following changes.

Control Action

V-Pot 1 or F1 Switches to Mixer view, and selects volume as the parameter edited
by the V-Pot.

V-Pot 2 or F2 Switches to Mixer view, and selects pan as the parameter edited by
the V-Pot.

V-Pot 3 or F3 Switches to Mixer view, and selects input format as the parameter

edited by the V-Pot.

V-Pot 4 or F4 Switches to Mixer view, and selects the input assignment as the
parameter edited by the V-Pot.
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Control Action

V-Pot 5 or F5 Switches to Mixer view, and selects the output assignment as the
parameter edited by the V-Pot.

V-Pot 6 or F6 Switches to Mixer view, and selects the automation mode as the
parameter edited by the V-Pot.

V-Pot 7 or F7 Switches to Mixer view, switches Logic Pro to Arrange view, and
selects the automation parameter selected in the Arrange window.

V-Pot 8 or F8 Switches to Channel Strip Setup view.

Channel Strip Setup View

Hold the TRACK button to display the Track shortcut menu on the LCD, and press V-Pot
8 or press F8 to enter Channel Strip Setup view. In this mode, you can edit the following
(less frequently used) parameters for the selected channel strip.

Control Action

V-Pot 1 Edits the channel strip format (mono, stereo, left, right, surround).

V-Pot 2 Edits the Spread parameter.

V-Pot 3 Selects the channel strip input assignment. Confirm by pressing
V-Pot 6.

V-Pot 4 Selects the channel strip output assignment. Confirm by pressing
V-Pot 7.

V-Pot 5 Edits the automation mode.

V-Pot 6 Edits group membership. You can only choose one group or Off.
To make a channel strip a member of multiple groups, use Group
Edit mode.

Mackie Control: PAN/SURROUND Button
Pressing the PAN/SURROUND button activates Pan/Surround Mixer view. Press the button
repeatedly to switch between Pan/Surround Mixer and Pan/Surround Channel views.

Pan/Surround Mixer View

Pan/Surround Mixer view allows you to edit one pan/surround parameter for all channel
strips: Angle or Pan (on non-surround channel strips), Diversity, LFE, Spread (on surround
channel strips). The parameter being edited is displayed briefly when switching to this
mode. Regardless of the selected (and active) surround parameter, non-surround channel
strips always display the standard Pan control.

In a project containing both surround and non-surround channel strips, you can edit a
specified surround parameter for surround channel strips, while the V-Pots of non-surround
channel strips edit pan position, as usual.

+ The mode display shows “Pn” (for Pan).

+ The upper row of the LCD shows channel strip names.
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+ Turning the V-Pots changes the current pan/surround parameter.

+ The Surround Angle parameter rotates between 0 and 359 degrees, avoiding any angle
limits.

+ Pressing the button on a V-Pot sets the parameter to its default value.
« Cursor Left/Cursor Right switches to the next or previous surround parameter. The
selected parameter appears briefly in the upper row of the LCD.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

Pan/Surround Channel View
Pan/Surround Channel view allows you to edit all surround parameters for the selected
channel strip.

+ The mode display shows “Pn” (for Pan).

+ The upper LCD row shows the name of the channel strip and “Pan/Surround.”

Control Action

V-Pot 1 Edits angle (or pan on non-surround channel strips).
V-Pot 2 Edits diversity.

V-Pot 3 Edits LFE level.

V-Pot 4 Edits spread.

V-Pot 5 Edits Surround X.

V-Pot 6 Edits Surround Y.

Note: The Angle/Diversity and X/Y pairs influence each other. Only the Angle/Diversity
parameters are automated and recorded.

Alternate Mode Options
Hold down the PAN/SURROUND button to display a submenu on the LCD. The V-Pots
and function keys allow you to make the following changes.

V-Pot 1 or F1 Switches to Pan/Surround Mixer view and selects Angle.
V-Pot 2 or F2 Switches to Pan/Surround Mixer view and selects Diversity.
V-Pot 3 or F3 Switches to Pan/Surround Mixer view and selects LFE level.
V-Pot 4 or F4 Switches to Pan/Surround Mixer view and selects Spread.
V-Pot 5 —

V-Pot 6 or F5 Switches to Pan/Surround Channel view.
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Control Action
V-Pot 7 or F6 Switches to Surround Angle/Diversity Mixer view.

+ The mode display shows “Ad” (Angle/Diversity).
The upper LCD row shows channel strip names.

+ The lower LCD row shows the surround angle currently assigned
to each channel strip.

+ Turning a V-Pot changes the surround angle (or adjusts pan
position on non-surround channel strips).

* Pressing a V-Pot sets the surround angle to its default value.

+ The faders edit surround diversity.

V-Pot 8 or F7 Switches to Surround X/Y Mixer view.

+ The mode display shows “XY".

+ The upper LCD row shows channel strip names.

The lower LCD row shows the surround X value currently assigned

to each channel strip.

+ Turning a V-Pot changes the surround X value (or adjusts pan
position on non-surround channel strips).

+ Pressing a V-Pot sets surround X to its default value.

+ The faders edit surround Y.

Note: X and Y have a value range of —1000 to +1000, but the resolution is not that high,
as surround positions are currently recorded as 7-bit data.

Note: The X and Y parameters are limited to a rectangular coordinate system. As such,
value pairs outside the surround circle are not possible. If you try to set a Y value that is
invalid, the X coordinate is automatically adjusted to a valid position, and vice versa. As
an example, moving Y to +1000 will result in an X coordinate value of 0.

When only one coordinate value is edited, the other coordinate value defaults to the
setting of the most recently selected channel strip. This helps you to create linear
movements.

Mackie Control: EQ Button
Pressing the EQ button activates EQ Mixer view. Pressing the button repeatedly switches
between EQ Mixer view and EQ Channel view.

Note: If no Channel or Linear Phase EQ is present on the selected channel strip, a Channel
EQ is inserted automatically when you enter EQ Channel view.

EQ Mixer View

EQ Mixer view allows you to edit one equalizer parameter for all channel strips: Frequency,
Gain, Q, or EQ bypass. The EQ band number, and parameter being edited, are displayed
briefly when you switch to this mode.

+ The mode display shows E1 to E8, indicating the selected EQ band.

+ The upper LCD row shows channel strip names.

Chapter 3 Mackie Control



76

+ Turning the V-Pots changes the current EQ parameter.
+ Pressing a V-Pot button sets the parameter to its default value.
+ Cursor Up/Cursor Down switches to the next or previous EQ band.

+ Cursor Left/Cursor Right switches to the next or previous EQ parameter. The selected
parameter is displayed briefly in the upper LCD row.

* Pressing a MUTE button while holding down the SHIFT button switches the current EQ
band'’s Bypass status.

+ When Flip mode is turned on, the MUTE buttons display, and switch, the current EQ
band'’s Bypass status.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

EQ Channel View
EQ Channel view allows you to edit all EQ parameters—in all bands—for the selected
channel strip.

+ The mode display shows EQ (EQ channel strip).

+ The upper row of the LCD shows the name of the channel strip, EQs, the page number,
and total number of pages (for example: “Page 1/2").

Control Action

V-Pot 1 Edits the frequency of odd-numbered EQ bands.

V-Pot 2 Edits the gain of odd-numbered EQ bands.

V-Pot 3 Edits the Q-factor of odd-numbered EQ bands.

V-Pot 4 Switches the bypass status of odd-numbered EQ bands.
V-Pot 5 Edits the frequency of even-numbered EQ bands.

V-Pot 6 Edits the gain of even-numbered EQ bands.

V-Pot 7 Edits the Q-factor of even-numbered EQ bands.

V-Pot 8 Switches the bypass status of even-numbered EQ bands.

The Cursor Left and Cursor Right buttons switch to the next or previous EQ band. The
LCD displays two EQ bands. If you have one or more connected Mackie Control (XT) units,
each XT can display two EQ bands—up to a total of eight bands.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

Alternate EQ Edit Mode Options

Holding down the EQ button gives you access to a further submenu in the LCD. The mode
display shows E_ or E_., depending on whether you are in EQ Mixer or EQ Channel View
mode.
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Control Action

V-Pot 1 or F1 Switches to EQ Mixer view and selects frequency.

V-Pot 2 or F2 Switches to EQ Mixer view and selects gain.

V-Pot 3 or F3 Switches to EQ Mixer view and selects Q.

V-Pot 4 or F4 Switches to EQ Mixer view and selects bypass.

V-Pot 6 or F6 Switches to EQ Channel view.

V-Pot 7 or F7 Switches to Frequency/Gain Mixer view. In this mode, you can edit

the frequency and gain parameters of a specific EQ band (1 to 8)
for all channel strips.

+ The mode display shows F1 to F8, indicating the selected EQ
band.

+ The upper LCD row shows channel strip names.

+ The lower LCD row shows the frequency of the selected EQ band.

+ Turning a V-Pot changes EQ frequency.

+ Pressing a V-Pot sets the EQ frequency to its default value.

+ Use the Mute buttons to bypass the EQ.

+ Use the faders to adjust the EQ gain.

V-Pot 8 or F8 Switches to Frequency/Gain Channel view. In this mode, you can
edit the frequency and gain parameters for all EQ bands of the
selected channel strip. Each pair of channel strips corresponds to
one EQ band.

+ The mode display shows FG.

+ V-Pots 1 to 8 control the frequency of EQ bands 1 to 8.

+ Mute buttons 1 to 8 control the bypass of EQ bands 1 to 8.
+ Faders 1 to 8 control the gain of EQ bands 1 to 8.

Note: The faders form a frequency response curve in this mode, if the EQ bands have
ascending frequency values.

Tip: You can edit another channel strip’s EQ without leaving this view by simply selecting
the channel strip in Logic Pro, or by pressing the appropriate SELECT button on the
Mackie Control.

Mackie Control: SEND Button
Pressing the SEND button activates Send Mixer view. Pressing the button repeatedly
switches between Send Mixer view and Send Channel view.

Send Mixer View

Send Mixer view allows you to edit one send parameter for all channel strips: Destination,
Level, Position, or Mute. The Send slot number, and the parameter being edited, are
displayed briefly on the LCD when switching to this mode.

+ The mode display shows S1 to S8, indicating the selected Send slot.
+ The upper LCD row shows channel strip names.

+ Turning the V-Pots changes the current send parameter.
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+ Pressing a V-Pot confirms the preselected send destination, and sets the other send
parameters to their defaults.

+ Cursor Up/Cursor Down switches to the next or previous Send slot.

+ Cursor Left/Cursor Right switches to the next or previous send parameter. The selected
parameter appears briefly in the upper LCD row.

+ Pressing a MUTE button while holding down the SHIFT button switches the current
send’s mute status.

+ When Flip mode is turned on, the MUTE buttons display, and edit, the current send’s
mute status.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

Send Channel View

Send Channel view allows you to edit all send parameters for the selected channel strip.
The mode display shows “SE.” (for send channel strip). The upper row of the LCD shows
the name of the channel strip, the text “Sends,” the page number, and total number of

pages—“Page 1/4," for example.

Control Action

V-Pot 1 Edits the destination of odd-numbered sends.

V-Pot 2 Edits the level of odd-numbered sends.

V-Pot 3 Edits the position (pre/post) of odd-numbered sends.
V-Pot 4 Sets the mute status of odd-numbered sends.

V-Pot 5 Edits the destination of even-numbered sends.

V-Pot 6 Edits the level of even-numbered sends.

V-Pot 7 Edits the position (pre/post) of even-numbered sends.
V-Pot 8 Sets the mute status of even-numbered sends.

The Cursor Left and Cursor Right buttons shift between pages. The number of sends that
can be displayed simultaneously depends on the number of Mackie Control XTs you have.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

Alternate Send Edit Mode Options

Holding down the SEND button gives you access to a further submenu in the LCD. The
mode display shows S_or S_., depending on whether you are in Send Mixer view or Send
Channel view.

Control Action

V-Pot 1 or F1 Switches to Send Mixer view and selects destination.

V-Pot 2 or F2 Switches to Send Mixer view and selects send level.
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Control Action

V-Pot 3 or F3 Switches to Send Mixer view and selects position.

V-Pot 4 or F4 Switches to Send Mixer view and selects mute.

V-Pot 5 or F5 Switches to Send Channel view.

V-Pot 6 or F6 Switches to Send Channel Strip 2 view: This mode is similar to Send

Channel view, but parameters are arranged in a slightly different
way. You can control one parameter for all Send slots used in the
selected channel strip.

+ The mode display shows “SE.” (Send channel strip).

+ The upper LCD row shows the name of the channel strip, the
text “Sends,” the page number, and total number of pages.

+ V-Pots 1 to 8 edit the displayed parameter.

+ The horizontal cursor buttons shift between pages. The number
of parameters that can be displayed simultaneously depends on
the number of Mackie Control XTs you have.

V-Pot 7 or F7 Switches to Destination/Level Mixer view. In this mode, you can
control one Send slot for all channel strips. Each channel strip
corresponds to the channel strip name shown in the upper LCD
row.

+ The mode display shows d1 to d8, indicating the selected send.

+ The upper LCD row shows channel strip names.

+ The lower LCD row shows the destination of the selected send.

+ Turning a V-Pot preselects the send destination.

+ Pressing a V-Pot confirms the preselected send destination.

+ The SOLO buttons edit send position—a lit SOLO LED indicates
Pre Fader mode.

+ The MUTE buttons set the send mute status.

+ The faders edit the send level.

V-Pot 8 or F8 Switches to Destination/Level Channel view. You can control all
Send slots for the selected channel strip in this mode. Each channel
strip corresponds to the (embossed) send number shown below
the LCD.

+ The mode display shows “dL.”

» Turning a V-Pot preselects the corresponding send destination.

+ Pressing a V-Pot confirms a preselected send destination.

+ The Solo buttons edit send position—a lit Solo LED indicates Pre
Fader mode.

+ The MUTE buttons set the send mute status.

+ The faders edit the send gain.

If one or more sends are activated on multiple channels, you can switch between them
while in the Channel View modes, by simply pressing the SELECT button of the desired
channel.
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Mackie Control: PLUG-IN Button
Pressing the PLUG-IN button activates Plug-in Mixer view. Pressing the button repeatedly
switches between Plug-in Mixer view and Plug-in Channel view.

Note: There is one exception to this behavior: If you are in Instrument Edit view, pressing
this button switches to Plug-in Edit view. For more information, see

Plug-in Mixer View
In this mode, you can view and edit the plug-ins associated with a particular Insert slot
for all channels.

+ The mode display shows P1 to P9, or 10 to 16, indicating the selected Insert slot number.
Note: If a software instrument channel is selected, the display shows P1 to P9 and 10 to
15.

+ The upper row of the LCD shows channel strip names.

+ The lower row of the LCD shows the currently selected plug-in for the active Insert slot.
Muted plug-ins are shown with an asterisk (*) that precedes the plug-in name.

+ Turning the V-Pots preselects a new plug-in. The plug-in name flashes until confirmed
by pressing the V-Pot button.

+ Turning another channel’s V-Pot cancels any earlier preselection, and starts preselection
on the newly selected channel strip.

+ Pressing a V-Pot button:

+ Confirms or activates the preselected plug-in (assuming that you've made your
preselection by turning the V-Pot).

+ Opens a plug-in window, if none is opened. If a plug-in window is open, and Link
mode is turned on, the selection of another plug-in replaces the existing plug-in
window.

+ Switches to Plug-in Edit view.

+ The Cursor Up/Cursor Down buttons change the currently displayed plug-in Insert slot
(1 to 15).

* Pressing a V-Pot or MUTE button while the SHIFT button is held down mutes or unmutes
the plug-in.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

To remove a plug-in
Preselect the “--" value (by turning the V-Pot fully counterclockwise), then press the V-Pot
button of the appropriate Insert slot.

The Mackie Control does not switch to Plug-in Edit view, and no plug-in window opens
when the “--" value is chosen. If a plug-in window is open, it closes (if Link mode is inactive).
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Plug-in Channel View
This mode shows the plug-ins associated with all Insert slots for the selected channel.

+ The mode display shows the text “PL.”
+ The upper LCD row shows Ins1PI through Ins8PI.

+ The lower LCD row shows the plug-in that is currently selected for this Insert slot. Muted
plug-ins are indicated by an asterisk (*), which precedes the plug-in name.

+ Turning the V-Pots preselects a new plug-in. The plug-in name flashes until activated.

+ Turning another channel’s V-Pot cancels any previous preselection and starts
preselection on the newly selected channel strip.

* Pressing a V-Pot button:

+ Activates the preselected plug-in (assuming that you've made your preselection by
turning the V-Pot).

+ Opens a plug-in window if none is opened. (If a plug-in window is open and Link
mode is turned on, the selection of another plug-in replaces the existing plug-in.)

+ Switches to Plug-in Edit view.

+ Pressing a V-Pot button while the SHIFT button is held down mutes/unmutes the
plug-in.

To remove a plug-in
Preselect the “--" value (by turning the V-Pot fully counterclockwise), then press the V-Pot
linked to the appropriate Insert slot.

The Mackie Control does not switch to Plug-in Edit view, and no plug-in window opens.
If one was previously opened, it closes (if Link mode is inactive).

Plug-in Edit View
You can view and edit plug-in parameters in this mode.

+ The mode display shows P1. to P8., indicating the number of the selected plug-in Insert
slot.

+ Depending on the NAME/VALUE button, the LCD display changes between the two
modes in the following ways:

+ Name: The upper LCD row shows the channel strip’s name, insert number, plug-in
name, current parameter page, and total number of parameter pages. The lower LCD
row shows the name of the parameter, which can be edited via the corresponding
V-Pot (the one below the parameter name).

« Value: The upper LCD row shows the name of the parameter which can be edited
via the corresponding V-Pot. The lower LCD row shows the current value of the
parameter. If there is sufficient onscreen space, the unit type will be added; for
example, Hz or dB.
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+ Turning the V-Pots changes parameter values.

+ Pressing a V-Pot button sets the parameter to its default value, except when the
parameter only has two values (on/off, for example). In this case, pressing the V-Pot
button switches between these values.

+ The Cursor Left/Cursor Right buttons switch to the next or previous parameter page.
Note: Ensure that the ZOOM button isn't active when using the cursor buttons.

When using the cursor buttons to switch between parameters, the parameters change
in groups of eight (unless the parameters on the last page do not make a complete group
of eight). For example, if a plug-in has 19 parameters, and the Mackie Control is controlling
parameters 1 to 8:

+ Pressing the Cursor Right button shifts to parameters 9 to 16.

+ Pressing the Cursor Right button again shifts to parameters 12 to 19.

+ Pressing the Cursor Left button shifts back to parameters 9 to 16, not 4 to 11.

This way, you always revert to the page positions you expect to find, and are comfortable
with.

+ To switch by a single parameter, rather than by page, hold down the CMD/ALT key
while pressing the Cursor Left or Cursor Right button.

+ The Cursor Up/Cursor Down buttons change the currently displayed Insert slot (1 to
15).

If you have a control surface group consisting of several Mackie Control and XT units, the
parameters are distributed across their displays. The number of parameters shown depends
on the Multiple Controls per Parameter settings in the Logic Pro > Preferences > Control
Surfaces > Preferences. See for details.

Note: When you exit Plug-in Edit view, the plug-in window closes.

Compatibility
Mackie Control can edit all plug-ins that can be automated. The plug-in type (Logic Pro
native, TDM, Audio Units) is irrelevant.

Some third-party manufacturer plug-ins unfortunately don't provide parameter names
or values as text. In such cases, parameters are named and enumerated as “Control #1,”
“Control #2,” and so on, with values displayed as numbers ranging between 0 and 1000.

Contact the plug-in manufacturer to obtain a version that supports this feature.

Mackie Control: INSTRUMENT Button

Pressing the INSTRUMENT button activates Instrument Mixer view, unless the

Mackie Control is currently in Plug-in Edit view. In this case, pressing the INSTRUMENT
button switches to Instrument Edit view.

Chapter 3 Mackie Control



If you can’t see the software instrument channel strips, use the BANK or CHANNEL buttons
in the Fader Bank zone, or switch to All view by pressing the INSTRUMENT button. (This
assumes that you have created at least one or more software instrument tracks.)

Instrument Mixer View

In this mode, you can view and edit the Instrument slots of all channels.
+ The mode display shows “In” (for instrument).

+ The upper LCD row shows channel strip names.

+ The lower LCD row shows the currently selected instrument. Muted instrument names
are preceded by an asterisk (*).

+ Turning the V-Pots preselects a new instrument. The preselected instrument name
flashes until activated.

+ Turning another channel’s V-Pot cancels any previous preselection, and starts
preselection on the newly chosen channel strip.

* Pressing a V-Pot button:

+ Activates the preselected instrument plug-in (@assuming that you've made your
preselection by turning the V-Pot).

+ Opens a plug-in window, if none is opened. If a plug-in window is open, and Link
mode is turned on, the selection of another instrument plug-in replaces the existing
one.

+ Switches to Instrument Edit view.

+ Pressing a V-Pot or MUTE button while holding down the SHIFT button mutes/unmutes
the instrument.

To remove an instrument

Preselect the “--" value (by turning the V-Pot fully counterclockwise).

Press the V-Pot button.

Mackie Control does not switch to Instrument Edit view, and no plug-in window opens.

If a plug-in window is open, it closes.

Instrument Edit View

You can view and edit instrument parameters in this mode.

+ The mode display shows “In.”

+ Depending on the state of the NAME/VALUE button, the LCD changes in the following
ways:

+ Name: The upper LCD row shows the channel strip name, instrument name, current
parameter page, and total number of parameter pages. The lower LCD row shows
the name of the parameter that can be edited with the V-Pot directly below.
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« Value: The upper LCD row shows the name of the parameter that can be edited with
the V-Pot below. The lower LCD row shows the current value of the parameter being
edited. If there is sufficient space on the LCD row, the unit type is shown after the
value; for example, Hz or dB.

+ Turning a V-Pot changes the corresponding parameter.

+ Pressing a V-Pot button sets the parameter to its default value, except when the
parameter only has two values (on/off, for example). In this case, pressing the V-Pot
button switches between these values.

Compatibility
Mackie Control can edit all instruments that can be automated, regardless of the type of
plug-in you are using (Logic Pro native, TDM, Audio Units).

Some third-party manufacturer instruments do not provide parameter names or values
as text. In such cases, parameters are named and enumerated as “Control #1,” “Control
#2,” and so on, with values displayed as numbers ranging between 0 and 1000.

Contact the plug-in manufacturer to obtain a version that supports this feature.

Mackie Control: Fader Bank Zone
This Mackie Control zone contains two sets of left and right buttons (for switching between
individual or grouped channels) as well as the FLIP and GLOBAL VIEW buttons.

Mackie Control: BANK LEFT and BANK RIGHT Buttons

The Mackie Control provides eight sets of channel strip controls, allowing you to edit
eight corresponding channels. The BANK LEFT and BANK RIGHT buttons let you move
between “banks” of eight channel strips. For example, if you are editing channel strips
1-8, pressing the BANK RIGHT button moves to channel strips 9-16. Pressing BANK RIGHT
again moves to channel strips 17-24. Pressing BANK LEFT returns to channel strips 9-16,
then to 1-8 with one more button press.

If you are using a control surface group, the BANK LEFT and BANK RIGHT buttons shift
the active channel strips by the total number of channels in the control surface group.
For example, if you have a Mackie Control and two Mackie Control XT units, the view
shifts by 24 channels—the total number of channels in the control surface group.

The BANK buttons always change channel strips in groups of eight, unless the last channel
strips do not make a complete group of eight. For example, if a project has 19 channel
strips, and the Mackie Control is controlling channel strips 1 to 8:

+ Pressing the BANK RIGHT button shifts to channel strips 9 to 16.
+ Pressing the BANK RIGHT button again shifts to channel strips 12 to 19.
+ Pressing the BANK LEFT button shifts back to channel strips 9 to 16, not 4 to 11.
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This way, you always revert to the channel strips you expect to find, and are comfortable
with.

Notes on Using the FADER BANKS Buttons

When holding down the OPTION button, pressing the BANK or CHANNEL LEFT button
jumps to the first set of channel strips in the project. Pressing the BANK or CHANNEL
RIGHT button jumps to the last set of channel strips in the project. For example, if your
project has 64 channel strips, pressing BANK or CHANNEL LEFT jumps to channel strips
1 through 8, and pressing BANK or CHANNEL RIGHT jumps to channel strips 57 through
64.

For views where one type of channel strip is displayed (such as audio, instruments, or
busses), Logic Pro remembers the last group of eight channel strips shown in the view,
and returns to it when you switch back from another view. For example, if you start in
a view with audio channel strips 4 through 11 visible, switch to an instruments view,
scroll to instruments 6 through 13, and then switch back to the audio channel view,
you will return to audio channel strips 4 through 11 (not 6 through 13). Switching to
the Instrument Channel view displays instruments 6 through 13.

Mackie Control: CHANNEL LEFT and CHANNEL RIGHT Buttons

Using the CHANNEL LEFT and CHANNEL RIGHT buttons, you can move up or down by a
single channel strip. Pressing the CHANNEL RIGHT button shifts (the active channel strips)
up by a single channel strip, while pressing CHANNEL LEFT shifts them down by a single
channel strip. For example, if you are viewing channel strips 1 to 8 and press the CHANNEL
RIGHT button, channel strips 2 to 9 are displayed.

Notes on Using the FADER BANKS Buttons

When holding down the OPTION button, pressing the BANK or CHANNEL LEFT button
jumps to the first set of channel strips in the project. Pressing the BANK or CHANNEL
RIGHT button jumps to the last set of channel strips in the project. For example, if your
project has 64 channel strips, pressing BANK or CHANNEL LEFT jumps to channel strips
1 through 8, and pressing BANK or CHANNEL RIGHT jumps to channel strips 57 through
64.

For views where one type of channel strip is displayed (such as audio, instruments, or
busses), Logic Pro remembers the last group of eight channel strips shown in the view,
and returns to it when you switch back from another view. For example, if you start in
a view with audio channel strips 4 through 11 visible, switch to an instruments view,
scroll to instruments 6 through 13, and then switch back to the audio channel view,
you will return to audio channel strips 4 through 11 (not 6 through 13). Switching to
the Instrument Channel view displays instruments 6 through 13.
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Mackie Control: FLIP Button
Press the FLIP button (alone, or in combination with a modifier key) to activate or
deactivate one of the following modes: Flip, Swap, or Zero.

Flip Mode

Pressing the FLIP button activates Flip mode. In Flip mode, the current assignments of
the eight V-Pots are mirrored by the eight channel faders, so that both control the same
parameter. Turning one of the V-Pots causes the corresponding fader to move, and vice
versa. When you activate Flip mode, the LED next to the FLIP button illuminates. Pressing
the FLIP button again turns off Flip mode.

Flip mode offers the following advantages:

+ You can edit any type of parameter with a fader, which allows more precise editing
control.

+ Unlike the V-Pots, the faders are touch-sensitive. This allows you to overwrite existing
controller automation movements with a constant value.

Swap Mode

Holding down the SHIFT button while pressing the FLIP button activates Swap mode. In
Swap mode, the encoder assignments are swapped with the fader assignments, so that
the faders control the parameter previously assigned to the V-Pots, and vice versa. The
LED next to the FLIP button flashes when Swap mode is active.

When Swap mode is active, pressing FLIP again reverts to Flip mode. Holding down the
SHIFT button and pressing FLIP turns off Swap mode, and returns the V-Pot and fader
assignments to the state they were in before you activated Flip or Swap mode.

Zero Mode

Holding down the CONTROL button while pressing the FLIP button activates Zero mode.
In Zero mode, the faders are set to the zero position and do not move. This is useful in
situations where the Mackie Control is located close to microphones, and you want to
make sure that you don't capture the mechanical noise of the faders moving.

When Zero mode is active, pressing FLIP again reverts to Flip mode. Holding down the
CONTROL button while pressing FLIP turns off Zero mode, and reactivates the faders.

Mackie Control: Global View Button
The GLOBAL VIEW button is used in conjunction with the buttons in the Global View
zone. These are discussed in
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Mackie Control: Function Key Zone

The Function Key zone, located below the Time display and the display buttons, features
eight function key buttons, labeled F1 through F8. The eight function key buttons are
assigned as follows:

Function key Action

F1toF8 Recalls screensets 1 through 8.

Holding down the SHIFT button while pressing one of the function keys opens one of
the following windows (or closes it, if currently open):

F1 Arrange window
F2 Mixer

F3 Event List

F4 Score Editor

F5 Hyper Editor

F6 Piano Roll Editor
F7 Transport window
F8 Audio Bin

Holding down the CMD/ALT button while pressing one of the function keys activates
one of the following common commands:

F1 Cut

F2 Copy

F3 Paste

F4 Clear

F5 Select All

F6 Select All Following

F7 Select Similar Regions/Events
F8 Select Inside Locators

In modal dialogs, pressing one of the function keys is equivalent to using the computer
keyboard number keys:

Function key Action
F1 1
F2 2
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Function key Action

F3 3
F4 4
F5 5
F6 6
F7 7
F8 8
The buttons located directly

below the function keys

complete the numeric input
functions:

MIDI Tracks button 9
Inputs button 0

In some other modes, the function keys perform other actions, such as shortcuts to
markers. For more information, see Mackie Control: Marker Button. Also see the tables in
Mackie Control: Assignment Overview.

Mackie Control: Global View Zone

You can use the eight buttons in the Global View zone to display (and edit) specific types
of channel strips. Pressing any of the buttons in the Global View zone activates All View
mode; when this mode is active, the green LED to the right of the GLOBAL VIEW button
is illuminated.

When you press one of the buttons in the Global View zone, the corresponding type of
channel strip appears in the main LCD. You can edit each channel strip with the
corresponding channel strip controls. Pressing multiple buttons (Audio Tracks, Instruments,
and Aux, for example) displays all channels of the selected types.

To view (and edit) multiple All View channel strips

While holding down any button in the Global View zone, press another button to add
this channel strip type to those currently displayed. If a channel strip type is already
displayed, pressing its button removes it from the display.

As an example, to display both the audio and output channel strips, hold down the AUDIO
TRACKS button, then press the OUTPUTS button.
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Mackie Control: Modifier Buttons

The four Modifier buttons correspond to the modifier keys on your computer keyboard
(but function independently from them). You can use these buttons, along with the
appropriate key on your computer keyboard (or with the mouse), in place of using the
corresponding modifier key. This also applies to modified Mackie Control commands.

A generic description of each button follows:
* SHIFT: Provides an alternate function or meaning for a button.

+ OPTION: The function applies to all channel strips. For relative value changes, sets the
value to its minimum, default, or maximum, depending on whether you're increasing
or decreasing it.

+ CONTROL: While held down, the group clutch is engaged, and channel strip groups
are temporarily disabled.

« CMD/ALT: Allows fine-tuning, or another variation, of the function.

Mackie Control: Automation Buttons

The Automation buttons activate the corresponding automation modes in Logic Pro:
Read/Off, Touch, Latch, and Write. You use the Automation buttons in conjunction with
the channel strip SELECT buttons, as follows:

To set the automation mode for a channel
Press the SELECT button on the channel strip that you want to automate.
Press the appropriate Automation mode button.

Move the channel strip’s fader, turn the V-Pot, or use the Solo or Mute button.

The automation modes are outlined below:

+ READ/OFF: If no automation mode is active, pressing the READ/OFF button switches
between Read mode and Off.

* Read: The fader reads (follows) any existing automation data, but does not record
any new automation data.

« Off: Automation is off. The fader neither sends nor receives automation data. Existing
automation data is not changed. The fader still adjusts the volume or pan position
as usual, when moved.

+ TOUCH: Writes new data when the fader is touched or the V-Pot is turned during
playback. Any existing automation data (of the current fader type) is replaced with new
data, for as long as the control is active (while the fader is being touched or the V-Pot
is being turned).
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« LATCH: Similar to Touch mode, but the control remains active, even when the fader is
no longer being touched, or the V-Pot is not being turned. When you release the fader,
the current fader value replaces all existing automation data, for as long as the sequencer
is in playback (or record) mode. Press STOP to prevent existing automation data from
being overwritten.

« WRITE: Overwrites all existing automation data, or creates new automation data if none
exists. Only use this option if you want to destroy all existing automation data.

Pressing one of the Automation buttons while holding down the OPTION button assigns
the selected automation mode to all channels. When an automation mode has been
assigned to all channels, the corresponding automation mode button LED illuminates
whenever you hold down the OPTION button.

Important: This behavior is slightly different for the Off automation mode. When holding
down the OPTION button and pressing Read/Off, the LEDs for the other Automation
buttons are unlit, but this does not necessarily indicate that all channel strips are in Off
mode—they could still be set to other modes. To ensure that you have set all channel
strips to Off mode, press Read/Off twice while holding down the OPTION button. The
Read/Off button LED turns on, then off.

Mackie Control: GROUP Button

Pressing the GROUP button activates Group Edit mode, allowing you to edit various Mixer
group parameters.

In Group Edit mode:

+ The upper row of the LCD displays channel strip names.

+ The lower row of the LCD displays group parameters.

+ The Assignment display shows the currently displayed group—GT1, for example.

+ The Time display shows the group name. (If the name is longer than ten characters,
the last ten characters are displayed.)

+ You can switch between group parameters with the V-Pot buttons.
+ The Cursor Up and Cursor Down buttons select the previous or next group.
+ The Cursor Left and Cursor Right buttons shift the group parameter display.

+ The SELECT buttons determine group membership. Pressing a SELECT button adds the
channel strip to the group (or removes it from the group, if already a member). An
illuminated SELECT button LED indicates active group membership.

* The LED next to the GROUP button is illuminated.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.
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If Group Edit mode is off, holding down the GROUP button and pressing one or more
SELECT buttons allows you to create a new group.

Pressing the GROUP button while holding down the SHIFT button creates a new group,
opens the Group window, and activates Group Edit mode.

Pressing the GROUP button while holding down the TRACK button switches to Mixer
view, with the channel strip group parameter shown. It displays the group that the selected
channel strip belongs to. Multiple group membership is displayed as in the Mixer window.
Turning a V-Pot changes group membership.

Note: You can only select one group (or Off) with this function.

Mackie Control: Utilities Buttons

The four Utilities buttons activate common Logic Pro functions: Save, Undo, Cancel, and
Enter.

SAVE Button

Press the SAVE button to save the current project file. The first time you save a project,
a Save dialog appears on your computer screen. Enter a name and location for the file,
then click the Save button in the dialog.

The main LCD displays this message: “There is a file select dialog on the screen.” The
Position/Time display shows “ALERT.” All LEDs are unlit. Once the Save operation has
been confirmed in Logic Pro, the Mackie Control returns all controls to their previous
state (before you pressed the SAVE button).

Once you have named a project and saved it, further presses of the SAVE button store
the current project state without presenting a Save dialog onscreen, or showing any alerts
on the LCD. This allows you to quickly save incremental changes you make as your project
develops.

The SAVE LED is illuminated as soon as you make (saveable) changes to your project.

Holding down the OPTION button while pressing SAVE opens the Save As dialog on the
computer screen. This allows you to rename a project, or save it in a different location.

UNDO Button

Pressing the UNDO button undoes the last undoable action. As Logic Pro supports a
nearly unlimited number of undo/redo steps, the green UNDO LED illuminates to indicate
that Redo is available, not to indicate an undoable step. The LCD provides a warning that
performing a reversible editing step will render all Redo steps unavailable.

Holding down the SHIFT button while pressing UNDO performs a Redo.

Holding down the OPTION button while pressing UNDO opens the Undo History window.
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CANCEL Button
When an alert appears on your computer screen, you can cancel (or abort) it by pressing
the CANCEL button. For information about alerts, see

Pressing the CANCEL button when no alert is visible onscreen does the following:

+ Opens the Toolbox at the current onscreen position of the pointer.

+ Alternately, it will perform any function currently assigned to the computer keyboard's
Esc (Escape) key.

+ If the Mackie Control is currently showing the contents of a folder track, pressing the
CANCEL button exits the folder.

+ The CANCEL button also lets you invalidate a (blinking) parameter value preselection.

ENTER Button
When an alert appears on your computer screen, pressing the ENTER button activates
the default button in the alert. For information about alerts, see

If there is no alert onscreen, and the selected track is a folder track, pressing the ENTER
button opens the folder.

Mackie Control: Transport Zone
The Transport zone features five buttons for the standard transport functions (Rewind,
Fast Forward, Stop, Play, and Record).

The Transport zone also incorporates seven small, circular buttons for different recording
and playback modes.

You can use these buttons independently, or in conjunction with one another, to navigate
and edit your projects. Each button has a dedicated LED that indicates its current status.

Mackie Control: REWIND Button

The REWIND button lets you rewind through your project. Pressing the REWIND button
repeatedly while rewinding accelerates the rewind speed. Pressing the FAST FWD button
repeatedly while rewinding slows down, stops, and eventually reverses the shuttle
direction. Pressing the STOP button halts the rewind process at the current playhead
position. Turning the Jog/Scrub Wheel also exits rewind shuttle mode.

When one of the Marker modes is activated, pressing the REWIND button moves the
playhead to the previous marker.

When one of the Nudge modes is activated, the REWIND button moves the selected
regions or events backward by the value defined in Large Nudge mode.
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Mackie Control: FAST FWD Button

The FAST FWD button lets you fast forward through your project. Pressing FAST FWD
repeatedly while fast forwarding accelerates the shuttle speed. Pressing the REWIND
button repeatedly while fast forwarding slows down, stops, and eventually reverses the
shuttle direction. Pressing the STOP button halts the fast forward process. Turning the
Jog/Scrub Wheel also exits forward shuttle mode.

When one of the Marker modes is active, pressing the FAST FWD button moves the
playhead to the next marker.

When one of the Nudge modes is active, pressing the FAST FWD button moves the
selected regions or events forward by the value defined in Large Nudge mode.

Tip: You can combine markers with cycle areas by pressing the respective buttons on
the Mackie Control. This, in conjunction with navigation between markers (using the
REWIND and FAST FWD buttons), moves the playhead, and automatically sets a cycle
area between adjacent markers. Try this, and other options, with various button
combinations.

Mackie Control: STOP Button

Pressing the STOP button stops project playback (or recording, if active), and stops all
other Transport functions. Pressing the STOP button a second time returns the playhead
to the project start point, or the beginning of the nearest cycle area, if Cycle mode is
active. Pressing STOP repeatedly switches between these two functions.

Mackie Control: PLAY Button
Pressing PLAY starts playback from the current playhead position. Pressing PLAY repeatedly
jumps to the beginning of the nearest cycle area, if Cycle mode is active.

Pressing SHIFT and PLAY simultaneously works as a Pause command.

Mackie Control: RECORD Button
Pressing RECORD activates recording on the selected MIDI, audio, or software instrument
channel strip (if it is armed for recording).

It is possible that the first time you arm an audio channel strip (by pressing the REC/RDY
button for the channel), a Save dialog will appear on your computer screen. Enter a
filename (and a save location) in the dialog, then press Save. The Mackie Control LCD
display shows “There is a file select dialog on the screen.” The Position/Time display shows
“ALERT.” All LEDs are unlit.

Once you enter the filename (and press Save), all controls on the Mackie Control return
to their previous state.
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After the default audio filename has been entered, you can freely select and arm any
audio channel strip, and then press the RECORD button. No alert messages and file save
dialogs will appear onscreen.

Tip: To minimize the appearance of the dialog, save your project with Assets before you
start recording. Saving your project this way bypasses the need to define filenames, and
makes handling faster and easier when using Logic Pro with the Mackie Control.

Mackie Control: Marker Button

Pressing the MARKER button activates one of the three marker modes: Small Marker
mode, Large Marker mode, and Temporary Marker mode. You can use these modes to
create or delete markers, and jump to markers in your project.

Note: The Marker and Nudge modes are mutually exclusive; activating one deactivates
the other.

Small Marker Mode

Pressing the MARKER button activates Small Marker mode. In this mode, pressing the
FAST FWD or REWIND button moves the playhead to the next or previous marker. Pressing
the MARKER button again reverts to the default behavior of the FAST FWD and REWIND
buttons. (See Mackie Control: REWIND Button and Mackie Control: FAST FWD Button.)

Small Marker mode is useful if you want to jump to markers while using the V-Pots for
other purposes.

Large Marker Mode
Pressing the MARKER button while holding down the SHIFT button displays three create
options on the LCD, assigned to the three rightmost V-Pot buttons.

Once markers have been created, press the V-Pot button listed below to create or delete
a marker at the current playhead position.

Control Action

V-Pot 1to 5 Displays the first five markers by name. Pressing a V-Pot button
moves the playhead to the corresponding marker. When the
playhead position is inside a marker, the lower line displays INSIDE,
and the V-Pot LED ring is lit.

V-Pot 6 Cr w/o—Creates a marker, without rounding to the nearest bar.
V-Pot 7 Create—Creates a marker, rounded to the nearest bar.
V-Pot 8 Delete—Deletes the marker above the current playhead position.

A recommended workflow for creating or deleting markers is to use the Jog/Scrub Wheel.
Turn the wheel to move the playhead to the desired project position, and then press the
appropriate V-Pot to create or delete a marker.

+ For coarse placement, use the wheel to move the playhead.
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+ For fine placement, press the SCRUB button, then use the wheel to precisely position
the playhead. (This technique is only appropriate if creating or deleting an unrounded
marker.)

For more information about using the Jog/Scrub Wheel, see Mackie Control: Jog/Scrub
Wheel Zone.

Large Marker mode is terminated by pressing the MARKER button again.

Temporary Marker Mode

If you want to enter Marker mode temporarily (to quickly perform a few marker functions),
hold down the MARKER button and press one (or more) of the V-Pot buttons. This action
executes the marker function and then leaves Marker mode as soon as you release the
MARKER button.

+ When in this mode with the MARKER button held down, pressing the function keys F1
to F8 moves the playhead to the first eight markers (if created). For example, to navigate
to marker 3, press and hold down the MARKER button and press F3.

+ To jump between markers, with (or without) the MARKER button held down, simply
press the FAST FWD or REWIND button.

Mackie Control: NUDGE Button
The NUDGE button allows you to move (nudge) selected audio or MIDI regions (or events)
in Small, Large, or Temporary Nudge mode.

Note: The Marker and Nudge modes are mutually exclusive; activating one deactivates
the other.

Small Nudge Mode

Pressing the NUDGE button reassigns the behavior of the FAST FWD and REWIND buttons;
pressing either FAST FWD or REWIND nudges the selected regions or events by the value
defined in Large Nudge mode. Pressing the NUDGE button a second time reverts to the
default behavior of the FAST FWD and REWIND buttons. (See Mackie Control: REWIND
Button and Mackie Control: FAST FWD Button.)

Small Nudge mode is useful if you want to nudge regions or events, but still use the
V-Pots for other purposes.

Large Nudge Mode

Pressing the NUDGE button while holding down the SHIFT button displays eight functions
on the LCD, and assigns them to the corresponding V-Pot buttons. These functions allow
you to move the selected region or events by various amounts, or to a specific position.

The position of the first selected region or event is displayed above V-Pots 3 and 4. If
nothing is displayed, either a window that does not allow the selection of regions or
events is open, or no regions or events are selected.
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The functions are as follows:

Control Label Action

V-Pot 1 Nudge Selects the nudge value used by the REWIND and
FAST FWD buttons. These buttons move the
selected objects backward/forward by the defined

value.

V-Pot 2 Pickup Moves to the current playhead position.

V-Pot 3 Bar Moves by one bar.

V-Pot 4 Beat Moves by the current project denominator value
(beats).

V-Pot 5 Division Moves by the current project division value.

V-Pot 6 Ticks Moves by single ticks.

V-Pot 7 Frames Moves by one SMPTE frame.

V-Pot 8 Fram/2 Moves by half a SMPTE frame.

The cursor buttons emulate the computer keyboard’s arrow keys, allowing easy selection
of a region or event.

Note: Ensure that the ZOOM button isn't active when using the cursor buttons.
Pressing the NUDGE button a second time turns off Large Nudge mode.

Temporary Nudge Mode

To use Nudge temporarily (for one or two small moves), hold down the NUDGE button
and use one or more of the V-Pots. This action executes the selected function, and then
exits Temporary Nudge mode as soon as you release the NUDGE button.

In Temporary Nudge mode, the cursor buttons emulate the computer keyboard'’s arrow
keys, allowing easy selection of a region or event.

The Nudge value for the REWIND and FAST FWD buttons can also be defined with the
function buttons:

Function button Action

F1 Sets Ticks.

F2 Sets Division.

F3 Sets Beat.

F4 Sets Bar.

F5 Sets Frames.

Fé6 Sets Half Frames.
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Mackie Control: CYCLE Button
This button activates and deactivates Cycle mode. By default, the cycle area falls between
the first two markers.

Subsequent markers can act as left and right boundaries for further cycle areas.

To jump between cycle areas defined by the markers

Press the MARKER button.

Press the CYCLE button, and when active (as indicated by the LED), press the REWIND or
FAST FWD button.

To set the left or right locator to the current playhead position
Hold down the CYCLE button and press REWIND or FAST FWD. This also activates Cycle
mode.

To quickly define a new cycle area

Navigate to the desired left locator position with the Jog/Scrub Wheel.
Press the CYCLE and REWIND buttons.

Navigate to the desired right locator position with the Jog/Scrub Wheel.
Press the CYCLE and FAST FWD buttons.

Cycle View

Pressing the SHIFT and CYCLE buttons activates Cycle View mode. The mode display
shows “Cy.”

To return to a regular Assignment mode, press one of the Assignment buttons.

Control Action

Turning V-Pot 1 Shows and edits the current cycle status (off or on); you can also
use the CYCLE button.

Turning V-Pot 2 BySel—sets the current cycle area by the selection made in the
Arrange window (selected audio or MIDI region).

Turning V-Pot 3 Move—moves the current cycle by a bar with each click of the V-Pot.

Pressing V-Pot 5 Picks up the current playhead position for the left locator.

Turning V-Pot 5 Changes the left locator in bars.

Turning V-Pot 6 Changes the left locator in beats (denominator steps).

Pressing V-Pot 7 Picks up the current playhead position for the right locator.

Turning V-Pot 7 Changes the right locator in bars.

Turning V-Pot 8 Changes the right locator in beats (denominator steps).

Mackie Control: DROP Button

The DROP button lets you activate and deactivate Autopunch mode.
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To navigate between punch in areas
Press the MARKER button.

Press the DROP button, and when active (as indicated by the lit LED), press the FAST FWD
or REWIND button.

To set the punch in or punch out locator to the current playhead position
Hold down the DROP button and press FAST FWD or REWIND. This also activates
Autopunch mode.

To quickly define a new punch in area

Navigate to the desired punch in locator position with the Jog/Scrub Wheel.
Press the DROP and REWIND buttons.

Navigate to the desired punch out locator position with the Jog/Scrub Wheel.
Press the DROP and FAST FWD buttons.

Punch View

Pressing the SHIFT and DROP buttons activates Punch view. The mode display shows
IIPu.!I

To return to a regular Assignment mode, press one of the Assignment buttons.

Note: Changing a punch locator value with the Mackie Control automatically activates
Autopunch mode in Logic.

Control Action

Turning V-Pot 1 Shows and edits the current Autopunch status (off or on); you can
also use the DROP button.

Turning V-Pot 3 Move—moves the current punch area by a bar with each click of
the V-Pot.

Pressing V-Pot 5 Picks up the current playhead position for the punch in locator.

Turning V-Pot 5 Changes the punch in locator in bars.

Turning V-Pot 6 Changes the punch in locator in beats (denominator steps).

Pressing V-Pot 7 Picks up the current playhead position for the punch out locator.

Turning V-Pot 7 Changes the punch out locator in bars.

Turning V-Pot 8 Changes the punch out locator in beats (denominator steps).

Mackie Control: Replace, Click, and Solo Buttons
The REPLACE button activates or deactivates Replace mode.

The CLICK button activates or deactivates the (MIDI or Klopfgeist) metronome click. There
are independent click settings for play and record. To access the click settings, choose
File > Project Settings > Metronome.
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Press the SHIFT and CLICK buttons to activate or deactivate both External Sync mode and
transmission of MMC.

The SOLO button behaves as per the Solo key command. Individual channels can be
soloed with the SOLO buttons on each channel strip. MIDI or audio regions can be selected,
and soloed, along with the selected channels. Each channel features an independent
SOLO LED, which is lit when a channel strip is soloed. The RUDE SOLO LED—just to the
right of the Position/Time display—is lit whenever any channel strip is soloed.

Press the SHIFT and SOLO buttons to activate Solo Lock mode.

Mackie Control: Cursor Key Zone

This zone contains five buttons, located to the left of the Jog/Shuttle Wheel, which serve
a number of purposes. The four cursor buttons—Up, Down, Left, and Right—encircle the
central ZOOM button.

Mackie Control: Normal Operation

When the ZOOM button is not active (its LED is unlit), the four cursor buttons select the
current parameter, shift the current parameter page or Send/EQ/Insert slot, depending
on the current V-Pot assignment.

When the OPTION button is held down, the Cursor Left and Cursor Right buttons scroll
to the first and last page, and the Cursor Up and Cursor Down buttons scroll to the first
and last slot.

When the CMD/ALT button is held down, the Cursor Left and Cursor Right buttons shift
the parameter display by one parameter, rather than one page.

In view modes that don't require page or slot shifts, the cursor buttons emulate the
computer keyboard’s arrow keys. As an example, the left and right buttons select channel
strips when in Mixer view.

In Large and Temporary Nudge modes, the Cursor Left and Cursor Right buttons emulate
the computer keyboard’s arrow keys, allowing easy region or event selection.

Mackie Control: Zoom Mode

Pressing the ZOOM button activates Zoom mode. The cursor buttons are then used to
change the vertical or horizontal zoom factor of the window with key focus.

In the Arrange window:

+ OPTION and Cursor Up or Cursor Down changes the zoom factor of the selected track.
+ OPTION and Cursor Left resets the zoom factor of the selected track.

+ OPTION and Cursor Right resets the zoom factor of all tracks of the same class (audio,
MIDI, and so on) as the selected track.
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Mackie Control: Computer Arrow Key Emulation
To use the cursor buttons as a replacement for the computer keyboard arrow keys, hold
down the SHIFT button.

When SHIFT and ZOOM are pressed, the cursor buttons enter Permanent Cursor Key
mode—they mimic the computer arrow keys without the need to hold down the SHIFT
button. The ZOOM button LED flashes when in this mode.

You can deactivate this mode by pressing the ZOOM button.

Mackie Control: Jog/Scrub Wheel Zone

The Jog/Scrub Wheel and SCRUB button can be used to navigate through the project,
which is useful for a number of transport tasks. Simply turn the dial to use it. The following
Scrub modes change the behavior of the Jog/Scrub Wheel.

+ Scrub mode off: The Jog/Scrub Wheel moves the playhead.

+ Scrub mode on: The Jog/Scrub Wheel performs scrubbing, which allows you to hear
the data of the selected (or soloed) tracks while scrolling or moving through the project.

Audio tracks are normally played back at their original speed. If you would rather hear
them at double speed, choose Logic Pro > Preferences > Audio > Drivers, and set
Maximum Scrub Speed to Double in the pop-up menu.

Note: You can also use the SCRUB button for Pause functionality.

+ SHUTTLE mode: The Jog/Scrub Wheel shuttles the playhead—turning it increases or
decreases the speed at which the playhead moves. The SCRUB button LED flashes when
in Shuttle mode.

Mackie Control: Programmable User Modes

The Mackie Control provides six programmable user modes, which you can use for your
own assignments. You can activate each of these modes by holding down the SHIFT
button along with one of the Assignment buttons, as follows:

+ TRACK + SHIFT = User mode 1.

+ PAN/SURROUND + SHIFT = User mode 2.
+ EQ + SHIFT = User mode 3.

+ SEND + SHIFT = User mode 4.

+ PLUG-IN + SHIFT = User mode 5.

+ INSTRUMENT + SHIFT = User mode 6.

The Assignment displays shows the users modes as u1, u2, and so on.
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To create an assignment in one of the user modes
Activate the user mode you want to use by holding down the SHIFT button and pressing
one of the Assignment buttons, as listed above.

In Logic Pro, use the Learn process to create one or more assignments, as described in
Assigning Controllers to Logic Pro Parameters.

Mackie Control: Connecting Foot Switches
You can connect a momentary foot pedal—with either positive or negative polarity—to
the foot switch sockets. By default, foot switches control the following functions:

+ USER SWITCH A is assigned to Start/Stop.

+ USER SWITCH B is assigned to Record. (Note that a track must be selected and armed
for recording to take place.)

+ EXTERNAL CONTROL is assigned to the MASTER fader level. Only use an expression
pedal with this socket.

The polarity of the foot switches is determined by the Mackie Control when powered up.
You should first connect the foot switches, then turn on the Mackie Control.

Mackie Control: Assignment Overview
Each of the following sections outline how Mackie Control interface elements are assigned
to Logic functions.

» Mackie Control: Display Buttons

» Mackie Control: Channel Strip Controls (1 Through 8)
+ Mackie Control: ASSIGNMENT Buttons

+ Mackie Control: Function Key Buttons

* Mackie Control: GLOBAL VIEW Buttons

« Mackie Control: MODIFIER Buttons (While Held Down)
+ Mackie Control: AUTOMATION Buttons

* Mackie Control: UTILITIES Buttons

+ Mackie Control: TRANSPORT Buttons

+ Mackie Control: Cursor Keys

+ Mackie Control: Jog/Scrub Wheel

+ Mackie Control: External Inputs

Mackie Control: DISPLAY Buttons
The following table outlines the display controls and their functions:
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Button Modifier Function/Comments
NAME/VALUE — Switch between parameter name and parameter
value display.
SHIFT Cycle through level meter displays: vertical,
horizontal, and off.
OPTION Switch between track name and track number:
name display.
CONTROL Clear clip/overload flags.
CMD/ALT Enter control surface group settings mode.
SMPTE/BEATS — Switch between SMPTE and beat format in clock

display.

Mackie Control: Channel Strip Controls (1 Through 8)
The following table outlines the channel strip controls and their functions:

Control Modifier Function/Comments
Turning V-Pot — Modify parameter displayed in LCD.
OPTION Set parameter to minimum, default, or maximum
value.
CMD/ALT Modify parameter at high resolution.

Pressing V-Pot button

Set parameter displayed on LCD to default value,
or switch between two possible values.

Flashing preselection:

Enter the preselected value.

Menu options:

Enter whatever option is visible in display.

If track is folder:

Enter folder.

REC/RDY button — Activate/deactivate Record Enable button of track.
OPTION Disable Record Enable button for all tracks.
SOLO button — Activate/deactivate Solo button of track’s channel
strip.
OPTION Disable Solo button for all channel strips.
In Send

Destination/Level Mixer
view:

Switch pre/post status of selected send.

In Send
Destination/Level
Channel view:

102 Chapter 3 Mackie Control



Control Modifier

Function/Comments

Switch between pre/post fader mode of send on
selected channel strip.

MUTE button —

Activate/deactivate Mute button of track’s channel
strip.

OPTION Disable Mute button for all channel strips.
In Mixer view:
SHIFT Activate/deactivate mute/bypass of the shown

parameter.

In EQ Mixer view:

SHIFT

Activate/deactivate bypass of the current EQ band.

In EQ Frequency/Gain
view:

Activate/deactivate bypass of selected EQ band.

In Send Mixer view:

SHIFT Activate/deactivate bypass of selected send.
In Send

Destination/Level Mixer

view:

— Activate/deactivate bypass of selected send.
In Send

Destination/Level
Channel view:

Activate/deactivate mute of send on selected
channel strip.

In Plug-in Mixer view:

SHIFT Activate/deactivate bypass of plug-in.
In Instrument Mixer
view:
SHIFT Activate/deactivate bypass of instrument.
SELECT button — Select channel strip.
SHIFT Set channel strip volume to unity level (0 dB).
OPTION Creates a new track with the same assignment as
the selected track and switches to Arrange view.
SHIFT+OPTION Create a new track with the next channel strip
(following the selected track) and switches to
Arrange view.
Fader — Adjust volume.
In Flip mode
“Duplicate”:
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Control Modifier

Function/Comments

Same function as V-Pot of same channel.

In Flip mode “Swap”:

Swap function with V-Pot of same channel.

In Surround
Angle/Diversity view:

Adjust surround diversity.

In EQ Frequency/Gain

view:

— Adjust gain of selected EQ band.
In Send

Destination/Level Mixer

view:

— Adjust send level of selected send.
In Send

Destination/Level
Channel view:

Adjust send level of send on selected channel strip.

Mackie Control: ASSIGNMENT Buttons

Hold down to show a shortcut menu on the LCD. Functions or commands are assigned
to V-Pots. Release the chosen Assignment button to switch V-Pots to Multi Channel or
Channel views. The table outlines both the standard use of Assignment buttons, and
when used in conjunction with a modifier button.

Button Modifier Function/Comments

TRACK — Channel strip parameters

TRACK SHIFT User mode 1

PAN/SURROUND — Pan/Surround parameters
PAN/SURROUND SHIFT User mode 2

EQ — EQ parameters

EQ SHIFT User mode 3

SEND — Send parameters

SEND SHIFT User mode 4

PLUG-IN — Plug-in selection or Plug-in Edit mode
PLUG-IN SHIFT User mode 5

INSTRUMENT — Instrument selection or Instrument Edit mode
INSTRUMENT SHIFT User mode 6
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Button Modifier Function/Comments
BANK <> — Shift fader BANK LEFT/RIGHT by number of
channel strips.
OPTION Shift fader bank to beginning or end.
CHANNEL<> — Shift fader BANK LEFT/RIGHT by one channel.
OPTION Shift fader bank to beginning or end.
FLIP — Switch Flip mode between Off and Duplicate.
SHIFT Switch Flip mode between Off and Swap.
CONTROL Switch Flip mode between Off and Zero (turns
fader motors off).
GLOBAL VIEW — Switch between Arrange view and All view.
SHIFT Switch between Arrange view and Tracks view.

Mackie Control: Function Key Buttons

The following table outlines the function key controls and their functions:

Button Modifier Function/Comments
F1 — Recall screenset 1.
SHIFT Open or close Arrange window.
CMD/ALT Cut
TRACK Switch to Mixer view-Volume.
PAN/SURROUND Switch to Mixer view-Pan/surround angle.
EQ Switch to Mixer view-Bypass.
SEND Switch to Mixer view-Destination.
MARKER Create marker without rounding.
NUDGE Nudge value: Tick
In modal dialog: F1 key is equivalent to computer keyboard 1 key.
F2 — Recall screenset 2.
SHIFT Open or close Mixer window.
CMD/ALT Copy
TRACK Switch to Mixer view-Pan.
PAN/SURROUND Switch to Mixer view-Pan/surround radius.
EQ Switch to Mixer view-EQ Type.
SEND Switch to Mixer view-Level.
MARKER Create marker with rounding.
NUDGE Nudge value: Format

In modal dialog:

F2 key is equivalent to computer keyboard 2 key.
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Button Modifier

Function/Comments

F3 — Recall screenset 3.
SHIFT Open or close Event Editor.
CMD/ALT Paste
TRACK Switch to Mixer view-Channel Strip mode.
PAN/SURROUND Switch to Mixer view-Pan/surround LFE.
EQ Switch to Mixer view-Frequency.
SEND Switch to Mixer view-Position.
MARKER Delete marker.
NUDGE Nudge value: Beat
In modal dialog: F3 key is equivalent to computer keyboard 3 key.
F4 — Recall screenset 4.
SHIFT Open or close Score Editor.
CMD/ALT Clear
TRACK Switch to Mixer view-Input.
PAN/SURROUND Switch to Mixer view-Pan/surround mode.
EQ Switch to Mixer view-Gain.
SEND Switch to Mixer view-Mute.
NUDGE Nudge value: Bar
In modal dialog: F4 key is equivalent to computer keyboard 4 key.
F5 — Recall screenset 5.
SHIFT Open or close Hyper Editor.
CMD/ALT Select All
TRACK Switch to Mixer view-Output.
PAN/SURROUND Switch to Channel view.
EQ Switch to Mixer view-Q Factor.
SEND Switch to Channel view.
NUDGE Nudge value: Frame
In modal dialog: F5 key is equivalent to computer keyboard 5 key.
F6 — Recall screenset 6.
SHIFT Open or close Piano Roll Editor.
CMD/ALT Select All Following.
TRACK Switch to Mixer view-Automation.
PAN/SURROUND Switch to Angle/Diversity view.
EQ Switch to Channel view.
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Button Modifier

Function/Comments

SEND Switch to Channel Strip 2 view.

NUDGE Nudge value: 1/2 Frame
In modal dialog: F6 key is equivalent to computer keyboard 6 key.
F7 — Recall screenset 7.

SHIFT Open/Close Transport window.

CMD/ALT Select Similar Regions/events.

TRACK Switch to Mixer view-Displayed parameter.

PAN/SURROUND Switch to Surround X/Y view.

EQ Switch to Frequency/Gain Mixer view.

SEND Switch to Destination/Level Mixer view.
In modal dialog: F7 key is equivalent to computer keyboard 7 key.
F8 — Close topmost floating window.

SHIFT Open or close Audio Bin.

CMD/ALT Select Inside Locators.

TRACK Switch to Channel Strip Setup view.

EQ Switch to Frequency/Gain Channel view.

SEND Switch to Destination/Level Channel view.

In modal dialog:

F8 key is equivalent to computer keyboard 8 key.

Mackie Control: GLOBAL VIEW Buttons
The following table outlines the global view controls and their functions:

Button Modifier Function/Comments
MIDI TRACKS — Switch to All view and show MIDI tracks.
SHIFT Set to fader bank no. 1 (channel strips 1 to 8, for

example).

In modal dialog:

MIDI TRACKS button is equivalent to computer
keyboard 9 key.

INPUTS —

Switch to All view and show input channel strips.

SHIFT

Set to fader bank no. 2 (channel strips 9 to 16, for
example).

In modal dialog:

INPUTS button is equivalent to computer keyboard
0 key.

AUDIO TRACKS —

Switch to All view and show audio channel strips.

SHIFT

Set to fader bank no. 3 (channel strips 17 to 24,
for example).
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Button Modifier Function/Comments

In modal dialog: AUDIO TRACKS button is equivalent to computer
keyboard'’s Period key.

AUDIO INSTRUMENTS — Switch to All view and show software instrument
channel strips.

SHIFT Set to fader bank no. 4 (channel strips 25 to 32,
for example).

In modal dialog: AUDIO INSTRUMENTS button is equivalent to
computer keyboard / key.

AUX — Switch to All view and show aux channel strips.

SHIFT Set to fader bank no. 5 (channel strips 33 to 40,
for example).

In modal dialog: AUX button is equivalent to computer keyboard
* key.

BUSSES — Switch to All view and show bus channel strips.

SHIFT Set to fader bank no. 6 (channel strips 41 to 48,
for example).

In modal dialog: BUSSES button is equivalent to computer keyboard
- key.

OUTPUTS — Switch to All view and show output and master
channel strips.

SHIFT Set to fader bank no. 7 (channel strips 49 to 56,
for example).

In modal dialog: OUTPUTS button is equivalent to computer
keyboard + key.

USER — Currently unassigned

SHIFT Set to fader bank no. 8 (channel strips 57 to 64,
for example).

Mackie Control: MODIFIER Buttons (While Held Down)
The following table outlines the modifier buttons and their functions:

Button Function/Comments

SHIFT Switch to second function.

OPTION Apply function to all channel strips or set parameter to minimum,
default, or maximum value.

CONTROL Disable Group functions while held down.

CMD/ALT Enable Fine mode; shift parameter page by one parameter instead
of page.

Mackie Control: AUTOMATION Buttons
The following table outlines the automation controls and their functions:
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Mackie Control Modifier Function/Comments

READ/OFF — Set selected track’s automation to Read or Off.
OPTION Set all tracks’ automation to Read or Off.

TOUCH — Set selected track’s automation to Touch.
OPTION Set all tracks’ automation to Touch.

LATCH — Set selected track’s automation to Latch.
OPTION Set all tracks’ automation to Latch.

WRITE — Set selected track’s automation to Write.
OPTION Set all tracks’ automation to Write.

TRIM Currently unassigned

GROUP — Enter Group Edit mode.
SHIFT Create a new group, open the Group window and

enter Group Edit mode.

TRACK Switch to Mixer view, displaying group parameter.
OPTION Switch to Single view.

Mackie Control: UTILITIES Buttons

The following table outlines the utility controls and their functions:

Button Modifier Function/Comments
SAVE — Save project.

OPTION Save project as.
UNDO — Undo

SHIFT Redo

OPTION Open Undo History.
CANCEL — Leave folder.

Flashing preselection:

— Cancel preselection.

In alerts:

— Execute Cancel button.
ENTER — Enter folder of selected track.

In alerts:

Execute default button.

Mackie Control: TRANSPORT Buttons
The following table outlines the transport controls and their functions:
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Button Modifier

Function/Comments

MARKER — Switch Small Marker mode on/off.

SHIFT Switch Large Marker mode on/off.

NUDGE — Switch Small Nudge mode on/off.

SHIFT Switch Large Nudge mode on/off.

MARKER Create a marker. This allows you to create a marker
with one hand without entering Large Marker
mode.

CYCLE — Activate/deactivate Cycle mode.
SHIFT Switch to Cycle view.
DROP — Activate/deactivate Autopunch mode.
SHIFT Switch to Punch view.
REPLACE — Activate/deactivate Replace mode.
CLICK — Activate/deactivate metronome click (separately
for playback and record).

SHIFT Activate/deactivate internal/external sync and
MMC.

SOLO — Activate/deactivate Solo Lock function.

SHIFT Enable Solo Lock function.

REWIND << — Shuttle rewind.

MARKER Go to previous marker.

NUDGE Nudge left by chosen value.

CYCLE Engage Cycle mode and set left locator to
playhead.

DROP Engage Autopunch mode and set punch in locator.

In Marker mode:

— Go to previous marker.

In Nudge mode:

— Nudge left by chosen value.

FFWD >> — Shuttle forward.

MARKER Go to next marker.

NUDGE Nudge right by chosen value.

CYCLE Engage Cycle mode and set right locator to
playhead.

DROP Engage Autopunch and set punch out to locator.

In Marker mode:

Go to previous marker.
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Button

Modifier

In Nudge mode:

Function/Comments

Nudge right by chosen value.

STOP — Stop

PLAY — Play
SHIFT Pause

RECORD — Record

Mackie Control: Cursor Keys
The following table outlines the cursor controls and their functions:

Mackie Control

Cursor Left/Right

Modifier

If in Mixer view:

Function/Comments

Select previous/next parameter
of current view.

Z00M

Scroll window horizontally by
page.

If in Channel Strip EQ, Send view,
or Plug-in/Instrument Edit view:

Shift current editor page by one
page.

CMD/ALT Shift current editor page by one
parameter.
Z0O0M Scroll window horizontally by

page.

Otherwise (always in Nudge
mode):

Mimic computer keyboard
Left/Right Arrow keys.

Z00OM

Scroll window horizontally by
page.

In Zoom mode:

Change horizontal zoom level.

SHIFT

Reset individual track zoom of
current track (Cursor Left) or all
tracks of same type (Cursor
Right).

Cursor Up/Down

In Channel Strip EQ, Send view,
or Plug-In/Instrument Editor
view:
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Mackie Control Modifier Function/Comments

— Select previous/next EQ band,
Send, or Insert slot.

Z00M Scroll window vertically by page.

Otherwise (always in Nudge

mode):

— Mimic computer keyboard
Up/Down Arrow keys.

ZO0OM Scroll window vertically by page.

In Zoom mode:

— Change vertical zoom level.

SHIFT Change individual track zoom of
current track.

ZOOM — Switch between default cursor
button behavior (see above) and
Zoom mode.

SHIFT Switch between default cursor
button behavior and
permanently mimicking
computer keyboard arrow keys.

Mackie Control: Jog/Scrub Wheel
The following table outlines the Jog/Scrub Wheel controls and their functions:

Control Modifier Function
Jog Wheel — Move the playhead forward or back.
CYCLE Set the left locator to the current playhead

position, advance the playhead as normal, then
set the right locator to the playhead position.
Further Jog Wheel turns while still holding down
CYCLE advances the playhead and sets the right
locator again. Tip: Rotating the Jog Wheel
counterclockwise while holding down CYCLE
defines a skip-cycle range.

DROP Set the punch in locator to the current playhead
position, advance the playhead as normal, then
set the punch out locator to the playhead position.
Further Jog Wheel turns while still holding down
DROP advances the playhead and sets the punch
out locator again.

SCRUB button — Activate/deactivate Scrub mode.

SHIFT Enable Shuttle mode on the Jog Wheel (SCRUB
button LED flashes).
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Mackie Control: External Inputs
The following table outlines the external input controls and their functions:

Input Modifier Function
USER SWITCH A — Play/Stop
USER SWITCH B — Record
EXTERNAL CONTROL — Master Volume
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M-Audio iControl 4

This chapter introduces you to using the M-Audio iControl with Logic Pro.

Use of the iControl with Logic Pro simplifies work with GarageBand projects. When you
open a GarageBand project in Logic Pro, you can edit it (using the iControl) in exactly the
same manner as in GarageBand. You can also take full advantage of the greater control,
editing, and processing power afforded by Logic Pro.

Given the hugely expanded functionality of Logic Pro over GarageBand, some iControl
buttons may not be assigned as you might expect. You can, however, easily reassign
iControl buttons in the Controller Assignments window. For more information, see
Customizing Controller Assignments.

This chapter covers the following:

+ Setting Up Your M-Audio iControl (p. 115)

+ Editing Plug-in Parameters Using the M-Audio iControl (p. 116)

* M-Audio iControl: Assignment Buttons (p. 116)

» M-Audio iControl: Arrow Up and Arrow Down Buttons (p. 118)

* M-Audio iControl: Channel Strip Controls (p. 118)

* M-Audio iControl: Mixer View and Channel View (p. 120)

+ M-Audio iControl: Jog Wheel (p. 120)

* M-Audio iControl: Transport Controls (p. 120)

+ M-Audio iControl: Using Locators and Cycle Mode (p. 121)

» M-Audio iControl: Master Fader (p. 121)

» M-Audio iControl: Assignment Overview (p. 122)

Setting Up Your M-Audio iControl

When you connect the iControl to any of your computer’s USB ports, Logic Pro
automatically detects the device. If any channels are muted, soloed, or record-enabled
in the current project, the LED on the corresponding channel strip control is lit to reflect
the channel strip’s status. If Cycle mode is active, a lit LED also indicates this.
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Editing Plug-in Parameters Using the M-Audio iControl

In addition to editing volume, pan, and other channel strip functions, the iControl lets
you edit any plug-in that can be automated in Logic Pro. Many Logic Pro effect and
instrument plug-ins, and those of third-party manufacturers, feature dozens of parameters.
You can access each of these parameters with the iControl.

If a third-party plug-in that you're using does not support remote editing, or other features
mentioned in this document, contact the plug-in manufacturer to obtain an updated
version.

M-Audio iControl: Assignment Buttons

You can use the buttons along the left side of the iControl, in the areas labeled All Tracks
and Selected Track, to select different functions for the rotary encoders located along the
right edge, in the channel strip area. In some cases, the channel strip area controls can
change the functionality of the Select buttons.

Volume Button

Pressing the Volume button assigns the rotary encoders (in the channel strip area) to
control volume for the eight active channels. The channel strip buttons—Select, Record
Enable, Mute, and Solo—work as described in M-Audio iControl: Channel Strip Controls.

Pan Button
Pressing the Pan button assigns the rotary encoders to control the pan/balance of the
eight active channels. The channel strip button functionality is as per their defaults.

Track Info Button

Pressing the Track Info button activates Channel Strip Channel view. In this mode, you
can use the Select (Sel) buttons and rotary encoders to edit global parameters of the
selected channel strip. The Record Enable, Mute, and Solo buttons retain their default
functions.

+ Sel button 1 to 5: Switches the bypass status of the first five Insert slots.
« Sel button 6 and 7: Switches the bypass status of the first and second Send slots.
+ Sel button 8: Not assigned

In Channel Strip Channel view, each of the Select buttons is lit when the respective
Insert or Send slot is enabled, and unlit when the slot is bypassed.

* Encoder 1: If the selected channel is an audio channel strip with a Noise Gate effect,
controls the Threshold parameter of the Noise Gate (if inserted in the selected channel
strip).

* Encoder 2: If the selected channel is an audio channel strip with a Compressor effect,
controls the Compressor’s Ratio.
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Note: The assignments for Encoder 1 and 2 are optimized for GarageBand Real
Instrument tracks, which have a default Noise Gate and Compressor effect inserted.

+ Encoder 3: Not assigned

+ Encoder 4: Not assigned

* Encoder 5: Controls the Pan knob of the channel.

* Encoder 6: Controls the send level for the first send of the channel.

* Encoder 7: Controls the send level for the second send of the channel.

* Encoder 8: Controls the Volume fader of the channel.

Generator Button

If the selected channel strip is an instrument channel strip, pressing the Generator button
assigns the rotary encoders to edit the sound generation parameters of the instrument.
These assignments are in groups of eight parameters. The Arrow Up and Arrow Down
buttons switch to the previous or next page of eight parameters. Activation of the
Generator button has no effect if the selected channel strip is not a software instrument
channel strip.

Effect 1 and Effect 2 Buttons

Pressing Effect 1 assigns the rotary encoders to edit the parameters of the third Insert
slot of the selected channel strip. Pressing Effect 2 assigns the rotary encoders to edit the
parameters of the fourth Insert slot (if a fourth Insert slot exists). The Arrow Up and Arrow
Down buttons switch to the previous or next page of parameters.

Pressing the Effect 1 or Effect 2 button while holding down the Option button switches
the bypass status of Insert slots 3 and 4, respectively.

When using the Arrow buttons to switch between parameter pages—accessed through
use of the Generator, Effect 1, or Effect 2 button—the parameters change in groups of
eight (unless the parameters on the last page do not make a complete group of eight).
For example, if a plug-in has 19 parameters and the iControl is controlling parameters 1
to 8:

* Pressing the Arrow Up button shifts to parameters 9 to 16.
+ Pressing the Arrow Up button again shifts to parameters 12 to 19.
+ Pressing the Arrow Down button shifts back to parameters 9 to 16, not 4 to 11.

This way, you always revert to the page positions you expect to find, and are comfortable
with.
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EQ Button

Pressing the EQ button allows you to edit the EQ parameters of the selected channel
strip. If a Channel or Linear Phase EQ exists on the selected channel strip, pressing the
EQ button opens the EQ plug-in window. If no Channel or Linear Phase EQ exists on the
selected channel strip, a Channel EQ is inserted automatically. The Arrow Up and Arrow
Down buttons switch to the next or previous parameter page.

Each Assignment button has two modes—Mixer view and Channel view—that determine
whether the rotary encoders (and in some cases, the Select buttons) edit separate channels
or the same channel. For more information, see

M-Audio iControl: Arrow Up and Arrow Down Buttons

The iControl has channel strip controls for eight channel strips, which default to channel
strips 1 to 8. To access further channel strips, press the Arrow Up button. This allows you
to control channel strips 9 through 16. Press the Arrow Up button again to control channel
strips 17 to 24, or press the Arrow Down button to control channel strips 1 to 8.

When using the Arrow buttons to switch between groups of channel strips, the channel
strips follow groupings of eight (starting from channel strip 1) unless the last group of
channel strips do not make a complete group of eight. For example, if a project has 19
channel strips, and the iControl is controlling channel strips 1 to 8:

+ Pressing the Arrow Up button shifts to channel strips 9 to 16.
+ Pressing the Arrow Up button again shifts to channel strips 12 to 19.

+ Pressing the Arrow Down button shifts back to channel strips 9 to 16, not 4 to 11.

Pressing the Arrow Up button while holding down the Option button jumps to the first
eight channel strips in the project. Similarly, pressing the Option and Arrow Down buttons
jumps to the last eight channel strips in the project. For example, if a project has 64
channel strips, pressing Option—-Arrow Up jumps to channel strips 57 to 64, and pressing
Option-Arrow Down jumps to channel strips 1 to 8.

Note: If the Generator, EQ, Effect 1, or Effect 2 button is lit, the functionality of the Arrow
Up and Arrow Down buttons are as described in the Generator, Effect 1, and Effect 2
sections. See for details.

M-Audio iControl: Channel Strip Controls

The right side of the iControl features eight rows of controls that you can use to edit
channel strips. Each row includes Select, Record Enable, Mute, and Solo buttons plus a
rotary encoder.
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Select Button
Pressing a channel Select button selects the channel for channel-based editing or
assignment commands. When a channel is selected, “Sel” is lit on the button.

Note: If the Track Info button is illuminated, the Select buttons behave differently. See
for details.

Record Enable Button

Pressing a channel Record Enable button (denoted by a centered white dot) arms the
associated channel strip for recording. When a channel is armed for recording, the dot is
lit. Pressing the Record Enable button a second time disables recording for the channel.

To disarm all channel strips, hold down the Option button while pressing the Record
Enable button of any channel.

Mute Button

Pressing a channel strip Mute button (denoted by a speaker icon) mutes the channel.
The speaker icon is lit when the channel strip is muted. Pressing the Mute button a second
time unmutes the channel strip.

To unmute all channel strips, hold down the Option button and press the Mute button
of any channel.

Solo Button

Pressing a channel strip Solo button (denoted by a headphone icon) solos the associated
channel strip in the application. The headphone icon is lit when the channel strip is soloed.
Pressing the Solo button a second time exits Solo mode for the channel strip.

To hear (unsolo) all channel strips, hold down the Option button and press the Solo
button of any channel.

Rotary Encoder

Each channel features a rotary encoder, located to the right of the Solo button. The
function assigned to the encoders changes when different Assignment buttons are
pressed. See

Pressing the Option button while turning a rotary encoder—regardless of the active
assignment mode—switches between the parameter’s minimum, default, and maximum
values.
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M-Audio iControl: Mixer View and Channel View

The rotary encoders operate in two views: Mixer view and Channel view. The view you're
in determines whether the rotary encoders (and in some cases, the Select buttons) edit
multiple channels, or a single channel.

+ Mixerview: Accesses the same parameter for eight channel strips, such as pan or volume
(normally a section of the Mixer window).

+ Channel view: Accesses eight parameters of the selected channel strip.

To access Mixer or Channel view, press one of the Assignment buttons. For more
information about using the Assignment buttons, see M-Audio iControl: Assignment
Buttons Functions.

M-Audio iControl: Jog Wheel

You can navigate through projects with the Jog Wheel, located toward the lower-left
area of the iControl, just above the transport controls. Turning the wheel clockwise moves
the playhead forward. Turning it to the left moves the playhead backward.

M-Audio iControl: Transport Controls

The transport controls, at the bottom-left corner of the iControl, feature six large buttons:
Record, Return to Zero, Rewind, Play, Fast Forward, and Cycle. You can use these buttons
to navigate your projects, and to perform a number of recording and editing tasks.

Record Button
Press the Record button (denoted by a large white dot) to activate recording on channel
strips that are currently armed for recording. See Record Enable Button.

Return to Zero Button
Press the Return to Zero button (denoted by a vertical line and left arrow) to move the
playhead to the beginning of the project.

Rewind Button

Quickly press the Rewind button (denoted by two left arrows) to move the playhead
backward by one bar. Hold down the Rewind button to continuously move the playhead
backward in one-bar steps.

You can also press the Rewind and Cycle buttons simultaneously to activate Cycle mode,
and set the left cycle border (left locator) to the current playhead position.

Play/Stop Button
Press the Play button (denoted by a right arrow) to start playback from the current
playhead position, or to stop playback if the project is currently playing.
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Fast Forward Button

Quickly press the Fast Forward button (denoted by two right arrows) to move the playhead
forward by one bar. Hold down the Fast Forward button to continuously move the
playhead forward in one-bar increments.

You can also press the Fast Forward and Cycle buttons simultaneously to activate Cycle
mode, and set the right cycle border (right locator) to the current playhead position.

Cycle Button
Press the Cycle button (denoted by two circular arrows) to activate Cycle mode. If Cycle
mode is active, pressing the Cycle button deactivates it.

You can activate Cycle mode—and set the left and right cycle locators, respectively—by
using the Rewind or Fast Forward and Cycle buttons together. See

M-Audio iControl: Using Locators and Cycle Mode

The left and right locators are used to mark a section of your project. These are often
used in conjunction with cycle facilities, which repeatedly play back the section of your
project between the locators.

To set the left and right locators, and activate Cycle mode
Use the Jog Wheel to move the playhead to the desired left locator position, then press
both the Cycle and Rewind buttons.

Do one of the following:

+ Navigate to the position where you want to set the right locator with the Jog Wheel,
then press the Cycle and Fast Forward buttons simultaneously.

+ Hold down the Cycle button, navigate to the position where you want to set the right
locator using the Jog Wheel, then release the Cycle button.

+ Rotating the Jog Wheel counterclockwise (to the left) while holding down Cycle defines
a skip-cycle range.

M-Audio iControl: Master Fader

Moving the Master fader on the iControl sets the level of the Master fader in the Logic Pro
Mixer window. The Master fader changes the level of all output channels, but does not
affect the relative levels of channels that precede the Master fader in the signal path.
Move the fader left to decrease the master level, or to the right to increase the master
level.
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M-Audio iControl: Assignment Overview

The following assignment tables show all assignments for each control, both with and
without the Option button (for the Assignment buttons and channel strip controls), and
the Cycle button (for the Jog Wheel and transport buttons) being pressed.

* M-Audio iControl: Assignment Buttons Functions
* M-Audio iControl: Channel Strip Controls and Functions
* M-Audio iControl: Jog Wheel Controls and Functions

* M-Audio iControl: Transport Controls and Functions

M-Audio iControl: Assignment Buttons Functions
The Assignment buttons in the All Tracks and Selected Track areas define the behavior
of the channel strip controls.

iControl button Modifier Function/Comments

Volume — Encoders control channel’s Level fader.

Pan — Encoders control channel’s Pan/Balance control.
Generator — Encoders control software instrument parameters.
Track Info — Encoders control channel strip parameters.

EQ — Encoders control EQ parameters.

Effect 1 — Encoders control Insert 3 parameters.

Effect 2 — Encoders control Insert 4 parameter.

Option — Modifier for other controls; while held down, the

modified control either applies the function to all
channel strips, or sets the parameter to its
minimum, default, or maximum value.

Arrow Up/Arrow Down  — Shift fader bank left/right by number of channel
strips.

Option Shift fader bank to first or last group of channels
in the project.

M-Audio iControl: Channel Strip Controls and Functions
The following table outlines the channel strip controls and their functions:

iControl Modifier Function/Comments
Encoder — Modifies currently selected parameter.
Option Sets parameter to minimum, default, or maximum
value.
Record Enable — Activates/deactivates Record Enable button of

channel strip.
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iControl Modifier Function/Comments

Option Disables Record Enable buttons of all channel
strips.

Solo — Activates/deactivates Solo button of channel strip.

Option Disables Solo buttons of all channel strips.

Mute — Activates/deactivates Mute button of channel strip.

Option Disables Mute buttons of all channel strips.

Sel — Selects channel strip, except in Channel view.

M-Audio iControl: Jog Wheel Controls and Functions
The following table outlines the Jog Wheel controls and their functions:

iControl Modifier Function/Comments
Jog Wheel — Moves playhead.
Cycle Sets the left locator to the current playhead

position, advances the playhead as usual, then
sets the right locator to the new playhead position.
Further Jog Wheel turns (to the right) while
holding down the Cycle button advances the
playhead and resets the right locator position.

M-Audio iControl: Transport Controls and Functions
The following table outlines the transport controls and their functions:

iControl Modifier Function/Comments

Record — Record

Return to Zero — Go to beginning of project.

Rewind — Moves the playhead one bar backward. If held,

continue to scroll backward.

Cycle Engages Cycle function, and sets left locator to
playhead position.

Play — Play or Stop.

Fast Forward — Moves the playhead one bar forward. If held,
continue to scroll forward.

Cycle Engages Cycle function, and sets right locator to
playhead position.

Cycle — Switches Cycle mode on or off.
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Euphonix MC Pro, System 5-MC, 5
MC Control, MC Mix, and MC
Transport

Logic Pro supports the EuCon protocol developed by Euphonix. This protocol allows
enhanced communication between the MC Pro, System 5-MC, MC Control, MC Mix, or
MC Transport and Logic Pro.

Keep in mind the following when reading through the chapter: The term Euphonix device
is used when describing all devices as a group. MC Professional device is used when
speaking about the MC Pro and System 5-MC. MC Artist device is used when speaking
about the MC Mix, MC Transport, and MC Control. For any exceptions to the above,
individual device names are used.

Note: This is an addendum to the Euphonix user documentation and is limited to
descriptions of features specific to Logic Pro. Refer to the Euphonix documentation for
more information about the individual control surfaces.

This chapter covers the following:

+ Setting Up Your Euphonix Device with Logic Pro (p. 125)

+ Euphonix: Changing the Track Display (p. 126)

» Euphonix MC Professional: Setting Up Soft Key Assignments (p. 127)

+ Euphonix: Choosing Automation Modes (p. 128)

+ Euphonix: Understanding the Fader Strips (p. 129)

+ Euphonix: Opening and Closing Plug-in Windows (p. 129)

+ Euphonix: Getting to Know Knobsets (p. 130)

» Euphonix: Other Features Specific to Logic Pro (p. 138)

Setting Up Your Euphonix Device with Logic Pro
Depending on the specific Euphonix device you have, the setup process varies. Follow
the steps below to use your Euphonix device with Logic Pro.
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Note: EuCon support in Logic Pro works in a different way to the support of other control
surface devices. As a consequence, you cannot use the Controller Assignments window
to change assignments. See the documentation provided with your Euphonix device for
information on the use of parameters and device features. EuCon devices do not appear
in the Control Surfaces Setup window.

To set up your MC Professional device for use with Logic Pro
Set up your device as described in the Euphonix user documentation.

Install the latest EuCon software on your computer. (If necessary, go to the Euphonix
website to download the most recent version.)

Note: Installing EuCon software on the MC Professional device requires the installation
of two applications—one for the MC Pro device (EuConMC software), and a second for
the computer (EuConWS client). Full details are in the Euphonix user documentation.

Open Logic Pro.

The startup screen lets you know that Logic Pro is starting EuCon.

On the MC Pro, press the workstation button associated with your computer.
The MC Pro display shows an Attaching to Logic Pro progress bar.

To set up your MC Artist device for use with Logic Pro

Set up your device as described in the Euphonix user documentation.

Install the latest EuCon software on your computer. (If necessary, go to the Euphonix
website to download the most recent software version.)

With the EuControl application running on your computer, open Logic Pro.

Your MC Artist device will automatically connect to the application.

Euphonix: Changing the Track Display

By default, tracks are shown in the Mixer and on the display of your Euphonix device
according to the Mixer’s Arrange View mode. This means that all channel strips with
corresponding Arrange window tracks are displayed in the same order as in the Arrange
area.

Note: Redundant tracks—where multiple tracks are routed to the same channel strip—are
not accessible.

Switching the Mixer view to another mode (using the view buttons or channel strip filter
buttons) does not update the Euphonix device display. You can, however, override the
default behavior.

To switch the view of channel strips on Euphonix devices
Open the Logic Pro > Preferences > Control Surfaces > Setup window, and change the
Channel Strip View mode in the Control Surface Group 1 menu.
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Euphonix MC Professional: Setting Up Soft Key Assignments
The “Logic Pro.xml” Application Set file—installed with the EuCon software on your

MC Professional device—features a number of useful Soft Key assignments. It is possible
to edit these assignments.

To change a Soft Key assignment on your MC Professional device
Press the Setup button in the lower-right corner of the Soft Keys section on the device.

Select the respective Soft Key by pressing it.

Choose the desired EuCon command in the menu.

Logic Pro supports the following EuCon commands:

+ Key Commands: All Logic Pro key commands (except the transport commands) are
found here. The touchscreen uses the same hierarchy as the Key Commands window.
Many of these key commands switch between states (on/off, for example) or set a
value. Most also provide feedback on the Soft Key; for example, a Soft Key assigned to
the Open/Close Score Editor command is illuminated when a Score Editor window is
open.

+ Left Wheel/Right Wheel: The commands found here allow you to configure the left or
right wheel to perform a certain action when turned. This includes horizontal or vertical
zoom, waveform zoom, individual track zoom, move locators, adjust left locator, adjust
right locator, move punch locators, adjust punch in or punch out locator, move markers,
adjust marker lengths, nudge selected regions or events, left/right pan (surround X),
and front/back pan (surround Y).

* Project > Markers: All markers defined in the open project are shown as a list (which
only appears once you create the first marker in that project). Assigning a Soft Key to
a marker displays the marker title on the Soft Key, but only if the marker title consists
of six characters or fewer. A marker name with more than six characters is replaced on
the Soft Key by the marker number (1, for example). With this same limitation, renaming
a marker in Logic Pro also changes the associated Soft Key display. Pressing the Soft
Key moves the playhead to the marker start point. The Soft Key is illuminated while
the playhead is within the marker boundaries. Moving a marker disconnects the Soft
Key from the marker.

Note: Marker Soft Keys are a part of the Application Set, not the project. Don't forget
to save the User Set after defining a Marker Soft Key.

+ Transport: All transport-related key commands are found here.
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Euphonix: Choosing Automation Modes

The Euphonix devices only support Read and Write automation modes. Logic Pro, however,
also features Touch and Latch automation modes. When you use the Euphonix devices
with Logic Pro, activating Read/Write mode activates Touch mode in Logic Pro. Latch
mode cannot be activated with these devices.

To choose an automation mode on the MC Pro
Press the Wave and Select keys simultaneously.

Select the automation mode you want from the pop-up menu displayed on the
touchscreen. You can choose between:

+ Isolate: Automation mode is off.
* Read: Activates Read mode in Logic Pro.
+ Write: Activates Write mode in Logic Pro.

+ Read/Write: Activates Touch mode in Logic Pro.

You can also use the Select key to switch between automation modes in Logic Pro:

+ When you set the automation mode to Off or Read, the Select key switches between
these two modes.

+ When you set the automation mode to Read or Touch, the Select key switches between
these modes.

To choose an automation mode on a CM408T channel strip

Press the Wave and Y keys simultaneously.

The available automation modes are displayed in a pop-up menu on the CM408T display.

Use the fader of the channel strip to scroll through the following options:

+ Isolate: Automation mode is Off.

* Read: Activates Read mode in Logic Pro.

+ Write: Activates Write mode in Logic Pro.

* Read/Write: Activates Touch mode in Logic Pro.

Use the Y key to confirm your selection, or the N key to cancel the operation.

Note: If a write automation mode (Touch, Latch, Write) is active (and an automation

parameter is enabled in the Logic Pro > Preferences > Automation > Touch/Latch/Write

Erase settings), the red “W” LED is lit. The green LED is lit when a read automation mode
is active. Both LEDs are lit when Touch or Latch mode is active.

To choose an automation mode on MC Artist devices
Press and hold down the Shift key.
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2 Press the AUTO key repeatedly until your chosen automation mode appears on the display
screen. You can choose between:

* Blank: Automation mode is Off.
* Read (r): Activates Read mode in Logic Pro.
« Write (w): Activates Write mode in Logic Pro.

* Read/Write (rw): Activates Touch mode in Logic Pro.

Euphonix: Understanding the Fader Strips
The number of fader strips differs across each of the Euphonix devices. The following
section outlines the behavior of some fader strip elements in Logic Pro.

Note: This section is limited to descriptions of features specific to Logic Pro. Refer to the
Euphonix user documentation for information about basic fader behavior.

+ On key: The On key provides the same function as the Mute button in Logic Pro, but
behaves in a way that may not be expected.

+ The track is unmuted when the On key is lit (the Logic Pro Mute button is unlit).
+ The track is muted when the On key is unlit (the Logic Pro Mute button is lit).

« L LED: On MC Professional devices, when the Logic Pro channel strip being controlled
by the fader belongs to an automation group, the L LED of the channel strip is
illuminated.

+ “Touching fader selects track”: The “Touching fader selects track” preference of Logic Pro
(Logic Pro > Preferences > Control Surfaces > Preferences) does not apply to the
Euphonix devices when they are used with the EuCon protocol. This function is offered
by the individual devices, using the device’s “Select channel by touching fader/joystick”
or “Select by Touch” General preference. This is the same as pressing the Select/Sel key.

Euphonix: Opening and Closing Plug-in Windows

Logic Pro supports the Euphonix “Open plug-ins on workstation when editing” and “Close
plug-ins on workstation when exiting” preferences.

If the Link button is enabled in an open plug-in window:

+ "Open plug-ins on workstation when editing” does not open a new window when a
new plug-in is selected, but replaces the open window’s contents.

+ “Close plug-ins on workstation when exiting” does nothing.

If the Link button is disabled in an open plug-in window:

+ “Open plug-ins on workstation when editing” opens a new plug-in window.
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+ “Close plug-ins on workstation when exiting” closes the plug-in window.

Euphonix: Getting to Know Knobsets

When using the Euphonix devices with Logic Pro, the Mixer’s channel strip functions can
be accessed and edited using knobsets. A knobset contains pages, each comprised of
eight parameters. Knobsets are organized hierarchically.

The top-level knobset leads to the following knobsets:

+ Inserts: Pressing the Inserts knob top displays all effect plug-ins inserted in the currently
selected channel strip. (See Euphonix: Using the Inserts (Configuration) Knobset.) If a
plug-in is enabled (and does not belong to the dynamic, EQ, or filter plug-in groups)
either the On key is lit (MC Pro and MC Mix) or the knob’s image shows a small green
LED on the lower left (MC Control). To switch the bypass state, press the respective On
key or knob image, or the Ins In key on the CM408T channel strip.

* Input: Pressing the Input knob top displays all possible channel input values for the
selected channel strip. (See Euphonix: Using the Input (Configuration) Knobset.)

+ Dyn: The Dyn knob top is not currently used to display a list, or allow editing, of dynamic
plug-ins. If a dynamic plug-in is enabled, either the On key is lit (MC Pro and MC Mix)
or the knob's image shows a small green LED on the lower left (MC Control). To switch
the bypass state, press the respective On key or knob image, or the Dyn In key on the
CM408T channel strip.

*+ EQ: Pressing the EQ knob top switches to EQ editing mode. (See Euphonix: Using the
EQ Knobset.) If an EQ plug-in is enabled, either the On key is lit (MC Pro and MC Mix)
or the knob’s image shows a small green LED on the lower left (MC Control). To switch
the bypass state, press the respective On key or knob image, or the EQ In key on the
CM408T channel strip.

+ Auxor Sends: Pressing the Aux or Sends knob top switches to send editing mode. See
Euphonix: Using the Aux or Sends (Configuration) Knobset. If an Aux or Send is enabled,
either the On key is lit (MC Pro and MC Mix) or the knob'’s image shows a small green
LED on the lower left (MC Control). Pressing the respective On key or knob image
switches the bypass state.

* Pan: Pressing the Pan knob top switches to pan/surround editing mode. (See Euphonix:
Using the Pan/Surround Knobset.)

* Group: Pressing the Group knob top switches to group editing mode. (See Euphonix:
Using the Group Knobset.)

* Mix or Output: Pressing the Mix or Output knob top switches to output editing mode.
(See Euphonix: Using the Mix or Output Knobset.)
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Euphonix: Using the Inserts (Configuration) Knobset
This knobset allows you to:

+ Edit an effect plug-in (Inserts mode)

+ Change or insert an effect plug-in (Inserts Configuration mode)
Note: This knobset only relates to insert effects, and not to instrument plug-ins.

Editing Effect Plug-ins
You edit effect plug-ins in Inserts mode, using the Inserts knobset.

To edit an effect plug-in
Press the Inserts knob top, or key, to display all effect plug-ins inserted in the currently
selected channel strip. This key is labeled “*” (asterisk) on the CM408T channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The effect plug-in names are displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

If more than eight effect plug-ins are inserted, you can use the Page keys to display
ensuing plug-ins.

Press the knob top that features the name of the effect plug-in you want to edit.
The parameters are displayed in the order shown in the Controls view of the effect.
Turn the respective knob to change the value.

Depending on the system you are using, for parameters with only two values, you can
either press the On key, or turn the respective knob, to switch between the two values.
The On key is lit when the value is 1 (or on) and unlit when the value is 0 (or off).

Pressing a knob top sets the controlled parameter to its default value.

If there are more than eight parameters, use the Page keys to navigate between them.
Press the Back key to return to the top-level knobset.

Changing or Inserting Effect Plug-ins

You change or insert effect plug-ins in Inserts Configuration mode, using the Inserts
Configuration knobset.

To change or insert an effect plug-in

Press the Inserts knob top or key. The key is labeled “*” (asterisk) on the CM408T channel
strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

Press both Page keys simultaneously to display the Inserts Configuration knobset.

The first eight Insert slots of the selected channel strip are displayed.
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If an Insert slot already contains an effect plug-in, the On key is lit (on the MC Professional
and MC Mix devices). On the MC Control, it is indicated by a small green LED in the lower
left of the knob image.

Select the Insert slot you want by pressing the respective knob top. Press the Page keys
to display Insert slots 9 to 15.

The Logic Pro Effect Plug-in menu appears. Press the Page keys to display ensuing plug-ins
and to move through the effect plug-in hierarchy.

Choose the effect plug-in you want:
+ Pressing the knob top enters a submenu or inserts a selected effect plug-in.

+ Pressing the Back key navigates up one level in the menu hierarchy.

Euphonix: Using the Input (Configuration) Knobset

This knobset behaves differently, depending on the channel strip type you are working
with—audio or software instrument.

On audio channel strips, this knobset allows you to:

+ Set a channel strip’s input value (Input mode)

+ Set a channel strip’s input format (Input Configuration mode)

On instrument channel strips, this knobset allows you to:
+ Edit an instrument plug-in (Input mode)
+ Change or insert an instrument plug-in (Input Configuration mode)

Setting an Audio Channel Strip’s Input Value
You set an audio channel strip’s input value in Input mode, using the Input knobset.

To set a channel strip’s input value
Press the Input knob top, or key, to display all possible channel input values for the
selected channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The input values are displayed on the Soft Keys, the touchscreen, or the display, depending
on the system you are using.

You can use the Page keys to display ensuing input values.
Press the knob top that features the name of the channel input value you want to set.

The currently active input value is indicated by a lit On key (on the MC Professional and
MC Mix devices). On the MC Control, it is indicated by a small green LED in the lower left
of the knob image.
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Setting an Audio Channel Strip’s Input Format
You set an audio channel strip’s input format in Input Configuration mode, using the
Input Configuration knobset.

To set a channel strip’s input format

Press the Input knob top or key.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.
Press both Page keys simultaneously to switch to Input Configuration mode.

The selected channel strip's input format values—Mono, Stereo, Left, Right, Surround—are
displayed.

The currently active format value is indicated by a lit On key (on the MC Professional and
MC Mix devices). On the MC Control, it is indicated by a small green LED in the lower left
of the knob image.

Press the respective knob top to choose the input format you want.

Editing Instrument Plug-ins
You edit instrument plug-ins in Input mode, using the Input knobset.

To edit an instrument plug-in
Press the Input knob top, or key, to display the software instrument plug-in inserted in
the currently selected channel strip.

The instrument plug-in name is displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

Press the knob top to display the instrument plug-in parameters in the order shown in
the Controls view of the instrument.

Turn the respective knob to change the value.

Depending on the system you are using, for parameters with only two values, you can
either press the On key, or turn the respective knob, to switch between the two values.
The On key is lit when the value is 1 (or on) and unlit when the value is 0 (or off).

Pressing a knob top sets the controlled parameter to its default value.

If the instrument plug-in features more than eight parameters, use the Page keys to
navigate between pages of parameters.

Press the Back key to return to the top-level knobset.

Changing or Inserting Instrument Plug-ins
You change or insert instrument plug-ins in Input Configuration mode, using the Input
Configuration knobset.

To change or insert an instrument
Press the Input knob top, or key.
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2 Press both Page keys simultaneously to switch to Input Configuration mode.

The Logic Pro Instruments Plug-in menu appears. Press the Page keys to display ensuing
plug-ins.

If an instrument plug-in is already inserted, the On key is lit (on the MC Professional and
MC Mix devices). On the MC Control, it is indicated by a small green LED in the lower left
of the knob image.

3 Choose the instrument you want:
+ Pressing the knob top activates a submenu or inserts a selected instrument plug-in.

+ Pressing the Back key navigates up one level in the menu hierarchy.

Euphonix: Using the EQ Knobset

This knobset allows you to edit the first Channel or Linear Phase EQ inserted in the selected
channel strip.

There are two pages, each showing four EQ bands on eight knobs:

+ One page contains the parameters of EQ bands 1, 2, 7, and 8.

+ One page contains the parameters of EQ bands 3, 4, 5, and 6.

When no Channel or Linear Phase EQ is present on the selected channel strip, pressing
the knob top labeled AddChEQ inserts a Channel EQ.

To edit an EQ plug-in
1 Press the EQ knob top, or key, to display the EQ bands of the EQ plug-in inserted in the
currently selected channel strip.

Note: The MC Mix automatically switches to Channel mode.

The EQ band parameters are displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

You can use the Page keys to display ensuing parameters.
2 Turn the respective knob to change the parameter value.
Pressing a knob top sets the controlled parameter to its default value.

3 Press the Back key to return to the top-level knobset.
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Euphonix: Understanding the Controls Available for Each EQ Band
This section outlines the addressing and control of EQ bands with the MC Professional
and MC Mix devices.

+ The first knob of an EQ band (the upper or left knob of the pair) controls either
Frequency or Q. To switch between Frequency and Q, use the Select/SEL key if working
with the MC Professional devices or the MC Mix. If using the MC Control, press the Shift
key while touching the knob’s image on the touchscreen. (When active, a small yellow
LED lights on the upper left of the image.) Pressing the knob top sets the controlled
parameter to its default value.

+ The second knob of an EQ band (the lower or right knob of the pair) controls Gain (or
Slope). Pressing the knob top sets the controlled parameter to its default value.

+ If working with the MC Professional devices or the MC Mix, the On key switches the
bypass state of the band. On the MC Control, press the knob’s touchscreen image.

Euphonix: Using the Aux or Sends (Configuration) Knobset
The Aux or Sends (Configuration) knobset allows you to:

« Edit a send destination (Aux or Sends mode)
+ Change or set a send destination (Aux or Sends Configuration mode)

The Select key (labeled SEL on the MC Mix) switches between Pre Fader (off—unlit) and
Post Fader (on—Ilit) modes.

Editing Send Destinations
You edit send destinations in Aux/Sends mode, using the Aux/Sends knobset.

To edit a send destination
Press the Aux or Sends knob top, or key, to display all send options for the currently
selected channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The send options are displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

Turn the respective knob to change the send level.

Pressing a knob top sets the controlled parameter to its default level.
Press the Back key to return to the top-level knobset.

Changing or Setting Send Destinations

You change or set send destinations in Aux/Sends Configuration mode, using the
Aux/Sends Configuration knobset.

To change or set a send destination
Press the Aux or Sends knob top, or key.
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Note: If using the MC Mix, press the CHAN key to enter Channel mode.
Press both Page keys simultaneously to switch to Send Configuration mode.
The eight Send slots of the currently selected channel strip are displayed.
Select the Send slot you want by pressing the respective knob top.

The first eight send destinations are displayed. You can use the Page keys to display
further send destinations (busses).

Choose the send destination:
+ Pressing the knob top changes, or sets, a selected destination.

+ Pressing the Back key navigates up one level in the menu hierarchy.

Euphonix: Using the Pan/Surround Knobset
This knobset allows you to adjust a channel strip’s Pan/Surround control. If the channel
strip’s input format is set to Surround, the knobset displays the following parameters:

+ Surround Angle

+ Surround Diversity

+ LFE Level

+ Surround X (left/right)

+ Surround Y (front/back)

+ Spread

+ Center Level

To adjust the pan/surround control

Press the Pan/Surround knob top, or key, to display the Pan/Surround parameters for the
currently selected channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The parameter names are displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

Turn the respective knob to change the parameter value.
Pressing a knob top sets the controlled parameter to its default value.

Press the Back key to return to the top-level knobset.

Euphonix: Using the Group Knobset
This knobset allows you to edit a channel strip’s group membership.

To add a channel strip to a group
Press the Group knob top, or key, to display the list of groups that the currently selected
channel strip is assigned to. This key is labeled Grp on the CM408T channel strip.

Chapter 5 Euphonix MC Pro, System 5-MC, MC Control, MC Mix, and MC Transport



Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The groups names are displayed on the Soft Keys, the touchscreen, or the display,
depending on the system you are using.

If a channel strip is associated with more than the first eight groups, you can use the Page
keys to display ensuing groups.

Press the knob top that features the name of the group you want to associate the channel
strip with.

+ When you choose an inactive group number, the Group Settings window opens
automatically, with the channel strip being added to the group.

+ When you choose an active group number, the channel strip is added directly to the
group.
Tip: The On key can also be used to switch between active/inactive group membership
for the selected channel strip.

Press the Back key to return to the top-level knobset.
To remove a channel strip from a group

Press the Group knob top, or key, to display the list of groups that the currently selected
channel strip is assigned to. This key is labeled Grp on the CM408T channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

Press the knob top that features the name of the Group you want to remove the channel
strip from.

That particular channel is removed from the group.

Tip: The On key can also be used to switch between active/inactive group membership
for the selected channel strip.

Press the Back key to return to the top-level knobset.

Euphonix: Using the Mix or Output Knobset
This knobset allows you to change the mix or output destination of a channel strip.

To change the output destination of a channel strip
Press the Mix or Output knob top, or key, to display all possible mix or output values for
the currently selected channel strip.

Note: If using the MC Mix, press the CHAN key to enter Channel mode.

The value names are displayed on the Soft Keys, the touchscreen, or the display, depending
on the system you are using.

To select the output destination, do one of the following:
+ Press the knob top that features the name of the mix or output value.

+ Press the On key for the relevant mix or output value.
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You can use the Page keys to display ensuing outputs.

The currently active output is indicated by a lit On key (on the MC Professional and MC Mix
devices). On the MC Control, it is indicated by a small green LED in the lower left of the
knob image.

3 Press the Back key to return to the top-level knobset.

Euphonix: Other Features Specific to Logic Pro
This section describes other features specific to Logic Pro.

+ Layouts: Tracks assigned to channel strips can be saved as a Layout. This Layout can
then be recalled at a later time. Any Layouts saved on Euphonix devices are automatically
saved with the Logic Pro project.

+ Monitors and Control Room: Logic Pro does not support EuCon monitoring control. Use
the Studio Monitor Pro application.

« Track control bar: The track control bar of the Logic Pro Arrange area offers a special
feature on the Euphonix devices: it shows attentioned tracks in blue.

Note: The color of the track control bar cannot be changed in the Control Surfaces Setup
window.
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CM Labs Motormix 6

This chapter describes how to use your CM Labs Motormix with Logic Pro.

This chapter covers the following:
+ Setting Up Your CM Labs Motormix (p. 139)
+ CM Labs Motormix: Assignment Overview (p. 139)

Setting Up Your CM Labs Motormix

Follow the steps below to use your CM Labs Motormix control surface with Logic Pro.
To set up your CM Labs Motormix control surface in Logic Pro

Ensure that your Motormix unit is connected bidirectionally with the MIDI interface.
Choose Logic Pro > Preferences > Control Surfaces > Setup.

Choose Install from the Setup window's New menu.

Select Motormix in the Install window, click Add, then set the appropriate MIDI In and
Out ports in the Setup window.

CM Labs Motormix: Assignment Overview
Assignments of CM Labs Motormix interface elements to Logic functions are covered in
the following sections:

+ CM Labs Motormix: Select Buttons

+ CM Labs Motormix: Rotary Pots

+ CM Labs Motormix: Multi Buttons

+ CM Labs Motormix: Burn Buttons

» CM Labs Motormix: SOLO Buttons

+ CM Labs Motormix: MUTE Buttons

+ CM Labs Motormix: VIEW Section

» CM Labs Motormix: Left Function Buttons
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« CM Labs Motormix: Faders
+ CM Labs Motormix: Right Function Buttons

CM Labs Motormix: Select Buttons
The Select buttons (buttons just below the LCD) have multiple uses, depending on the
current mode.

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Mode Assignment

Normal Selects channel displayed in upper LCD line. Channels can be shifted
to the left and right with the View left and right buttons.

Bank button LED flashing Channel View mode: Select buttons switch between displayed
channel strips:

+ 1:Switches to Single view.

+ 2: Switches to Arrange view.

+ 3: All view, MIDI channels

+ 4: All view, input channels

+ 5: All view, audio channels

+ 6: All view, instrument channels

+ 7: All view, aux and bus channels

+ 8: All view, output and master channels

WINDOW/tool button LED on Window Select mode: Select buttons open, assign key focus, or
close a particular window type. LED off: If the window is not open,
the button opens it. LED on: If the window is open, but does not
have key focus, the button activates it. LED flashes: If the window
has key focus, the button closes it.

+ 1:Arrange window

+ 2: Mixer

* 3:Event List

+ 4:Score Editor

+ 5: Hyper Editor

+ 6: Piano Roll Editor

+ 7:Transport Bar window
+ 8: Audio Bin

WINDOW/tool button flashes Select Tool mode: Select buttons choose a tool.

+ 1:Pointer
« 2:Pencil

» 3:Eraser

+ 4: Text tool
+ 5:Scissors
+ 6: Glue tool
+ 7:Solo tool
+ 8: Mute tool
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Mode Assignment

PLAY/transport button flashes ~ Transport section mode

+ 1:Record

+ 2:Pause

+ 3:Stop

+ 4:Play

+ 5:Rewind

+ 6: Fast Forward

+ Upper LCD row displays current playhead position.

STOP/locate button flashes Locate mode

+ 1: Goes to left locator.

+ 2: Goes to right locator.

+ 3:Enables or disables Cycle mode.

+ 4: Enables or disables Autopunch mode.

+ 5: Enters Marker mode (see below).

+ 6: Opens Marker List.

+ Upper LCD row displays current playhead position.

Marker mode + 1to 6: Select markers 1 to 6. Marker names are displayed in the
upper LCD row.
+ 7:Creates a new marker.
+ 8: Deletes selected marker.

Group Edit mode Switches between group parameters. Parameter display can be
shifted by the View left and right buttons when the SHIFT button
is held down.

Effect Assign mode Enters Effect Edit mode for the selected channel.

Effect Edit mode Enables/disables the selected parameter, or resets it to the default
value.

Instrument Assign mode Enters Instrument Edit mode for the selected (instrument) channel.

Instrument Edit mode Enables/disables the selected parameter, or resets it to the default
value.

Note: In modal dialogs, the Select buttons generate the computer keyboard character
shown on the button face.

CM Labs Motormix: Rotary Pots
The following table outlines the rotary pot controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Control Modifier Assignment

Rotary pots 1to 8 Control parameter chosen with the Rotary Selector,
as displayed in the 7 segment display (see below).
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Control Modifier Assignment

7 segment display Shows current selection for rotary pots:
Send/EQ editing (S-MUTE or PRE/PST LED is on):

+ S1toS8=Send 1 to 8 level

+ F1to F8 =EQ band 1 to 8 frequency
» G1toG8 =EQ band 1 to 8 gain

+ q1tog8=EQband 1to8Q factor
Pan/Surround editing (select LED is on):
* Pn=Pan

» An = Surround Angle

+ dv = Surround Diversity

+ FE = Surround LFO

» Sp = Surround Spread

+ X =Surround X

+ Y =Surround Y

Channel parameter editing (eff-4 LED is on):
+ VL =Volume

* Pnor An = Pan/Surround Angle

* FM = Channel input format

+ In = Channel input assignment

» Ou = Channel output assignment

* Au = Automation mode

+ Gr = Group membership

Assignment:
» d1to d8 = Assign Send 1 to 8 destination.
Effect editing (DSP/compare LED is on):

+ P1to 15 = Assign Insert slot 1 to 15 to effect.
+ P1.to 15. = Effect parameter editing
Instrument editing (DSP/compare LED is on):

+ |A = Assign instrument to Instrument slot.

+ |E. = Instrument parameter editing

Group property editing (group LED is on):

» G1 to 32 = group number

Rotary Selector Selects a slot or parameter for rotary encoders,
depending on the parameter types being edited
with the rotary encoders:

» Send slot when editing send level or assigning
send destination.

+ EQ band when editing an EQ parameter.

+ Effect/Instrument slot when assigning an effect
or instrument.

+ Pan/Surround parameter when editing a
Pan/Surround parameter.

+ Channel parameter when editing a channel
parameter.

+ Effect/instrument parameter page when editing
an effect or instrument plug-in.
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Control Modifier Assignment

Rotary Selector push Switches Flip mode between Off and Duplicate
button (faders mirror the rotary encoder assignments).

SHIFT Switches the channel strip display mode between:

+ Page info in upper line, parameter name in
lower line.

+ Parameter name in upper line, parameter value
in lower line.

CM Labs Motormix: Multi Buttons
These buttons (labelled A to H) have multiple uses, depending on the current mode, as
indicated by the green and yellow LEDs to the right.

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Mode Modifier Assignment
fx bypass Enables/disables bypass of currently selected insert
effect.
SHIFT (eff-1) Enables/disables bypass of currently selected EQ

band, and switches rotary encoders to EQ
frequency editing.

s-mute Enables/disables bypass of currently edited send,
and switches rotary encoders to send level editing.

SHIFT (eff-2) Enables/disables bypass of currently selected EQ
band, and switches rotary encoders to EQ Gain
editing.

pre/post Switches between Pre and Post Fader modes of
currently edited send, and switches rotary
encoders to send level editing. Post mode is
indicated by a lit LED.

SHIFT (eff-3) Enables/disables bypass of currently selected EQ
band, and switches rotary encoders to (EQ) Q
factor editing.

select Switches rotary encoders to Pan/Surround editing.
The parameter is chosen with the rotary selector.

SHIFT (eff-4) Switches rotary encoders to channel parameter
editing.

Note: In modal dialogs, the Multi buttons generate the computer keyboard character
shown on the button face.

CM Labs Motormix: Burn Buttons
These buttons (labelled | to P) have multiple uses, depending on the current mode, as
indicated by the red LEDs to the left.
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Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Mode Modifier

record

Assignment

Enables/disables Record Enable status of channel.

SHIFT (fnctA)

Switches automation mode to Latch.

ALL + SHIFT (fnctA)

Switches automation mode of all channels to
Latch.

write Switches automation mode to Write.
ALL Switches automation mode of all channels to
Write.
SHIFT (fnctB) Switches automation mode to Read.
ALL + SHIFT (fnctA) Switches automation mode of all channels to Read.
burn Switches automation mode to Touch.

ALL

Switches automation mode of all channels to
Touch.

SHIFT (fnctC)

Switches automation mode to Off.

ALL + SHIFT (fnctA)

Switches automation mode of all channels to Off.

Note: In modal dialogs, the Burn buttons generate the computer keyboard character

shown on the button face.

CM Labs Motormix: SOLO Buttons

These buttons switch the Solo status of the displayed channel.

Note: In modal dialogs, the SOLO buttons generate the computer keyboard character

shown on the button face.

CM Labs Motormix; MUTE Buttons

These buttons switch the Mute status of the displayed channel.

Note: In modal dialogs, the MUTE buttons generate the computer keyboard character

shown on the button face.

CM Labs Motormix: VIEW Section

The following table outlines the view controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.
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Control Modifier

Left/right buttons

Assignment

In Effect and Instrument Plug-in Edit modes: shifts
the parameter bank. In other modes:

« If BANK LED is off: shifts the fader bank by one
channel.

+ If BANK LED is on: shifts the fader bank by one
bank (a group of 8 channels).

SHIFT

In Effect and Instrument Plug-in Edit modes: shifts
the parameter bank by one parameter. In Group
Edit mode, the group parameter bank is shifted.

bank

Switches mode of left/right buttons (see above).

SHIFT

Sets Select buttons to Channel View mode.

group

Sets Select buttons, rotary encoders, and Multi
buttons to Group Edit mode.

SHIFT

Displays channels’ group assignments in the LCD.
The rotary encoders allow you to change
assignments.

CM Labs Motormix: Left Function Buttons
The following table outlines the left function button controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Control Modifier

AUTO ENBL/mode

Assignment

Currently unassigned

SHIFT

Switches rotary encoders to Automation Enable
mode.

SUSPEND/create

While held down, the groups are temporarily
disabled.

SHIFT

Creates a new group, and enters Group Edit mode.

PLUG-IN/compare

Switches rotary encoders and Multi buttons to
Effect Assign mode. Use the Rotary Select knob to
choose the Insert slot you want to edit. In Effect
or Instrument Assign mode, it switches to Pan
mode. In Effect Edit mode, it switches to Effect
Assign mode. In Instrument Edit mode, it switches
to Instrument Assign mode.

SHIFT

Switches rotary encoders and Multi buttons to
Instrument Assign mode.

WINDOW/tools

Switches Select buttons to Window Select mode.

SHIFT

Switches Select buttons to Select Tool mode.
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Control Modifier

ALL/ALT/FINE

Assignment

While ALL/ALT/FINE is held down, rotary encoders
are in Full mode: rotating counterclockwise sets
minimum, rotating clockwise sets maximum value.

SHIFT

While SHIFT and ALL/ALT/FINE are held down,
rotary encoders are in Fine mode. Parameter
changes are made in single unit (or smaller) values.

DEFAULT/bypass

Currently unassigned

SHIFT

In Instrument Edit mode: switches bypass state of
the instrument. In Effect Edit mode: switches
bypass state of the effect being edited.

UNDO/save

Performs an Undo step. The LED is lit if there is a
Redo step available.

SHIFT

Saves the project. The LED is lit if the project
contains unsaved changes.

SHIFT

Switches to Shift mode, where the functions
indicated by the (inverted) labels below the
buttons apply.

CM Labs Motormix: Faders

The faders normally control volume. When in Flip mode, however, they duplicate the

rotary encoder assignments.

CM Labs Motormix: Right Function Buttons
The following table outlines the right function button controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a button description, it indicates
that the control has an alternate use while the modifier is held down.

Control Modifier Assignment
PLAY/transport Play key command

SHIFT Switches Select buttons to Transport Section

mode.

STOP/locate Stop key command

SHIFT Switches Select buttons to Locate mode.
FFWD/monitor Shuttle Forward key command
REWIND/status Shuttle Rewind key command

SHIFT Opens Project Settings Synchronization window.
NEXT/configure Moves playhead to next marker.
LAST/assign When rotary encoders are displaying send

destinations, use of LAST/assign reverts to
displaying send levels. Otherwise, moves playhead
to previous marker.
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Control Modifier
SHIFT

Assignment

When rotary encoders are displaying send levels,
use of LAST/assign switches them to display send
destinations. When rotary encoders are in Effect
Edit mode, use of LAST/assign switches them to
Effect Assign mode. When rotary encoders are in
Instrument Edit mode, use of LAST/assign switches
them to Instrument Assign Mode.

ENTER/utility

Identical to Enter key on computer keyboard.

SHIFT

Opens Project Settings Automation window.

ESCAPE

When LED is lit, escapes from “special” mode
(denoted by flashing LED). At all other times,
identical to Esc key on computer keyboard.
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Frontier Design TranzPort 7

This chapter describes how to use your Frontier Design TranzPort with Logic Pro.
Note: Support for the AlphaTrack control surface is available from Frontier Design.

This chapter covers the following:
+ Setting Up Your Frontier Design TranzPort (p. 149)
* Frontier Design TranzPort: LCD (p. 149)

+ Frontier Design TranzPort: Assignment Overview (p. 150)

Setting Up Your Frontier Design TranzPort
Follow the steps below to use your Frontier Design TranzPort control surface with
Logic Pro.

To set up your Frontier Design TranzPort device in Logic Pro
Ensure that the software that shipped with the TranzPort is installed.

Make sure that the Tranz Bridge (the wireless transmitter) is connected to the computer
via USB.

When Logic Pro is opened, it installs the TranzPort automatically, and sets it to Native
mode.

Frontier Design TranzPort: LCD
The LCD displays the following information:

+ Top line left: Name of currently displayed channel

+ Top line middle: Volume level of currently displayed channel
« Top line right: Pan position of currently displayed channel

+ Bottom line left: Level meter of currently displayed channel

* Bottom line right: Current playhead position
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Frontier Design TranzPort: Assignment Overview
The following sections outline the assignment of Frontier Design TranzPort interface
elements to Logic functions.

* Frontier Design TranzPort: Channel Strip
* Frontier Design TranzPort: Master Section

+ Frontier Design TranzPort: External Input

Frontier Design TranzPort: Channel Strip
The following table outlines the channel strip controls and their assignments:

Note: A SHIFT (or other modifier) shown below a button description indicates that the
button has an alternate meaning, while the modifier is held down.

Control Modifier Assignment
<CHAN Shifts the currently displayed channel to the left
by one channel.
SHIFT Shifts the currently displayed channel left by eight
channels.
CHAN> Shifts the currently displayed channel right by one
channel.
SHIFT Shifts the currently displayed channel right by
eight channels.
REC Activates/deactivates the Record Enable button
of the currently displayed channel.
SHIFT Disables the Record Enable buttons of all channels.
SOLO Enables/disables Solo for the currently displayed
channel.
SHIFT Disables Solo for all channels.
MUTE Enables/disables Mute for the currently displayed
channel.
SHIFT Disables Mute for all channels.
ANY SOLO Lit if any tracks, channels, or regions are soloed.
UNDO Undo
SHIFT Redo

Frontier Design TranzPort: Master Section
The following table outlines the master controls and their assignments:

Note: A SHIFT (or other modifier) shown below a button description indicates that the
button has an alternate meaning, while the modifier is held down.
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Control Modifier
SHIFT

Assignment

Modifier that alters the function of other controls.

IN

Moves playhead to left cycle locator.

PUNCH

Engages Autopunch mode, and sets punch in
locator to playhead position.

LOOP

Engages Cycle mode, and sets left cycle locator to
playhead position.

out

Goes to right cycle locator.

PUNCH

Engages Autopunch mode, and sets punch out
locator to playhead position.

LOOP

Engages Cycle mode, and sets right cycle locator
to playhead position.

PUNCH

Enables/disables Autopunch mode.

LOOP

Enables/disables Cycle mode.

PREV

Moves playhead to previous marker.

SHIFT

Sets locators by previous marker.

ADD

Creates marker at playhead position.

SHIFT

Deletes marker at playhead position.

NEXT

Moves playhead to next marker.

SHIFT

Sets locators by next marker.

Jog Wheel

Depending on current Jog Wheel mode:

+ Moves playhead by bars.
+ Controls audio (and MIDI) scrubbing.
+ Shuttles forward or backward.

SHIFT

Adjusts volume of the currently displayed channel.

LOOP

Sets the left locator to the current playhead
position, advances the playhead as usual, then
sets the right locator to the playhead position.
Further Jog Wheel use—while holding down
LOOP—advances the playhead, and sets the right
locator.

Tip: Rotating the Jog Wheel counterclockwise,
while holding down LOOP, defines a skip cycle
range.

DROP

Sets the punch in locator to the current playhead
position, advances the playhead as usual, then
sets the punch out locator to the playhead
position. Further Jog Wheel use—while holding
down DROP—advances the playhead, and sets
the punch out locator.

REW

Shuttles backward.
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Control Modifier Assignment
SHIFT Goes to last play position.
PUNCH Engages Autopunch mode, and sets punch in
locator to playhead position.
LOOP Engages Cycle mode, and sets left locator to
playhead position.
F FWD Shuttles forward.
PUNCH Engages Autopunch mode, and sets punch out
locator to playhead position.
LOOP Engages Cycle mode, and sets right locator to
playhead position.
STOP Stop
SHIFT Switches Jog Wheel between Move Playhead (by
bars), Scrubbing, and Shuttle modes.
PLAY Play
SHIFT Pause
RECORD Record
SHIFT Save

Frontier Design TranzPort: External Input
The following table outlines the foot switch input control and its assignment.

Control Assignment

Foot Switch Punch In/Out
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JLCooper CS-32 MiniDesk 8

This chapter describes how to use your JLCooper CS-32 MiniDesk with Logic Pro.

This chapter covers the following:
+ Setting Up Your JLCooper CS-32 MiniDesk (p. 153)
+ JLCooper CS-32 MiniDesk: Assignment Overview (p. 153)

Setting Up Your JLCooper CS-32 MiniDesk

Follow the steps below to use your JLCooper CS-32 MiniDesk control surface with Logic Pro.
To add JLCooper CS-32 control surfaces connected via USB

Install the software that comes with the CS-32.

Ensure that the CS-32 is in Host mode.

Make sure that your CS-32 units are connected to the computer via USB.
USB units are installed automatically when you open Logic Pro.

To add JLCooper CS-32 control surfaces connected via MIDI

Install the software that comes with the CS-32.

Ensure that the CS-32 is in Host mode.

Make sure that your CS-32 units are connected to the computer via MIDI.
Choose Logic Pro > Preferences > Control Surfaces > Setup.

Choose Install in the Setup window’s New menu.

Select the CS-32 from the list in the Install window.

Click the Scan button.

JLCooper CS-32 MiniDesk: Assignment Overview
Assignments of JLCooper CS-32 MiniDesk interface elements to Logic functions are covered
in the following sections:

+ JLCooper CS-32 MiniDesk: Display
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+ JLCooper CS-32 MiniDesk: Pots

+ JLCooper CS-32 MiniDesk: Channel Strips

+ JLCooper CS-32 MiniDesk: Bank Button

+ JLCooper CS-32 MiniDesk: F Key Section

+ JLCooper CS-32 MiniDesk: Cursor Section

+ JLCooper CS-32 MiniDesk: Transport Section
+ JLCooper CS-32 MiniDesk: Jog Wheel Section

JLCooper CS-32 MiniDesk: Display

The display shows information on the current mode, and parameters being edited.

Display text Meaning

- A switching parameter (Solo, Mute, Rec/Rdy) has been disabled.

AE Automation Enable setup: Mute buttons 1-6 display/set various
automation parameters.

AS Pots (knobs) are in Pan/Send Assignment mode.

b1—b9 Pots are in Plug-in or Instrument Bank Select mode.

In Pots are in Instrument Edit mode.

Lt Mute buttons display/set Latch automation mode.

Mu Mute has been enabled.

P1—P9 Pots are in Effect Edit mode.

PA Pots are in Pan/Send mode.

rd Mute buttons display/set Read automation mode.

Re Rec/Rdy has been enabled.

So Solo has been enabled.

Tc Mute buttons display/set Touch automation mode.

Wr Mute buttons display/set Write automation mode.

Other text When a channel is selected, the first two characters of its name are
briefly displayed.

Numbers While editing a numerical value with a fader or pot, the current

value is displayed. If there are more than two digits in the value,
the last two digits are shown. Plus/minus signs (+/-) are shown if
only one digit is displayed.

JLCooper CS-32 MiniDesk: Pots

As the pots are not motorized, Pickup mode is used (if turned on in the Control Surfaces
preferences). In Pickup mode, the controller must reach (pick up) the current value before
the value starts to change. This prevents sudden jumps of parameter values caused by
playing back automation.
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A pot’s current value is indicated by the NULL arrow LEDs.
+ The Upper arrow is lit if the pot’s value is above the current value.
+ The Lower arrow is lit if the pot’s value is below the current value.

+ Both arrow LEDs are lit when the pot has reached the current value.
The pots can operate in one of three modes, with one sub-mode in each.

Note: If a modifier button, such as SHIFT, is shown below a description, it indicates that
the control has an alternate use while the modifier is held down.

Pan/Send Mode
Press F7 to enable Pan/Send mode (display shows “PA”). In this mode, the pots control
the following channel parameters:

Control Assignment

SEND A/P1 Controls Send 1 level of selected channel.
SEND B/P2 Controls Send 2 level of selected channel.
PAN/P3 Controls pan of selected channel.

SEND C/P4 Controls Send 3 level of selected channel.
SEND D/P5 Controls Send 4 level of selected channel.
SEND E/P6 Controls Send 5 level of selected channel.

While SHIFT is held down (display shows “AS"), the pots allow you to perform the following
assignments:

Control Assignment

SEND A/P1 Assigns Send 1 destination (bus) for selected channel.
SEND B/P2 Assigns Send 2 destination for selected channel.
PAN/P3 Assigns input format of selected channel.

SEND C/P4 Assigns Send 3 destination for selected channel.
SEND D/P5 Assigns Send 4 destination for selected channel.
SEND E/P6 Assigns Send 5 destination for selected channel.

Instrument Edit Mode
Press F8 to enter Instrument Edit mode (display shows “In”). The pots control (software)
instrument parameters.

Note: With SHIFT held down (display shows “b1"-"b9"), you can move between banks
(pages) of parameters. (See JLCooper CS-32 MiniDesk: Cursor Section.)

Chapter 8 JLCooper CS-32 MiniDesk 155



Effect Edit Mode
Press F9 to enter Effect Edit mode (display shows “P1"-"P9"). The pots control the
parameters of the effect in the currently selected Insert slot.

Note: With SHIFT held down (display shows “b1"-"b9”), you can switch between Insert
slots, and move between banks (pages) of parameters. (See JLCooper CS-32 MiniDesk:
Cursor Section.)

JLCooper CS-32 MiniDesk: Channel Strips
The following table outlines the channel strip controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a description, it indicates that
the control has an alternate use while the modifier is held down.

Control Modifier Assignment

PAN SELECT/TRACK Selects channel strip (destination for the selected

SELECT track).

SOLO Enables/disables Solo.

LOCATE Moves playhead to markers 1 to 32.

SHIFT LOCATE 17: Creates a new marker.

LOCATE 18: Creates a new marker without
rounding.
LOCATE 19: Deletes the marker at the playhead
position.

LOCATE 25: Opens the Marker List.

LOCATE 26: Opens the Marker Text window.
LOCATE 28: Sets locators by previous marker.
LOCATE 29: Sets locators by current marker.
LOCATE 30: Sets locators by next marker.
LOCATE 31: Moves playhead to previous marker.
LOCATE 32: Moves playhead to next marker.

MUTE Enables/disables Mute.

F1 Automation Enable setup (display shows “AE").
MUTE 1: Enables/disables volume automation.
MUTE 2: Enables/disables pan automation.
MUTE 3: Enables/disables mute automation.
MUTE 4: Enables/disables automation of solo.
MUTE 5: Enables/disables send (level) automation.

MUTE 6: Enables/disables automation of plug-in
parameters.

F2 Switches automation mode between Read and
Off (display shows “Td").

F3 Switches automation mode between Touch and
Off (display shows “Tc").
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Control Modifier Assignment

F4 Switches automation mode between Latch and
Off (display shows “Lt").

F5 Switches automation mode between Write and
Off (display shows “Wr").

ARM Activates/deactivates Record Enable button.

Faders Control volume. As the faders don't offer feedback,
Pickup mode is used, as per the pots. See the
pickup information in JL.Cooper CS-32 MiniDesk:
Pots.

JLCooper CS-32 MiniDesk: Bank Button

The following table outlines the bank controls and their assignments:

Control Assignment

Small red button with green LED  LED off: Black labels of channel strip buttons apply (TRK/LOC/ARM).

LED on: White labels of channel strip buttons apply
(PAN/SOLO/MUTE).

JLCooper CS-32 MiniDesk: F Key Section

The following table outlines the F key controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a description, it indicates that
the control has an alternate use while the modifier is held down.

Control Modifier Assignment
SHIFT Modifier for function of other controls. See SHIFT
entries in left column.
F1 While held down, MUTE buttons 1-6
enable/disable automation of certain parameters
(see MUTE).
SHIFT Enables/disables Cycle mode.
F2 While held down, MUTE buttons set automation
mode to Read.
SHIFT Enables/disables Autopunch mode.
F3 While held down, MUTE buttons set automation
mode to Touch.
SHIFT Sets left locator by current playhead position.
F4 While held down, MUTE buttons set automation
mode to Latch.
SHIFT Sets right locator by current playhead position.
F5 While held down, MUTE buttons set automation

mode to Write.
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Control Modifier Assignment

SHIFT Sets punch in locator by current playhead position.

F6

SHIFT Sets punch out locator by current playhead
position.

F7 Sets pots to Pan/Send mode (display shows “PA”).

SHIFT Enables/disables metronome click.

F8 Sets pots to Instrument Edit mode (display shows
“—n.

Fo Sets pots to Effect Edit mode (display shows
“P17_"pQ").

JLCooper CS-32 MiniDesk: Cursor Section
The following table outlines the cursor controls and their assignments:

Note: If a modifier button, such as SHIFT, is shown below a description, it indicates that
the control has an alternate use while the modifier is held down.

Control Modifier Assignment
Up Zooms out vertically.
SHIFT In Effect Edit mode: moves up one Insert slot

(unless top slot is selected).

Down Zoom:s in vertically.

SHIFT In Effect Edit mode: moves down one Insert slot
(unless bottom slot).

Left Zooms out horizontally.

SHIFT In Instrument and Effect Edit modes: decrements
current parameter bank (moves down one bank,
or page, of parameters).

Right Zooms in horizontally.

SHIFT In Instrument and Effect Edit modes: increments
current parameter bank (moves up one bank, or
page, of parameters).

JLCooper CS-32 MiniDesk: Transport Section
The following table outlines the transport controls and their assignments:

Control Assignment

RECORD Record
STOP Stop
REW Moves playhead backward by one bar.
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Control Assignment

PLAY Play

F FWD Moves playhead forward by one bar.

JLCooper CS-32 MiniDesk: Jog Wheel Section

The following table outlines the Jog Wheel controls and their assignments:

Control Assignment

Jog Wheel SCRUB off: Moves playhead (in bar increments).
SCRUB on: Scrubbing of audio (and MIDI) is possible.
SHUTTLE on: Shuttle mode

SCRUB Switches Jog Wheel between Move Playhead (by bars), and
Scrubbing modes.

SHUTTLE Switches Jog Wheel between Move Playhead (by bars) and Shuttle
modes.
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JLCooper FaderMaster 4/100 9

This chapter describes how to use your JLCooper FaderMaster 4/100 with Logic Pro.

This chapter covers the following:
+ Setting Up Your JLCooper FaderMaster 4/100 (p. 161)
+ JLCooper FaderMaster 4/100: Assignment Overview (p. 162)

Setting Up Your JLCooper FaderMaster 4/100

Follow these steps before using your FaderMaster 4/100 control surface with Logic Pro.

+ Ensure that your FaderMaster 4/100 (MIDI or USB version) has firmware version 1.03 or
later installed.

Important: If you have older firmware (see the sticker on the back of the unit), contact
JLCooper.

+ USB model only: Install the software that comes with the FaderMaster 4/100.

+ Ensure that your FaderMaster 4/100 devices are connected to the computer via USB
or MIDI. If connected via USB, installation is automatic.

To install units connected via MIDI

Choose Logic Pro > Preferences > Control Surfaces > Setup.

Choose Install from the New menu.

Select FaderMaster 4/100 from the list in the Install window.

Click the Scan button.

Note: You can combine several FaderMaster 4/100 devices to form one large virtual

control surface. The meaning and functionality of the Track buttons, however, are
individually switched for each device.
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JLCooper FaderMaster 4/100: Assignment Overview
The following sections outline the assignment of JLCooper FaderMaster 4/100 interface
elements to Logic functions.

+ JLCooper FaderMaster 4/100: Global Buttons
+ JLCooper FaderMaster 4/100: Channel Strip

JLCooper FaderMaster 4/100: Global Buttons
The following table outlines the global controls and their assignments:

Control Assignment

Select Switches Track buttons to track selection duties.

Aux Switches Track buttons to emulate Record Enable buttons.
Solo Switches Track buttons to emulate Solo buttons.

Mute Switches Track Buttons to emulate Mute buttons.

Inc Increases fader bank display to show next four channels.

Dec Decreases fader bank display to show previous four channels.

JLCooper FaderMaster 4/100: Channel Strip
The following table outlines the channel strip controls and their assignments:

Control Assignment

Track button Performs currently selected function (Select, Record Enable, Solo,
Mute).
Fader Controls volume (touch-sensitive and motorized).
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JLCooper MCS3 10

This chapter describes how to use your JLCooper MCS3 MIDI or USB control surface with
Logic Pro.

This chapter covers the following:

+ Setting Up Your JLCooper MCS3 (p. 163)

+ JLCooper MCS3: Assignment Overview (p. 163)

Setting Up Your JLCooper MCS3

Logic Pro supports USB or MIDI versions of the JLCooper MCS3 control surface. Both USB
and MIDI versions are installed automatically when you open Logic Pro. If your MCS3 is
not recognized and installed correctly, follow the steps below.

To add JLCooper MCS3 control surfaces connected via USB
Ensure that your MCS3 USB device is correctly connected to the computer with a USB
cable. Also ensure that the unit is powered.

Open Logic Pro, and the MCS3 will be added to the Control Surfaces Setup window.
To add JLCooper MCS3 control surfaces connected via MIDI

Make sure that your MCS3 units are connected to the computer via MIDI.

Choose Logic Pro > Preferences > Control Surfaces > Setup.

Choose Install in the Setup window’s New menu.

Select the MCS3 from the list in the Install window.

Click the Scan button.

JLCooper MCS3: Assignment Overview
Assignments of JLCooper MCS3 interface elements to Logic functions are covered in the
following sections:

» JLCooper MCS3: F1 to F6 Buttons
+ JLCooper MCS3: W1 to W7 Buttons
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+ JLCooper MCS3: Cursor Controls
+ JLCooper MCS3: Jog Wheel and Shuttle Ring
+ JLCooper MCS3: Transport Controls

JLCooper MCS3: F1 to F6 Buttons
The following table outlines the F1 to F6 buttons and their assignments:

Control Assignment

F1 Switches to Layer 1.

F2 Switches to Layer 2.

F3 Switches to Layer 3.

F4 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

F5 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

F6 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

JLCooper MCS3: W1 to W7 Buttons
The following table outlines the W1 to W7 buttons and their assignments:

Control Assignment

W1 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W2 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W3 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W4 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W5 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W6 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

W7 Unassigned. Can be assigned to different key commands in Layers
1,2,and 3.

JLCooper MCS3: Cursor Controls
The following table outlines the cursor controls and their assignments:

Control Assignment

Up Arrow Mirrors the behavior of the computer keyboard Up Arrow key.
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Down Arrow Mirrors the behavior of the computer keyboard Down Arrow key.
Left Arrow Mirrors the behavior of the computer keyboard Left Arrow key.
Right Arrow Mirrors the behavior of the computer keyboard Right Arrow key.

JLCooper MCS3: Jog Wheel and Shuttle Ring
The following table outlines the Jog Wheel and Shuttle Ring controls and their
assignments:

Control Assignment
Jog Wheel Scrubs audio and MIDI.
SHUTTLE RING Shuttles the playhead backward when turned to the left. Shuttles

the playhead forward when turned to the right.

JLCooper MCS3: Transport Controls
The following table outlines the transport controls and their assignments:

REW Moves the playhead backward by one bar.
F FWD Moves the playhead forward by one bar.
STOP Stop

PLAY Play

RECORD Record. LED is lit when active.

Chapter 10 JLCooper MCS3
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Korg microKONTROL and 11
KONTROL49

This chapter describes how to use your Korg microKontrol and Kontrol49 with Logic Pro.

This chapter covers the following:
» Setting Up Your Korg microKONTROL and KONTROL49 (p. 167)
+ Korg microKONTROL and KONTROL49: Assignment Overview (p. 167)

Setting Up Your Korg microKONTROL and KONTROL49

Follow the steps below to use your control surface with Logic Pro.

To set up your control surface with Logic Pro

Ensure that your control surfaces are connected to the computer via USB.

Open Logic Pro.

The devices are scanned for, and installed automatically. The microKONTROL/KONTROL49

is automatically set to Native mode; internal Scene settings are ignored.

Note: If installation and identification fails, it may be possible that the
microKONTROL/KONTROL49 reaction time is too slow due to USB bus-power issues. In
this situation, connect the supplied power adapter, and set the power switch to the DC
position.

When you quit Logic Pro (or delete the control surface icon in the Control Surfaces Setup
window), the microKONTROL/KONTROL49 is reset to normal (not native) operation.

Korg microKONTROL and KONTROL49: Assignment Overview
The following sections outline the assignment of Korg microKONTROL and KONTROL49
interface elements to Logic functions.

+ Korg microKONTROL and KONTROL49: Pads

+ Korg microKONTROL and KONTROL49: Main Section

+ Korg microKONTROL and KONTROL49: Channel Strips
+ Korg microKONTROL and KONTROL49: External Input
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Korg microKONTROL and KONTROL49: Pads

The Pads can operate in one of eight modes, and three overlays. While pressing SCENE,
you can select modes for the Pads and channel strips. Releasing SCENE without pressing
a Pad does not affect the currently selected Pad or channel views.

Pad Assignment

1 Switches Pads to Transport mode.
2 Switches Pads to Solo/Mute mode.
3 Switches Pads to Rec/Select mode.
4-8 Switches Pads to User 4-8 mode.

These modes have unassigned Pads. You can assign them to key
commands with the Learn function.

9 Switches channel strips to Pan mode.

10 Switches channel strips to Send mode.

n Switches channel strips to Automation mode.

12 Switches channel strips to Instrument Edit mode.
13 Switches channel strips to Effect Edit mode.
14-16 Switches channel strips to User 6-8 mode.

These modes have unassigned encoders. You can assign them with
the Logic Pro Learn function.

Transport Mode
This mode is enabled by pressing SCENE and Pad 1.

Pad Assignment

1 Sets main encoder to Transport mode.

2 Sets main encoder to Scrub mode.

3 Sets main encoder to Shuttle mode.

7 Switches sync between internal and external.

8 Enables/disables metronome click (separately for Playback and
Record).

9 Enables/disables Cycle mode.

10 Enables/disables Autopunch mode.

n Enables/disables Replace mode.

12 Enables/disables Solo.

13 Record

14 Pause

15 Play

16 Stop
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Solo/Mute Mode
This mode is enabled by pressing SCENE and Pad 2.

Pad Assignment

1-8 Enables/disables Solo for the eight channels being controlled with
the eight channel strips.

9-16 Enables/disables Mute for the eight channels being controlled with
the eight channel strips.

Rec/Select Mode
This mode is enabled by pressing SCENE and Pad 3.

Pad Assignment

1-8 Activates/deactivates the Record Enable button of the eight channels
being controlled with the eight channel strips.

9-16 Selects one of the eight channels being controlled with the eight
channel strips.

User 4-8 Modes
These modes are enabled by pressing SCENE and Pad 4 to 8.

In these modes, the Pads are unassigned. Use the Learn function: Logic Pro > Preferences
> Control Surfaces > Learn Assignment for [function name] to assign them to key
commands, for example.

Note: When in Learn mode, if a pad is pressed and released immediately, the learned
assignment does not work as expected.

To successfully assign a key command
Enable the Learn New Assignment button in the Key Commands window.

Choose a key command, then press and hold down the pad, until the Learn New
Assignment button switches to the “up” state.

This slightly different approach is due to messages sent by the Korg devices: when the
pad is immediately released, a value range is learned. Holding the pad until Learn mode
disengages results in a fixed value being learned.

Send Mode

This mode is enabled by pressing SCENE and Pad 10. In Send mode, the channel strip
encoders control the send level of the selected send. The Pads remain in the currently
selected mode.

+ Send Overlay: Pressing SETTING while the encoders are in Send mode changes the
operation of the Pads in Send mode.
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Pad Assignment

1-8 Switches the send bypass state (of the currently selected send) for
the eight channel strips.

9-16 Switches the send position (pre/post fader) of the currently selected
send, for the eight channel strips.

Effect Edit Mode

This mode is enabled by pressing SCENE and Pad 13. In Effect Edit mode, the channel
strip encoders control the parameters of the currently selected effect. The Pads remain
in the currently selected mode.

« Effect Edit Overlay: Pressing SETTING while the encoders are in Effect Edit mode changes
the operation of the Pads in Effect Edit mode.

Pad Assignment

1-8 Switches the effect bypass state (of the currently selected Insert
slot) for the eight channel strips.

Korg microKONTROL and KONTROL49: Main Section

The main LCD shows information on the current mode of the encoders.

<Instrument name> Encoders edit instrument parameters.

<Plug-in name> Encoders edit effect parameters (the currently selected Insert slot
number is indicated on the display).

Automatn Encoders set the automation mode.

Ins. x (SETTING held down) Main encoder chooses the Insert slot number.

ModePad? Displayed while SCENE button is held down.

Pan Encoders control pan.

Send x Encoders control send level of send x.

User 6 Channel Strip User Mode 6. Encoders are initially unassigned.

User 7 Channel Strip User Mode 7. Encoders are initially unassigned.

User 8 Channel Strip User Mode 8. Encoders are initially unassigned.

The LCD backlight is red while recording, and green at other times.

The controls in the main section have the following meaning:

Control Assignment

Main encoder Controls the playhead in one of three modes. (See Pads 1-3 in
Transport Mode.)
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Control Assignment
SETTING Held down in Send mode:

+ Main encoder chooses the current send.

+ Pads have special meaning—see Send Mode.
+ LCDs display send destinations.

+ Encoders choose send destinations.

Held down in Effect Edit mode:
+ Main encoder chooses the current Insert slot.

+ Pads have special meaning—see Effect Edit Mode.
+ LCDs display effect names for all eight channels.

MESSAGE Enables/disables Duplicate Flip mode. When enabled, both the
faders and encoders control the parameter displayed in the LCDs.

SCENE While held down, Pads switch between Pad functions and channel
views. See Korg microKONTROL and KONTROL49: Pads.

EXIT —

HEX LOCK Shifts fader bank to the previous eight channels. (LED is on if
previous channels exist.) Shifts fader bank to the previous eight
parameters in Effect Edit or Instrument Edit view.

ENTER Shifts fader bank to the next eight channels. (LED is on if subsequent
channels exist.) Shifts fader bank to the next eight parameters in
Effect Edit or Instrument Edit view.

< Octave Shift Down

> Octave Shift Up

Korg microKONTROL and KONTROL49: Channel Strips

There are several modes for the encoders, enabled with SCENE and Pad 9-16.

Control Assignment

LCD Shows the parameter controlled by the encoder. The current
name/value is displayed for a few seconds when you move an
encoder or fader. When the encoders are in a Mixer view (Pan, Send,
Send Setup), the background color indicates the channel automation
mode:

+ Green: Off or Read
+ Yellow: Touch or Latch

+ Red: Write

Encoder Controls the parameter shown directly above the encoder in the
LCD.

Fader Controls volume. As the faders don't offer feedback, Pickup mode

is used (if enabled in the Control Surfaces preferences). This means
that the fader must reach (“pick up”) the current parameter value
before the value starts to change.
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Korg microKONTROL and KONTROL49: External Input
The following table outlines the external input controls and their assignments:

Control Assignment

Foot Switch Starts and stops playback.

Pedal Controls the master fader.
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Mackie Baby HUI 12

This chapter describes how to use your Mackie Baby HUI with Logic Pro.

This chapter covers the following:
+ Setting Up Your Mackie Baby HUI (p. 173)
+ Mackie Baby HUI: Assignment Overview (p. 173)

Setting Up Your Mackie Baby HUI

Baby HUI control surface units do not support automatic scanning. You need to manually
add these devices to your setup. When you add a device in this way, you need to specify
the MIDI In and Out port parameters.

To set up Mackie Baby HUI units
Make sure that your Baby HUI units are connected bidirectionally with the computer,
using a MIDI interface.

Choose Logic Pro > Preferences > Control Surfaces > Setup.
Choose New > Install in the Setup window.

Select the Baby HUI in the Install window.

Click the Add button.

Select the added device in the Setup window, then assign the MIDI Input and MIDI Out
parameters as appropriate.

Mackie Baby HUI: Assignment Overview
Assignments of Mackie Baby HUI interface elements to Logic functions are covered in the
following sections:

* Mackie Baby HUI: Channel Strips

+ Mackie Baby HUI: Encoder Assignment Section
+ Mackie Baby HUI: Automation Section

» Mackie Baby HUI: Display Section
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+ Mackie Baby HUI: Utility Section
+ Mackie Baby HUI: Navigation Section
+ Mackie Baby HUI: Transport Section

Mackie Baby HUI: Channel Strips

The following table outlines the channel strip controls and their assignments:

Note: If SHIFT is shown below a button description, it indicates that the control has an
alternate use while the modifier is held down.

Control Modifier Assignment

Rotary encoder Adjusts the parameter selected in the Encoder
Assignment section.

Rotary encoder push Selects a channel strip.

button

SHIFT Turns Record Enable button of selected channel

on/off.

Signal indicator llluminates when a signal is present in the channel.
It also indicates channel selection.

SOLO Enables or disables Solo.

MUTE Enables or disables Mute.

Fader Adjusts volume.

Mackie Baby HUI: Encoder Assignment Section
The following table outlines the encoder assignment controls and their assignments:

Control Assignment

PAN Assigns pan to rotary encoders.

SEND 1 Assigns Send 1 level to rotary encoders.
SEND 2 Assigns Send 2 level to rotary encoders.
SEND 3 Assigns Send 3 level to rotary encoders.
SEND 4 Assigns Send 4 level to rotary encoders.

Mackie Baby HUI: Automation Section
The following table outlines the automation controls and their assignments:

Note: If SHIFT is shown below a button description, it indicates that the control has an
alternate use while the modifier is held down.

Control Modifier Assignment

BYPASS/OFF Sets selected channel to Off automation mode.
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Control Modifier Assignment

SHIFT Enables or disables playback and recording of level
(volume) automation.

READ Sets selected channel to Read automation mode.

SHIFT Enables or disables playback and recording of
mute automation.

WRITE Sets selected channel to Write automation mode.

SHIFT Enables or disables playback and recording of pan
automation.

TOUCH Sets selected channel to Touch automation mode.

SHIFT Enables or disables playback and recording of send
level automation.

Mackie Baby HUI: Display Section

The following table outlines the display controls and their assignments:

TRANSPORT Opens or closes the Transport bar window.
MEM-LOC Opens or closes the Marker List.

MIXER Opens or closes the Mixer.

EDIT Opens or closes the Arrange window.

Mackie Baby HUI: Utility Section

The following table outlines the utility controls and their assignments:

Control Assignment
UNDO Undoes the last editing step.
SHIFT Shifts to alternate use of some buttons.

Mackie Baby HUI: Navigation Section
The following table outlines the navigation controls and their assignments:

Note: If SHIFT is shown below a button description, it indicates that the control has an
alternate use while the modifier is held down.

Control Modifier Assignment
RTZ Navigates to the left locator.
SHIFT Sets the punch in locator (at current playhead
position).
END Navigates to the right locator.
SHIFT Sets the punch out locator (at current playhead
position).
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Control Modifier Assignment

BANK SELECT Left Shifts channel strips by one bank to the left.
SHIFT Shifts channel strips by one channel to the left.

BANK SELECT Right Shifts channel strips by one bank to the right.
SHIFT Shifts channel strips by one channel to the right.

Mackie Baby HUI: Transport Section
The following table outlines the transport controls and their assignments:

REWIND Shuttles backward.
FAST FWD Shuttles forward.
STOP Stop

PLAY Play

RECORD Record
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Mackie HUI 13

This chapter describes how to use your Mackie HUI with Logic Pro.

Important: There are a number of control surfaces—not mentioned in this guide—that
can emulate the HUI. Such devices are not supported by Apple, nor are they guaranteed
to work with Logic Pro in HUI emulation mode.

This chapter covers the following:

+ Setting Up Your Mackie HUI (p. 177)

+ Mackie HUI: Assignment Overview (p. 178)

Setting Up Your Mackie HUI

HUI control surface devices don't support automatic scanning. You need to manually add
these devices to your setup. When you add a device in this way, you need to assign the
MIDI In and Out port parameters.

To set up Mackie HUI devices
Make sure that your HUI devices are connected bidirectionally with the computer, using
a MIDI interface.

Choose Logic Pro > Preferences > Control Surfaces > Setup.
Choose New > Install in the Setup window.

Select HUI in the Install window.

Click the Add button.

Select the added device in the Setup window, then set the MIDI In and MIDI Out
parameters as appropriate.
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Tips for Setting Up Other HUI-Compatible Devices
If the unit emulates a single HUI device, proceed as if using a HULI.

If you experience problems in the DSP Edit display, install the unit as a DM2000. See
Yamaha DM2000.

If the unit emulates more than one HUI, add the required number of additional devices
in the Setup window. If the unit is limited to support of only one HUI DSP Edit section,
choose “HUI Channel Strips only” as the model name for these additional units. This
ensures that scrolling in the DSP Edit section is limited to four parameters.

If you want to know more about button assignments, refer to Mackie HUI: Assignment
Overview, and the user manual for the device.

Mackie HUI: Assignment Overview
The following sections outline the assignment of Mackie HUI interface elements to Logic
functions.

+ Mackie HUI: ASSIGN Section

+ Mackie HUI: Fader Bank Buttons

+ Mackie HUI: WINDOW Section

+ Mackie HUI: KEYBOARD SHORTCUTS Section
» Mackie HUI: Channel Strips

» Mackie HUI: DSP EDIT/ASSIGN Section

+ Mackie HUI: Function Keys

+ Mackie HUI: AUTO ENABLE Section

+ Mackie HUI: AUTO MODE Section

» Mackie HUI: STATUS/GROUP Section

» Mackie HUI: EDIT Section

* Mackie HUI: Time Display

+ Mackie HUI: LOCATE/NUMERICS Section
» Mackie HUI: Transport Section

+ Mackie HUI: Cursor Buttons

+ Mackie HUI: Jog Wheel

+ Mackie HUI: Foot Switches

Mackie HUI: ASSIGN Section

The following table outlines the controls in the ASSIGN section and their assignments:
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Note: A modifier button, such as SHIFT, below a button description indicates that the
button has an alternate use while the modifier is held down.

Control
SEND A

Modifier

Assignment

Assigns Send 1 level to V-Pots, and Send 1 to 4
levels to DSP V-Pots. While SEND A is held down,
the scribble strips show the current Send 1
destination (a bus number).

SHIFT/ADD

As above, for Send 6

SEND B

As above, for Send 2

SHIFT/ADD

As above, for Send 7

SEND C

As above, for Send 3

SHIFT/ADD

As above, for Send 8

SEND D

As above, for Send 4

SEND E

As above, for Send 5

PAN

Assigns Pan to V-Pots, and the selected (surround)
channel strip’s pan/surround parameters to

DSP V-Pots. You must confirm any changes made
with the DSP V-Pots by pressing the corresponding
V-Select button.

INPUT

Assigns channel strip input to V-Pots. While held
down, the scribble strips show the current channel
strip input assignment. The four DSP V-Pots control
the following parameters of the selected channel
strip: format, input, output, and automation mode.
You must confirm any changes made with the
V-Pots or DSP V-Pots by pressing the
corresponding V-Select button.

OUTPUT

Assigns channel strip output to V-Pots. While held
down, the scribble strips show the current channel
strip output assignment. The four DSP V-Pots
control the following parameters of the selected
channel strip: format, input, output, and
automation mode. You must confirm any changes
made with the V-Pots or DSP V-Pots by pressing
the corresponding V-Select button.

REC/RDY ALL

Disables Record Enable button of all channel strips.

BYPASS

Switches the INSERT buttons between Insert Select
and Insert Bypass modes. See Insert entry in the
Mackie HUI: Channel Strips table.

MUTE

Switches the V-Select buttons between Send
Position and Send Mute modes.

SHIFT

Enables or disables Flip mode.
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Control Modifier Assignment

SELECT-ASSIGN Displays the V-Pot assignment as follows: Pan,
Snd1 to Snd8, S1As to S8As, In, Out.

SUSPEND _

DEFAULT Hold this button down to switch the V-Select

buttons between standard operation and setting
default values.

ASSIGN When V-Pots display a send level, the ASSIGN
button switches them to Send Destination
Assignment mode (choosing a bus, in other
words). Press the V-Select to confirm the
assignment. The DSP V-Pots display the
assignments of Send slots 1-4 or Send slots 5-8.
Confirm any changes by pressing the V-Select
button or all changes will be lost when you leave
Send Destination Assignment mode, or press the
Assign button a second time.

Mackie HUI: Fader Bank Buttons
The following table outlines the fader bank controls and their assignments:

Control Assignment

Bank Left Shifts channel strips by one bank (a group of channel strips or
parameters) to the left.

Bank Right Shifts channel strips by one bank to the right.
Channel Left Shifts channel strips by one channel (or parameter) to the left.
Channel Right Shifts channel strips by one channel to the right.

Mackie HUI: WINDOW Section

The following table outlines the window controls and their assignments:

Control Assignment

TRANSPORT Opens or closes the Transport bar window.
EDIT Opens or closes the Arrange window.

MIX Opens or closes the Mixer.

ALT Opens or closes the Sample Editor.

STATUS Opens or closes the Audio Bin.

MEM-LOC Opens or closes the Marker List.

Mackie HUI: KEYBOARD SHORTCUTS Section

The following table outlines the keyboard shortcut controls and their assignments:
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Note: A modifier button, such as SHIFT, below a button description indicates that the
button has an alternate use while the modifier is held down.

Control Modifier Assignment
UNDO Undoes last editing operation.
SHIFT/ADD Redoes last editing operation.
OPTION/ALL Opens Undo History window.
SAVE Saves the project.
OPTION/ALL Performs Save As function, allowing you to save
the project with a different name.
EDIT MODE —
EDIT TOOL Selects the next tool. While held down, numerical
buttons select a specific tool.
SHIFT/ADD Shifts to alternate mode/use for some buttons.
See descriptions of other buttons.
OPTION/ALL While held down, value change mode is set to

relative. This switches between a minimum,
default, or maximum value for the edited
parameter. Also see description of other buttons.

CTRL/CLUTCH While held down, the Group Clutch is engaged.
(All groups are disabled.)

CMD/ALT/FINE While held down, Value Change mode is set to
Fine. All value changes work at maximum
resolution. Also see descriptions of other buttons.

Mackie HUI: Channel Strips
The following table outlines the channel strip controls and their assignments:

Note: A modifier button, such as SHIFT, below a button description indicates that the
button has an alternate use while the modifier is held down.

Control Modifier Assignment
Level meters Displays momentary and peak levels.
REC/RDY Activates or deactivates the Record Enable button.
OPTION/ALL Disables the Record Enable buttons of all channel
strips.
INSERT + BYPASS button OFF (see Insert Select mode in

Mackie HUI: ASSIGN Section): selects channel
strip for plug-in selection.

+ BYPASS button ON (see Insert Bypass mode in
Mackie HUI: ASSIGN Section): enables/disables
bypass of currently selected Insert slot.
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Control Modifier Assignment
V-SEL + PAN button ON: sets Pan parameter to center
position if DEFAULT button is on.
+ Send 1 to 8 selected: edits Send Pre/Post,
activates/deactivates Send Mute, or sets Send
Level to default value.
+ In Send Destination Assignment mode, Channel
Strip Input or Channel Strip Output Assignment
mode: the V-SEL buttons confirm your selection.
V-Pot Adjusts parameter selected in the ASSIGN section.
AUTO Cycles through automation modes. If you hold
down an automation mode button, pressing AUTO
sets this mode.
SOLO Enables or disables the Solo button.
OPTION/ALL Disables the Solo buttons of all channel strips.
MUTE Enables or disables the Mute button.
OPTION/ALL Disables the Mute buttons of all channel strips.
Scribble strip Displays the channel strip name or send, input, or
output assignment.
SELECT Selects the channel strip.
SHIFT/ADD Sets volume to unity level.
DEFAULT Sets volume to unity level.
Fader Adjusts volume, or duplicates the V-Pot

assignment in Flip mode.

Mackie HUI: DSP EDIT/ASSIGN Section
The following table outlines the DSP controls and their assignments:

Note: A modifier button, such as SHIFT, below a button description indicates that the
button has an alternate use while the modifier is held down.

Control Modifier Assignment

ASSIGN —

COMPARE Switches DSP display between “track
name/parameter name” and “parameter
name/parameter value” modes.

BYPASS Switches the bypass state of the plug-in being

edited.
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Control Modifier Assignment

DSP Select 1to 4 » Assignment Pan mode:
DSP Select 1 resets pan or surround angle.

DSP Select 2 resets surround diversity.
DSP Select 3 resets surround LFE (level).
DSP Select 4 resets the Spread parameter.

+ Assignment Send mode:
Activates or deactivates Sends 1 to 4, or mutes
510 8.

+ Effect Assign mode:
Confirms Insert 1 to 4 or 5 to 8 effect selection,
selects this Insert slot, and enters Effect Edit
mode, showing the parameters of the chosen
effect.

+ Effect Edit mode:
Sets parameter to the default value, or turns
“switching” parameters on/off.

DSP V-Pots + Assignment Pan mode:
DSP V-Pot 1 controls pan or surround angle.

DSP V-Pot 2 controls surround diversity.
DSP V-Pot 3 controls surround LFE (level).
DSP V-Pot 4 controls the Spread parameter.

+ Assignment Send mode:
Controls Send 1 to 4, or 5 to 8 Levels.

« Effect Assign mode:
Assigns effects to Insert slots 1 through 4, or 5
to 8.

+ Effect Edit mode:
Controls the selected effect parameter.

INSERT/PARAM Switches between Effect Assign and Effect Edit
modes.
SCROLL Effect Edit mod